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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described in the next section or sections by product name.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

TSQ Quantum XLS and TSQ Quantum XLS Ultra

EMC Directive 2004/108/EC 
EMC compliance has been evaluated by TUV Rheinland of North America Inc.

Low Voltage Directive 2006/95/EC

This device complies with Low Voltage Directive 2006/95/EC and harmonized standards: EN 61010-1: 2001; IEC 
61010-1: 2002; UL 61010A-1: 2004; CAN/CSA 22.2 61010-1: 2004.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

EN 55011 2007; A2: 2007 EN 61000-4-5 2005

EN 61000-3-2 2006 EN 61000-4-6 2007

EN 61000-3-3 1995; A1: 2001; A2: 2005 EN 61000-4-11 2004

EN 61000-4-2 1995; A1: 1999; A2: 2001 EN 61326-1 2006

EN 61000-4-3 2006 FCC Class A 2008, CFR 47, Part 15

EN 61000-4-4 2004



FCC Compliance Statement

Notice on Lifting and Handling of
Thermo Fisher Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for one 
person alone to handle safely.

Notice on the Proper Use of
Thermo Fisher Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

WARNING  Read and understand the various precautionary notes, signs, and symbols contained 
inside this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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P

Preface

The Thermo Scientific TSQ Quantum XLS and TSQ Quantum XLS Ultra systems make up 
the TSQ Quantum XLS Series and are member of the TSQ Quantum™ family of mass 
spectrometers. 

This TSQ Quantum XLS Series User Guide contains a description of the modes of operation 
and principle hardware components of your TSQ Quantum XLS Series system. In addition, 
this user guide provides step-by-step instructions for cleaning and maintaining your mass 
spectrometer.

To suggest changes to documentation or to Help

• Complete a brief survey about this document by clicking the link below.
Thank you in advance for your help.

Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the following PDF document and 
Help for the TSQ Quantum XLS Series systems:

• TSQ Quantum XLS Series Preinstallation Requirements Guide

• Manuals that come with other modules of your system

• Help that is included with the software

Contents

• Related Documentation

• Safety and Special Notices

• Contacting Us
Thermo Scientific TSQ Quantum XLS Series User Guide xi
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Preface
Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following: 

WARNING  Highlights hazards to humans. Each WARNING notice is accompanied by an 
appropriate hazard symbol.

WARNING  Burn Hazard. The ion source, GC oven, injector, and transfer line are hot. 
Allow them to cool to room temperature before touching them.

WARNING  Shock Hazard. Unplug the product-name mass spectrometer before 
proceeding.

WARNING  Material and Eye Hazard. Wear impermeable laboratory gloves and eye 
protection when performing cleaning procedures.

CAUTION  Highlights hazards to property or the environment. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
xii TSQ Quantum XLS Series User Guide Thermo Scientific



Preface
Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To get local contact information for sales or service

Go to www.thermoscientific.com/wps/portal/ts/contactus.

To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
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Introduction 

The TSQ Quantum XLS Series systems are advanced analytical instruments that include a 
mass spectrometer, gas chromatograph, and the Xcalibur™ data system. See Figure 1 and 
Figure 2.

In a typical analysis, an autosampler (AS) introduces a sample into the gas chromatograph 
(GC). The GC separates the sample into its various components. The components elute from 
the GC and pass into the mass spectrometer where they are analyzed. 

The TSQ Quantum XLS Series mass spectrometers include an electron ionization/chemical 
ionization (EI/CI) ion source, ion optics, a triple-stage mass analyzer, and an ion detection 
system—all of which are enclosed in a vacuum manifold. Ionization of the sample takes place 
in the ion source. The specific process used to ionize the sample is known as the ionization 
mode. The ion optics transmit the ions produced in the ion source into the mass analyzer, 
where they are filtered according to their mass-to-charge ratio. The polarity of the potentials 
applied to the lenses in the ion source and ion optics determines whether positively charged 
ions or negatively charged ions are transmitted to the mass analyzer. You can configure the 
mass spectrometer to analyze positively or negatively charged ions (called the positive or 
negative ion polarity mode). 

Contents

• Ionization Modes

• Ion Polarity Modes

• Scan Modes

• Scan Types

• Data Types

• Mass/Charge Range
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1 Introduction
Figure 1. TSQ Quantum XLS Ultra mass spectrometer, TriPlus autosampler, and TRACE GC Ultra 
gas chromatograph

Figure 2. TSQ Quantum XLS mass spectrometer, TriPlus autosampler, and TRACE GC Ultra gas 
chromatograph
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Ionization Modes
The mass spectrometer’s triple-stage mass analyzer performs either one or two stages of mass 
analysis:

• The mass spectrometer is operated as a conventional mass spectrometer with one stage of 
mass analysis. The ion source ionizes the sample and the ion products are subjected to 
mass analysis in the first rod assembly. The second and third rod assemblies transmit the 
resulting mass-selected ions to the ion detection system.1

• The mass spectrometer is operated as a tandem mass spectrometer with two stages of mass 
analysis. The ion source ionizes the sample and the ion products are mass analyzed by the 
first rod assembly. In this case, however, mass-selected ions exiting the first rod assembly 
collide with an inert gas in the second rod assembly and fragment to produce a set of ions 
known as product ions. (A chamber called the collision cell surrounds the second rod 
assembly. The collision cell can be pressurized with an inert gas.) The product ions 
undergo further mass analysis in the third rod assembly to detect selected ions. Two stages 
of mass analysis yield far greater chemical specificity than a single stage can achieve, 
because of the system’s ability to select and determine two discrete but directly related sets 
of masses.

In a first stage of mass analysis, you can use the mass spectrometer to elucidate the structures 
of pure organic compounds and the structures of the components within mixtures. 
Furthermore, in a second stage of mass analysis, the mass spectrometer can fragment and 
separate each ionic fragment of a molecule formed in the ion source to build up an entire 
structure for the molecule, piece by piece. As a result, the TSQ Quantum XLS Series systems 
make investigating all pathways for the formation and fragmentation of each ion in the mass 
spectrum possible.

The two stages of mass analysis, with resultant reduction of chemical noise in the final mass 
spectrum, allow for very selective and sensitive analysis.

Each sequence of single or triple-stage mass analysis of the ions is called a scan. The mass 
spectrometer uses several different scan modes and different scan types to filter, fragment, or 
transmit ions in the mass analyzer. Along with the ionization and ion polarity modes, the 
ability to vary the scan mode and scan type affords you great flexibility in the instrumentation 
for solving complex analytical problems.

Ionization Modes
The specific process used to ionize the analyte is referred to as the ionization mode. You can 
operate the TSQ Quantum XLS Series mass spectrometers in either of two ionization modes:

• Electron Ionization Mode

• Chemical Ionization Mode

1  You can also use the instrument as a single-stage mass spectrometer by transmitting the ions through the first 
and second rod assemblies followed by mass analysis in the third rod assembly.
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Electron Ionization Mode

In electron ionization (EI) mode, electrons are emitted by a heated, wire filament that has 
electric current running through it, by thermionic emission. The filament and its reflector are 
typically maintained at a –70 V potential relative to the ion source block. This potential 
accelerates the electrons through the ionization space, called the ion volume. These energetic 
electrons interact with neutral, gas-phase analyte molecules present in the ion volume and 
cause the analyte to lose an electron and produce a radical cation:

M + e- → M+ + 2e- 

Frequently, numerous cleavage reactions give rise to fragment ions, which provide structural 
information about the analyte.

EI positive-ion mode is the only commonly used EI mode. 

Chemical Ionization Mode

In chemical ionization (CI) mode, ionization of the sample molecules is a multi-step process:

1. Reagent gas is introduced into the CI ion volume at a flow (for methane) of about 
2 mL/min, along with sample vapors typically present at partial pressures of less than 
one-thousandth that of the reagent gas. 

2. The energetic (typically 100 eV) electrons emitted by the heated filament interact to 
ionize the reagent gas and form a plasma. This reaction also produces thermal electrons.

3. Reagent gas ions react with reagent gas molecules to form a variety of secondary ions that 
are stable with respect to further reaction with reagent gas. 

For example, for methane:

CH4 + e- → CH4
+. + 2e- 

CH4 + e- → CH3
+ + e- + H-

CH4
+. + CH4 → CH5

+ +CH3
.

CH3
+ + CH4 → C2H5

+ + H2 

4. Positive sample ions are formed by one of the following:

• The transfer of a proton from a secondary reagent gas ion to a sample molecule 

• The abstraction of an electron by a reagent gas ion

• An ion association reaction where an adduct ion is formed between a reagent gas ion 
and a sample molecule 

In methane positive ion mode CI, the relevant peaks observed are MH+, [M+CH5]+, and 
[M+C2H5]+; but mainly MH+.
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In isobutane positive ion mode CI, the main peak observed is MH+. 

In ammonia positive ion mode CI, the main peaks observed are MH+ and [M+NH4]+. 

Negative sample ions are most commonly formed by one of the following:

• Sample molecules that capture the secondary thermal electrons present in the ion source

• Electron transfer from ionized reagent gas (for example, NH2
-)

• Proton abstraction 

Molecular ions observed in negative ion chemical ionization mass spectra are usually M- or 
[M-H]-.

Ion Polarity Modes
You can operate the TSQ Quantum XLS Series mass spectrometers in either of two ion 
polarity modes: positive or negative. Both positively charged and negatively charged ions form 
in the ion source of the mass spectrometer. The mass spectrometer controls whether positive 
ions or negative ions are transmitted to the mass analyzer for mass analysis by changing the 
polarity of the potentials applied to the ion source and ion optics. The ion optics deliver the 
ions produced in the ion source, in a collimated beam, to the mass analyzer. The mass 
spectrometer can switch between positive and negative polarity modes in under 95 ms.

Because the information obtained from a positive-ion mass spectrum is different from and 
complementary to the information from a negative-ion spectrum, the ability to obtain both 
positive-ion and negative-ion mass spectra aids you in the qualitative analysis of your sample. 
You can choose the ion polarity mode and ionization mode to obtain maximum sensitivity for 
the particular analyte of interest.

Scan Modes
You can operate the TSQ Quantum XLS Series mass spectrometers in a variety of scan modes. 
The most commonly used scan modes can be divided into two categories: single mass 
spectrometry (MS) scan modes and tandem mass spectrometry (MS/MS) scan modes. The 
scan modes in each category are as follows:

• MS scan modes: Q1MS and Q3MS scan modes 

• MS/MS scan modes: Product scan mode, Parent scan mode, Neutral Loss scan mode 

• Data-dependent scan mode

The scan modes that you can employ depend on the number and type of rod assemblies and 
the voltages applied to the rod assemblies.
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The mass analyzer or the mass spectrometer has three rod assemblies.2 The first and third rod 
assemblies, Q1 and Q3, are quadrupoles, and the second rod assembly, Q2, is a square-profile 
quadrupole. 

Rod assemblies can operate in either of two capacities:

• As ion transmission devices

• As mass analyzers

If you apply only RF voltage, a rod assembly serves as an ion transmission device that passes 
all ions within a large range of mass-to-charge ratios (that is, virtually all ions present).

When you apply both RF and dc voltages to a rod assembly, the separation of ions of different 
mass-to-charge ratios occurs. This separation allows the rod assembly to serve as a mass 
analyzer.

On the TSQ Quantum XLS Series mass spectrometers, the quadrupole rod assemblies can 
operate with rf and dc voltages or with only rf voltage. That is, Q1 and Q3 can act either as 
mass analyzers or ion transmission devices. The Q2 rod assembly operates exclusively with rf 
voltage. As a result, Q2 is always an ion transmission device. Surrounding Q2 is a collision cell 
where fragmentation can take place if the argon collision gas is present in the cell. For a 
summary of how the rod assemblies function in several of the major scan modes, see Table 1.
.

aScan = full scan or transmission of selected ions
bPass all ions or fragments = pass ions or fragments within a wide range of mass-to-charge ratios
cSet = set to pass ions of a single mass-to-charge ratio or a set of mass-to-charge ratios 
dFragment ions = collisions with argon gas cause ions to fragment

2  A rod assembly is a regular array of metal rods. For a discussion of the rod assemblies used on the 
TSQ Quantum XLS Series instruments, see “Mass Analyzer” on page 31.

Table 1. Summary of scan modes

Scan mode Q1 quadrupole Q2 collision cell Q3 quadrupole 

Q1MS Scana Pass all ionsb Pass all ions

Q3MS Pass all ions Pass all ions Scan

Product Setc Fragment ionsd, then pass all 
fragments

Scan

Parent Scan Fragment ions, then pass all 
fragments

Set

Neutral loss Scan Fragment ions, then pass all 
fragments

Scan
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Scan Modes
Q1MS and Q3MS Scan Modes

The Q1MS and Q3MS scan modes perform only one stage of mass analysis. The mass 
spectrum obtained is equivalent to the mass spectrum obtained from an instrument with a 
single mass analyzer. In the one stage of analysis, ions formed in the ion source enter the 
analyzer assembly. One of the mass analyzers (Q1 or Q3) is scanned to obtain a complete mass 
spectrum. The other rod assemblies (Q2 and Q3, or Q1 and Q2, respectively) act as ion 
transmission devices. The Q1MS scan mode uses Q1 as the mass analyzer; the Q3MS scan 
mode uses Q3 as the mass analyzer.

Product Scan Mode

The Product scan mode performs two stages of analysis. In the first stage, ions formed in the 
ion source enter Q1, which is set to transmit ions of one mass-to-charge ratio. Ions selected by 
this first stage of mass analysis are called parent ions. (As a result, Q1 is referred to as the 
parent mass analyzer, and the mass-to-charge ratio of ions transmitted by the parent mass 
analyzer is referred to as the parent set mass.) Parent ions selected by Q1 then enter Q2, which 
is surrounded by the collision cell.

In the second stage of analysis, ions in the collision cell can fragment further to produce 
product ions. Two processes produce product ions: by unimolecular decomposition of 
metastable ions or by interaction with argon collision gas present in the collision cell. This 
latter step is known as collision-induced dissociation (CID). Ions formed in the collision cell 
enter Q3 (the product mass analyzer) for the second stage of mass analysis. Q3 is scanned to 
obtain a mass spectrum that shows the product ions produced from the fragmentation of the 
selected parent ion.

A mass spectrum obtained in the Product scan mode (product mass spectrum) is the mass 
spectrum of a selected parent ion.

Figure 3 illustrates the Product scan mode.

Note  For convenience, when referring to the first, second, and third rod assemblies as 
pieces of hardware, you call them Q1, Q2, and Q3, respectively. However, for clarity in 
discussing their function in MS/MS scan modes, you refer to them as the parent mass 
analyzer, collision cell (ion transmission device surrounded by the collision cell), and 
product mass analyzer, respectively. 
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Figure 3. Illustration of Product scan mode

Parent Scan Mode

The Parent scan mode also uses two stages of analysis. In the first stage, ions formed in the ion 
source are introduced into the parent mass analyzer, which is scanned to transmit parent ions 
sequentially into the collision cell.

In the second stage of analysis, in the collision cell, parent ions can fragment to produce 
product ions by unimolecular decomposition of metastable ions or by collision-induced 
dissociation. Ions formed in the collision cell enter the product mass analyzer, which transmits 
a selected product ion. (The product set mass is the mass-to-charge ratio of ions transmitted 
by the product mass analyzer.)

The resultant spectrum shows all the parent ions that fragment to produce the selected 
product ion. Note that for a mass spectrum obtained in the Parent scan mode (parent mass 
spectrum), data for the mass-to-charge ratio axis is obtained from Q1 (the parent ions), 
whereas data for the ion intensity axis is obtained from Q3 (from monitoring the product 
ion).

Figure 4 illustrates the Parent scan mode.

Q1 Set

Q2
RF Only + Ar

Q3 Scanning

 Q3 m/z 
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Figure 4. Illustration of the Parent scan mode

You can perform experiments that use the parent scan mode (parent experiments) in structure 
and fragmentation studies as well as in survey analyses of mixtures. In general, parent 
experiments detect all compounds that decompose to a common fragment. The experiments 
are useful for the rapid detection of a series of structural homologs that have a common 
fragment ion (for example, m/z 149 for the phthalates).

Neutral Loss Scan Modes

The Neutral Loss scan mode links the two mass analyzers (Q1 and Q3) together so that they 
are scanned at the same rate over mass ranges of the same width. The respective mass ranges, 
however, are offset by a selected mass so that the product mass analyzer scans a selected 
number of mass units lower than the parent mass analyzer.

As a result, the Neutral Loss scan mode has two stages of mass analysis. In the first stage, the 
parent mass analyzer separates ions formed in the ion source by mass-to-charge ratio. Then 
the ions are introduced sequentially into the collision cell.

In the second stage of analysis, ions admitted to the collision cell can fragment further by 
metastable ion decomposition or by CID to produce product ions. The product mass analyzer 
then separates these product ions by mass-to-charge ratio. Figure 5 illustrates the Neutral Loss 
scan mode. Examples of compounds with a common neutral loss fragment appear in Figure 6 
on page 11.

Q2
RF Only + Ar

Q3 Set 

 Q1 m/z 

 Q1 Scanning
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To detect an ion, between the time the ion leaves Q1 and enters Q3, it must lose a neutral 
moiety whose mass (the neutral loss mass) is equal to the difference in the mass ranges that the 
two mass analyzers scan. A neutral loss mass spectrum, then, is a spectrum showing all the 
parent ions that lose a neutral species of a selected mass.

Note that you can also perform a neutral gain (or association) experiment in which the mass 
range scanned by Q3 is offset by a selected mass above the mass range scanned by Q1.

For a neutral loss (or neutral gain) mass spectrum, as for a parent mass spectrum, data for the 
mass-to-charge ratio axis is obtained from Q1 (the parent ion), whereas data for the ion 
intensity axis is obtained from Q3 (the product ion being monitored).

You can perform experiments that use the Neutral Loss scan mode (neutral loss experiments) 
when a large number of compounds are being surveyed for common functionality. Neutral 
moieties are frequently lost from substituent functional groups (for example, CO2 from 
carboxylic acids, CO from aldehydes, HX from halides, and H2O from alcohols).

Figure 5. Illustration of the Neutral Loss scan mode

 Q1 Scanning

 Q1 m/z 

Q2
RF Only + Ar

Q3 = Q1 - Δ
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Figure 6. Examples of compounds with a common neutral-loss fragment

Data-Dependent Scan Mode

The TSQ Quantum XLS Series mass spectrometers use the information in a data-dependent 
scan mode experiment to make automatic decisions about the next step of the experiment 
without user input. In data-dependent scan mode you specify criteria to select one or more 
ions of interest on which to perform subsequent scans, such as MS/MS. You can approach the 
setup of data-dependent experiments in either of two ways:

• If you have some idea of what the parent ion is, or if you expect a certain kind of parent 
ion, you can set up a list of possible parent ions. Then, when one of the parent ions you 
specified is detected, you can acquire product spectra and analyze the information. 
Conversely, you can also set up a list of ions that you do not want selected for 
fragmentation.

• If you have little information about your compound, you can set up the parameters of a 
data-dependent experiment so that if the intensity of the ion signal is above a specified 
threshold, the mass spectrometer generates product spectra. Later, you can decide if the 
information is useful. 

Because a data-dependent scan needs to use a target ion from a previous scan, the first scan 
event cannot be a data-dependent scan. 
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Scan Types
You can operate the TSQ Quantum XLS Series systems with a variety of scan types. The most 
common scan types are as follows:

• Full Scan

• Selected Ion Monitoring (SIM) 

• Selected Reaction Monitoring (SRM) 

• Intelligent Selected Reaction Monitoring (iSRM)

• Quantitation-Enhanced, Data-Dependent MS (QED MS)

• AutoSIM

Full Scan

The full-scan scan type provides a full mass spectrum of each analyte. With full scan, in a 
given scan time the scanning mass analyzer is scanned from the first mass to the last mass 
without interruption.

You use full-scan experiments to determine or confirm the identity of unknown compounds 
or the identity of each component in a mixture of unknown compounds. (Generally, you need 
a full mass spectrum to determine the identity of an unknown compound.) 

The full-scan scan type gives you more information about an analyte than does SIM, but a full 
scan does not yield the sensitivity that SIM or SRM can achieve. With full scan, you spend 
less time monitoring the signal for each ion than you do in SIM or SRM. Full scan provides 
greater information but lower sensitivity than SIM or SRM scan types.

To use SIM or SRM, you must know what ions or reactions you are looking for before you 
can perform an experiment with these scan types. You might use a full scan for SIM to 
determine the identity of an analyte and to obtain its mass spectrum, and a full scan for SRM 
to determine the mass spectrum and product mass spectra for parent ions of interest. Then, 
you might use SIM or SRM to do routine quantitative analysis of the compound.

Selected Ion Monitoring (SIM)

Selected ion monitoring (SIM) monitors a particular ion or set of ions. You can perform SIM 
experiments to detect small quantities of a target compound in a complex mixture when you 
know the mass spectrum of the target compound. SIM is useful in trace analysis and in the 
rapid screening of a large number of samples for a target compound.
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Because SIM monitors only a few ions, it can provide lower detection limits and greater speed 
than the full-scan modes. SIM achieves lower detection limits because more time is spent 
monitoring significant ions that are known to occur in the mass spectrum of the target 
analyte. SIM can achieve greater speed because it monitors only a few ions of interest; SIM 
does not monitor regions of the spectrum that are empty or have no ions of interest.

SIM can improve the detection limit and decrease analysis time, but it can also reduce 
specificity. Because SIM monitors only specific ions, any compound that fragments to 
produce those ions appear as the target compound, which can result in a false positive.

Selected Reaction Monitoring (SRM)

Selected reaction monitoring (SRM) monitors a particular reaction or set of reactions, such as 
the fragmentation of an ion or the loss of a neutral moiety.

SRM monitors a limited number of parent/product-ion pairs. In product-type experiments, a 
parent ion is selected as usual, but generally only one product ion is monitored. SRM 
experiments are normally conducted with the Product scan mode.

As does SIM, SRM provides for the very rapid analysis of trace components in complex 
mixtures. However, because SRM selects two sets of ions, it obtains specificity that is much 
greater than what SIM can obtain. Not only would an interfering compound have to form an 
ion source product (parent ion) of the same mass-to-charge ratio as the selected parent ion 
from the target compound, but that parent ion would also have to fragment to form a product 
ion of the same mass-to-charge ratio as the selected product ion from the target compound.

Highly-Selective Reaction Monitoring (HSRM)

Highly-selective reaction monitoring (HSRM) is SRM performed at higher Q1 resolution 
(0.4 u fwhm [less for TSQ Quantum XLS Ultra mass spectrometers] versus 0.7 u fwhm for 
SRM). 

Intelligent Selected Reaction Monitoring (iSRM)

In intelligent selected reaction monitoring (iSRM) experiments, the mass spectrometer 
performs multiple “primary” selected reaction monitoring (SRM) scans for each analyte 
(parent ion) of interest. The mass spectrometer uses for quantification the sum of the 
intensities of an analyte’s primary SRM scans.

You specify a trigger threshold for each primary SRM scan. If the intensities of all the listed 
primary SRM reactions for an analyte are above their trigger thresholds, and if all these scans 
are within a specified retention time window, then the mass spectrometer performs 
“secondary” SRM scans to confirm the identity of the analyte. The maximum number of 
secondary SRM reactions is 12 400.
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The mass spectrometer uses reference SRM scans to adjust the acquisition time window of 
subsequent SRM scans. It uses the time difference between the expected and observed 
retention times of reference SRM reactions to correct the retention times that it uses to make 
procedural decisions. The mass spectrometer still records data with the true retention times. 
You should specify two to four reference reactions spaced throughout the LC run. The mass 
spectrometer uses the preceding two retention time corrections to calculate a piecewise linear 
retention time correction for the primary SRM scans that follow. As with primary SRM scans, 
reference SRM scans might trigger secondary SRM scans.

The maximum number of primary plus reference SRM transitions is 3600.

Quantitation-Enhanced, Data-Dependent MS (QED MS) 

The quantitation-enhanced, data-dependent MS (QED MS) scan type provides simultaneous 
quantitation (SRM) and structural confirmation (full-scan MS/MS product ion spectra). If 
the intensity of an SRM reaction that you specify for a parent ion is above its trigger 
threshold, the mass spectrometer performs a full-scan MS/MS product ion scan to confirm 
the identity of the analyte. You can perform retention time correction with QED MS.

AutoSIM

In the scan type known as AutoSIM, the mass spectrometer automatically selects the most 
intense masses (m/z values) in a survey scan, builds a SIM scan list for them, and then acquires 
and records ion current at only these selected masses. You can perform AutoSIM scans on any 
full scan in any scan mode, but not on data-dependent scans.

Data Types
You can acquire and display mass spectral data (intensity versus mass-to-charge ratio) with the 
TSQ Quantum XLS Series mass spectrometers in one of two data types:

• Profile Data Type

• Centroid Data Type

Profile Data Type

In the profile data type, you can see the shape of the peaks in the mass spectrum. Each atomic 
mass unit is divided into many sampling intervals. The intensity of the ion current is 
determined at each of the sampling intervals. The profile data type displays the intensity at 
each sampling interval with the intensities connected by a continuous line. In general, use the 
profile scan data type when you tune and calibrate the mass spectrometer so that you can 
easily see and measure mass resolution.
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Centroid Data Type

The centroid data type displays the mass spectrum as a bar graph and sums the intensities of 
each set of multiple sampling intervals. This sum is displayed versus the integral center of 
mass of the sampling intervals. In general, for faster scan speed use the centroid scan data type 
for data acquisition. Data processing is also much faster for centroid data.

Mass/Charge Range
The TSQ Quantum XLS and TSQ Quantum XLS Ultra mass spectrometers can operate in a 
mass/charge range of 10 to 3000 Da, and 10 to 1500 Da, respectively. 
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Functional Description

This chapter describes the principal components of the TSQ Quantum XLS Series systems 
and their respective functions. 

A functional block diagram of the TSQ Quantum XLS Series system is shown in Figure 7. A 
sample transfer line connects the gas chromatograph (GC) to the mass spectrometer. The 
autosampler and GC are installed on the left side of the mass spectrometer. 

In analysis by GC/MS, you inject a sample into a GC column. The sample then separates into 
its various components. The components elute from the GC column and pass through the 
transfer line into the mass spectrometer where they are analyzed. You can also use a direct 
sample probe to introduce sample into the mass spectrometer.

Electron ionization (EI) or chemical ionization (CI) ionizes sample molecules upon entering 
the mass spectrometer. The ion optics focus and accelerate the resulting sample ions into the 
mass analyzer where they are filtered according to their mass-to-charge ratios. An ion 
detection system then produces a signal proportional to the number of ions detected. The 
system electronics receive and amplify the ion current signal from the ion detection system. 
That signal is then passed on to the data system for further processing, storage, and display. 
The data system provides the primary mass spectrometer user interface.

Contents

• Autosampler (optional)

• Gas Chromatograph 

• Direct Sample Probes (optional)

• Transfer Line

• Mass Spectrometer

• Data System
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Autosampler
Figure 7. Functional block diagram of the TSQ Quantum XLS Series system

Autosampler
You can use the optional Thermo Scientific TriPlus™ autosampler to inject samples 
automatically into the GC inlet. With an autosampler, you can automate your GC/MS/MS 
analyses. The TriPlus autosampler is shown in Figure 1 and Figure 2 on page 2.

Autosampler Start/Stop signals with the mass spectrometer are provided by contact closure. 

You configure the TriPlus autosampler from the data system computer. Select the TriPlus 
instrument button in the Instrument Configuration window, available from the Microsoft™ 
Windows™ taskbar by choosing Start > All Programs > Thermo Foundation 2.0 > 
Instrument Configuration. For a description of TriPlus configuration options, refer to the 
Xcalibur Help.

You also use the data system to set up the TriPlus autosampler to inject samples. Choose 
Start > All Programs > Thermo Xcalibur > Xcalibur and click Instrument Setup to open 
the Instrument Setup window. Then, click the TriPlus icon to open the TriPlus Autosampler 
page. Refer to the Help for instructions on running the TriPlus autosampler.

For maintenance procedures, refer to the documentation provided with the autosampler.
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Electrical connection
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Gas Chromatograph
The Thermo Scientific TRACE GC Ultra™ gas chromatograph (GC) separates a sample 
mixture into its chemical components by gas chromatography. In gas chromatography, the 
sample mixture is partitioned between a solid stationary phase and a mobile gas. The 
stationary phase is adhered to the inside of a small-diameter glass tube: the capillary column. 
The molecular structure of each component of the mixture determines in which order each 
component elutes from the GC and enters the mass spectrometer. The TRACE GC Ultra gas 
chromatograph is shown in Figure 1 and Figure 2 on page 2. 

Gas chromatography is widely used in analytical chemistry, though the high temperatures 
used in GC make it unsuitable for high molecular weight biopolymers, frequently 
encountered in biochemistry. It is well suited for use in the petrochemical, environmental 
monitoring, and industrial chemical fields. It is also used extensively in chemistry research.

You configure the TRACE GC Ultra gas chromatograph from the data system computer. 
Click the TRACE GC Ultra instrument button in the Instrument Configuration window, 
available from the Microsoft Windows taskbar by choosing Start > All Programs > Thermo 
Foundation 2.0 > Instrument Configuration. For a description of TRACE GC Ultra 
configuration options, refer to the Xcalibur Help.

The TSQ Quantum XLS Series data system computers can directly control the TRACE GC 
Ultra. Choose Start > All Programs > Thermo Xcalibur > Xcalibur and click Instrument 
Setup to open the Instrument Setup window. Click the TRACE GC Ultra icon to open the 
TRACE GC Ultra page. For instructions to operate the TRACE GC Ultra, refer to the Help.

For front-panel (keypad) operation of the GC and maintenance procedures for the GC, refer 
to the documentation provided with the GC. To replace the GC capillary column, see 
“Removing and Installing a GC Capillary Column” on page 107.

Direct Sample Probes
With the optional direct sample probes, you can introduce compounds directly into the ion 
source without GC column separation. See Figure 8. The direct sample probes are ideal for 
qualitative or semi-quantitative analysis of materials that do not require a GC column 
separation or are difficult, if not impossible, to elute chromatographically, as with solids. The 
direct sample probes introduce samples directly into the ion source via a vacuum interlock. 
A single controller box (Figure 8) with interchangeable probe tools makes it easy to select the 
best method of sample introduction. 

The direct sample probe system includes two probe tools: 

• Direct exposure probe

• Direct insertion probe 
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The direct exposure probe (DEP) has a heated filament that rapidly vaporizes liquids or 
solutions. The DEP is ideal for rapid molecular weight confirmation of liquids or solids 
dissolved in a suitable solvent. The DEP can vaporize compounds with a high boiling point.

The direct insertion probe (DIP) has a temperature-controlled, heated capillary tube that 
slowly vaporizes solid samples. You can use the DIP for rapid analysis of solids or trace 
components in solid matrices, such as forensic samples or tissue. 

Figure 8. Direct sample probe and controller

Transfer Line
The transfer line is the interface between the GC and mass spectrometer. The transfer line 
heats the capillary column as it passes from the GC into the ion source in the mass 
spectrometer. This prevents the sample from condensing. The transfer line includes an inlet 
for calibration gas and chemical ionization gas. See Figure 9.
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Figure 9. Transfer line 

Mass Spectrometer
The TSQ Quantum XLS Series mass spectrometers provides sample ionization and mass 
analysis of samples introduced from a gas chromatograph or direct insertion probe. The mass 
spectrometer uses a triple-quadrupole mass analyzer with an ion source external to the mass 
analyzer. Several important features of the TSQ Quantum XLS Series mass spectrometers are 
as follows:

• High sensitivity and resolution

• m/z 10 to 3000 mass range for the TSQ Quantum XLS, and m/z 10 to 1500 mass range 
for the TSQ Quantum XLS Ultra

• EI and CI ionization modes

• Positive and negative ion polarity modes

• MS and MS/MS scan modes 

• Full-scan, SIM, SRM, iSRM, QED MS, AutoSIM, and data-dependent scan types

The mass spectrometer includes the following components:

• Controls and Indicators

• EI/CI Ion Source

• Ion Optics

Mass spectrometer 
ion source end

GC end

Inlet for 
calibration gas 
and CI gas
Thermo Scientific TSQ Quantum XLS Series User Guide 21



2 Functional Description
Mass Spectrometer
• Mass Analyzer

• Ion Detection System

• Vacuum System and Inlet Gasses Hardware

• Electronic Assemblies 

• Data System

Controls and Indicators

Five light-emitting diodes (LEDs) are located in the upper right of the front panel of the mass 
spectrometer. See Figure 10 and Figure 11.

The Power LED illuminates green whenever power is supplied to the vacuum system and 
electronic assemblies of the mass spectrometer. 

The Vacuum LED illuminates yellow when the turbomolecular pump is nearly at speed 
(80 percent of its operating speed of 750 MHz), and it is safe to turn on the ion gauge. The 
Vacuum LED is off if the turbomolecular pump is not at speed. The Vacuum LED 
illuminates green whenever the pressure in the analyzer chamber, as measured by the ion 
gauge, is at or below the value required to enable high voltages to the mass analyzer. 
See Table 2.

Figure 10. Front panel LEDs of the TSQ Quantum XLS Ultra mass spectrometer

Figure 11. Front panel LEDs of the TSQ Quantum XLS mass spectrometer

Table 2. Maximum allowed pressure to turn on high voltages

Carrier gas Ar collision gas Maximum pressure (Torr)

He Off 8 × 10–6

He On 5 × 10–5

Power Vacuum Communication System Scan

CommunicationVacuumPower

System Scan
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The Communication LED illuminates yellow when the mass spectrometer and the data 
system are trying to establish a communication link. The Communication LED illuminates 
green when the Ethernet communication link between the mass spectrometer and the data 
system has been made. 

The System LED illuminates yellow whenever the mass spectrometer is in standby—that is, 
high voltage is not supplied to the ion source, mass analyzer, or ion detection system, but the 
mass spectrometer power is on. The System LED illuminates green whenever the high voltage 
is enabled and the system is in the On state. High voltage is enabled if the pressure of the 
analyzer chamber is below the values listed in Table 2.

The Scan LED flashes blue whenever the mass spectrometer is on and is scanning ions.

The System Power Off button, located on the front of the electronics module, turns off power 
to the mass spectrometer, gas chromatograph, and autosampler. See Figure 12. To restore 
power to the mass spectrometer, gas chromatograph, and autosampler, you must use the main 
power circuit breaker, located on the back of the electronics module.

Figure 12. Front panel System Power Off button

The main power circuit breaker switch (labeled Main Power) is located on the power panel at 
the back of the electronics module. See Figure 13. In the Off (O) position, the circuit breaker 
removes all power to the mass spectrometer, gas chromatograph, and autosampler. In the 
On (|) position, power is supplied to the mass spectrometer, gas chromatograph, and 
autosampler. In the standard operational mode, the circuit breaker is kept in the On (|) 
position.

CAUTION  In an emergency, to shut off all power to the mass spectrometer, gas 
chromatograph, and autosampler, press the System Power Off button located at the front 
of the instrument.

System

System Power Off
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Figure 13. Back power panel of the electronics module

The mass spectrometer main power circuit breaker switch (labeled Main Power) is located on 
the instrument power panel in the lower corner of the right-side panel of the mass 
spectrometer. See Figure 14. In the Off position, the circuit breaker removes all power to the 
mass spectrometer, including the vacuum pumps. In the On position, power is supplied to the 
mass spectrometer. For the standard operational mode, the circuit breaker is in the On 
position.

The electronics service switch (labeled Electronics) is located next to the main power circuit 
breaker on the mass spectrometer power panel (Figure 14). In the Service Mode position, the 
switch removes power to all components of the mass spectrometer other than the vacuum 
system. The Operating Mode position supplies power to all non-vacuum system components 
of the mass spectrometer. 

The vacuum service switch (labeled Vacuum) is located next to the electronics service switch 
on the instrument power panel (Figure 14). In the Service Mode position, the switch removes 
power to all components of the vacuum system, including the forepump, turbomolecular 
pump, and turbomolecular pump controller. The switch in the Operating Mode position 
supplies power to all vacuum system components of the mass spectrometer. 

The System Reset button is also located on the mass spectrometer power panel. Pressing the 
System Reset button takes the 5 V logic to ground and causes the embedded computer on the 
System Control printed circuit board (PCB) to restart. For information on how to reset the 
mass spectrometer software is then reloaded from the data system, see “Resetting the Data 
System” on page 57. For information on how to reset the mass spectrometer, see “Resetting 
the Mass Spectrometer” on page 57.

Three LEDs are located on the power panel: The Pump On LED is green when the rough 
pump current sensor detects current to the forepump. The LED is off when the forepump 
current sensor does not detect current to the forepump. If the current sensor detects a loss of 
current when the mass spectrometer is on, the vacuum system vents.

The Vent Valve Closed LED is green whenever the vent valve current sensor detects current 
through the vent valve and the vent valve is closed. The LED is off when the vent valve is 
open.

! !

Power In GC Power Out Quantum Power Out A/S Power Out

V~230 
50/60 Hz,  2A MAX

V~230  
50/60 Hz,  10A MAX

V~230  
50/60 Hz,  16A MAX

       V~230
              Hz,  30A MAX
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The Ethernet Link OK LED is green when the System Control PCB is communicating with 
the data system computer. The LED is off when there is no communication between the 
System Control PCB and the data system computer.

Figure 14. Right-side power panel of the mass spectrometer

Qualified
Service

Personnel
Only

!

Electronics Vacuum

Pump On
Thermo Scientific TSQ Quantum XLS Series User Guide 25



2 Functional Description
Mass Spectrometer
EI/CI Ion Source

The EI/CI ion source forms gas phase sample ions from sample molecules that elute from the 
GC or are introduced by the direct sample probe. See Figure 15. You can operate the ion 
source in either the electron ionization (EI) or chemical ionization (CI) mode. See “Ionization 
Modes” on page 3.

Figure 15. Ion source of the TSQ Quantum XLS Series mass spectrometer

The ion volume, located in the center of the ion source, is the site where electrons interact 
with sample or reagent gas molecules to form ions. Three exchangeable ion volumes and 
ion volume holders are available for use in the ion source. See Figure 16. The choice of ion 
volume depends on the ionization mode. The open EI ion volume is open on the analyzer 
end, with a relatively large electron entrance hole. The closed EI ion volume has a smaller ion 
exit hole than the EI ion volume. This results in a higher pressure of analyte and greater 
sensitivity, but less dynamic range. The CI ion volume is closed on the analyzer end, except 
for a small ion exit hole and a relatively small electron entrance hole. In the CI mode, you 
must maintain a relatively high reagent gas pressure.

Magnets and 
magnet yoke

Filament

EI/CI source 
PCB

Heater ring

Ion source 
block

Heated Q0 quadrupole 
assembly

 L1, L2, L3, lens 
assembly
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The ion source block holds the ion volume in its center. Samples are introduced from the 
GC capillary column through an aperture on the side of the ion source block and then into 
the ion volume. Gases for calibration or chemical ionization enter the ion volume through the 
transfer line.

Figure 16. EI (left), closed EI (center), and CI (right) ion volumes and holders 

Cartridge heaters heat the ion source block and lens assemblies to minimize the rate at which 
deposits form on the ions source block, ion volume, and lens assemblies. The ion source block 
is also heated to assist in the rapid temperature equilibration of the ion source block and ion 
volume after the filament is turned on. In EI mode, the ion source is typically maintained at 
150 oC to 220 oC. However, you can sometimes use lower or higher temperatures for certain 
applications. In the CI mode, the ion source is typically maintained at 180 oC to 200 oC. The 
ion source heater is feedback controlled. 

The filament assembly, positioned in a recess at the top of the ions source block, contains the 
filament, reflector, and electron lens. The filament is a rhenium wire that is electrically heated 
to produce electrons by thermionic emission. The reflector repels electrons emitted by the 
filament away from the filament toward the ion volume. The filament and its reflector are 
maintained at a negative potential relative to the ion volume. The electron lens prevents 
positive ions from traveling up the electron beam. In turn, this prevents positive ions from 
leaving the ion volume through the electron entrance hole. The difference in potential 
between the filament and the ion volume determines the electron energy.

Two permanent magnets are held in a magnet yoke in the proper position above and below 
the ion source block. The permanent magnets collimate the electron beam and cause the 
beam to spiral through the ion volume. This ensures optimum ionization of the sample.

The ion source of the TSQ Quantum XLS Series mass spectrometer has two ion source len 
assemblies, called the L1, L2, and L3 lens assembly and the heated Q0 quadrupole assembly. 
The lenses extract the ions formed in the ion source and transmit them to the ion optics. The 
lens L1 voltage is mass dependent. The rods of the heated Q0 quadrupole contact the rods of 
the Q0 quadrupole and share their rf and dc voltages. 

Ion volume 
holder

Electron 
entrance 
hole

Ion exit hole 
(front)

Electron 
exit hole

GC effluent, CI gas, calibration gas 
entrance hole
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Inlet Valve

The inlet valve, which is attached to the front of the vacuum manifold, is a vacuum-sealed 
valve that allows you to change ion volumes or insert the direct exposure probe without 
venting the mass spectrometer to atmosphere. You use the insertion/removal (I/R) tool to 
insert or remove ion volumes. See Figure 17. The forepump evacuates the inlet valve. 

The ball valve is a ball with a hole in it, and it is located between the vacuum manifold and 
the inlet valve block. The ball valve is open when the hole in the ball is aligned with the 
opening between the vacuum manifold and the inlet valve. The ball valve lever opens and 
closes the ball valve. When the ball valve is closed, it prevents the vacuum manifold from 
venting to atmosphere. 

Figure 17. Inlet valve, I/R tool, guide bar, and ball valve lever 

Inlet 
valve

I/R tool

Guide bar

Ball valve lever
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Ion Optics

The ion optics focus the ions produced in the ion source and transmit them to the mass 
analyzer. The ion optics includes the Q0 quadrupole and lenses L11 and L12. 

The Q0 quadrupole is a square array of square-profile rods that act as an ion transmission 
device. See Figure 18. An rf voltage applied to the rods gives rise to an electric field that guides 
the ions along the axis of the quadrupole. The Q0 offset voltage increases the translational 
kinetic energy of ions emerging from the ion source. 

The Q0 quadrupole is split into two sections. See Figure 18. The smaller, heated Q0 
quadrupole assembly attaches to the ion source, which heats it with the cartridge heaters. The 
rods of the heated Q0 quadrupole make electrical contact with the rods of the larger Q0 
quadrupole.

Figure 18. Heated Q0 quadrupole (left) and Q0 quadrupole (right)

Figure 19 gives a cross-sectional view of the transfer line, ion source, heated Q0 quadrupole, 
and Q0 quadrupole.
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Figure 19. Cross-sectional view of the transfer line, ion source, heated Q0 quadrupole, and Q0 quadrupole of the TSQ 
Quantum XLS Series mass spectrometer

The L11 and L12 lenses are metal disks with a circular hole in the center that the ion beam 
can pass through. Together they act as a two-element cone lens. You can apply an electrical 
potential to the lens to accelerate (or decelerate) ions as they approach the lens and focus the 
ion beam as it passes through the lens. The value ranges between 0 and ±300 V. Lenses L11 
and L12 also act as a vacuum baffle between the Q0 quadrupole chamber and the mass 
analyzer chamber.

Q0 quadrupole

Heated Q0 quadrupole
Lens L1

Ion source 
ion volumeLens L3

Lens L2

Transfer line

Capillary column
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Mass Analyzer

The mass analyzer separates ions according to their mass-to-charge ratio and then passes them 
to the ion detection system. The mass analyzers on the TSQ Quantum XLS Series mass 
spectrometers consist of three quadrupole rod assemblies (Q1, Q2, and Q3) and three lens 
sets.

The mass analyzer is discussed in detail in the following subtopics:

• Quadrupole Rod Assemblies

• Rf and dc Fields Applied to the Quadrupoles

• Mass Analysis

• Collision Cell and CID Efficiency 

• Quadrupole Offset Voltage

• Mass Analyzer Lenses

Quadrupole Rod Assemblies

The three rod assemblies used in the mass spectrometer are numbered from the ion source end 
of the manifold and are designated Q1, Q2, and Q3. Q1 and Q3 are quadrupoles that enable 
high-resolution scans without signal loss. 

Q1 and Q3 are square arrays of precision-machined and precision-aligned, true hyperbolic 
quadrupoles, called hyperquads (TSQ Quantum XLS Ultra mass spectrometer) or 
hyperbolic-profile round rods (TSQ Quantum XLS mass spectrometer). See Figure 20 and 
Figure 21. Quartz spacers act as electrical insulators between adjacent rods. 

Figure 20. Q1 or Q3 hyperquad of the TSQ Quantum XLS Ultra mass spectrometer

Figure 21. Q1 or Q3 quadrupole of the TSQ Quantum XLS mass spectrometer
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Q2 is a square-profile quadrupole rod assembly. Q2 always acts as an ion transmission device. 
The Q2 quadrupole rods are bent through a 90-degree arc. In addition to reducing the 
footprint of the instrument, this prevents the transmission of unwanted neutral species to the 
detector and dramatically lowers the noise level in the data. Q2 has become synonymous with 
the term collision cell. Technically, the collision cell is the chamber that encloses Q2 where 
collision-induced dissociation can take place if the argon collision gas is present. See 
Figure 22.

Figure 22. Collision cell, Q2 quadrupole, and lenses 

Rf and dc Fields Applied to the Quadrupoles

In a quadrupole rod assembly, because rods opposite each other in the array connect 
electrically, you can consider the four rods as two pairs of two rods each. Ac and dc voltages 
are applied to the rods and these voltages are ramped during the scan. Voltages of the same 
amplitude and sign are applied to the rods of each pair. However, the voltages applied to the 
different rod pairs are equal in amplitude but opposite in sign. See Figure 23.

Lenses L21, L22, 
and L23

Lenses L31, L32,
and L33
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Figure 23. Polarity of the rf and dc voltages applied to the rods of the Q1 and Q3 mass analyzers

The ac voltage applied to the quadrupole rods is of constant frequency (1.123 MHz). The 
ac voltage applied to the rods varies from 0 to 10 000 V peak-to-peak, and the dc voltage 
varies from 0 to ±840 V. Voltages of the same amplitude and sign are applied to each rod pair. 
However, the voltages applied to the other rod pair are equal in amplitude but opposite in 
sign.

Because the frequency of this ac voltage is in the radio frequency range, you refer to it as 
rf voltage. In Figure 24, the solid line represents the combined rf and dc voltage applied to 
one rod pair, and the dashed line represents the combined rf and dc voltage applied to the 
other rod pair. The ratio of rf voltage to dc voltage determines the ability of the mass 
spectrometer to separate ions of different mass-to-charge ratios.

The first and third quadrupole rod assemblies (Q1 and Q3 quadrupoles) can act as mass 
analyzers or as ion transmission devices. When both rf and dc voltages are applied, Q1 and 
Q3 function as mass analyzers. When only rf voltage is applied, they act as ion transmission 
devices. In the ion transmission mode, the quadrupole rod assemblies allow ions in a wide 
window of mass-to-charge ratios to pass.

The square quadrupole rod assembly (Q2) operates in the ion transmission mode only. 
Surrounding Q2 is a collision cell where CID can take place if the argon collision gas is 
present in the cell.

rf voltage
+ dc voltage

rf voltage 180° out of phase 
–dc voltage
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Figure 24. Magnitude of the rf and dc voltages applied to the rods of the Q1 and Q3 mass 
analyzers 

Mass Analysis

The Q1 and Q3 rods are charged with a variable ratio of rf voltage and dc voltage (Figure 24). 
These potentials give rise to an electrostatic field that gives stable oscillations to ions with a 
specific mass-to-charge ratio and unstable oscillations to all others.

At any given instant, one particular set of rf and dc voltage values is being applied to the mass 
analyzer rods. Under these conditions, only ions of one mass-to-charge ratio (for example, 
m/z 180) are maintained within bounded oscillations as their velocity carries them through 
the mass analyzer. During this same time, all other ions undergo unbounded oscillations. 
These ions strike one of the rod surfaces, become neutralized, and are pumped away, or they 
are ejected from the rod assembly.

10,000 V P/P 
  840 V DC VOLTAGE
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Then, at a later time, both rf and dc voltages change, and ions of the next mass-to-charge ratio 
(for example, m/z 181) are allowed to pass, while all other ions (including m/z 180) become 
unstable and undergo unbounded oscillations. This process continues, with ions of one 
mass-to-charge ratio after another being transmitted, as the rf and dc voltages change in value. 
The potentials on the quadrupole rods can be changed rapidly and precisely. At the end of the 
scan, the mass spectrometer discharges the rf and dc voltages to zero and repeats the process.

The precision quadrupole rods of the mass spectrometer provide excellent sensitivity, peak 
shape, resolution, and high mass transmission.

Collision Cell and CID Efficiency

In the MS/MS scan modes, the mass spectrometer applies a large voltage of opposite polarity 
to the Q2 rod pairs between scans, which empties the collision cell. This process ensures that 
no ions remain in the collision cell from scan to scan.

The collision cell quadrupole rod assembly (Q2), which always acts as an ion transmission 
device, is a quadrupole array of square-profile rods. A variable rf voltage charges the rods, 
which creates an electrostatic field that gives stable oscillations to ions in a wide window of 
mass-to-charge ratios. 

The collision cell surrounds Q2 and is usually pressurized from about 1 × 10–3 to 
4 × 10–3 Torr with argon collision gas. The collision cell is where collision-induced 
dissociation (CID) takes place.

CID is a process in which an ion collides with a neutral atom or molecule and then, because 
of the collision, dissociates into smaller fragments. The mechanism of dissociation involves 
converting some of the translational kinetic energy (TKE) of the ion into internal energy. This 
collision places the ion in an excited state. If the internal energy is sufficient, the ion 
fragments. 

Three expressions convey the efficiency of the CID process:

• Collection efficiency

• Fragmentation efficiency

• Overall CID efficiency

Collection efficiency: The ion flux ratio measured at the exit of the collision cell and at its 
entrance. With no collision gas present, the mass spectrometer obtains virtually 100 percent 
collection efficiency. Collection efficiency is a mass-dependent parameter. For example, with 
mid-range collision gas pressure, the collection efficiency might vary from about 50 percent 
for comparatively less massive ions (which are more prone to scatter) up to 75 percent for 
comparatively more massive ions (which are less prone to scatter). 
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Fragmentation efficiency: The fraction of the ion flux at the exit of the collision cell that 
results from fragmented ions. Fragmentation efficiency depends directly on the stability of the 
ion and indirectly on the mass of the ion. The more stable the ion, the less likely a given 
collision will fragment the ion. Typically, low mass ions require a higher collision energy to 
dissociate than high mass ions. To compensate for this, you can use the data system to specify 
a mass-dependent collision energy ramp.

With a mid-range collision gas pressure, fragmentation efficiency might vary from 15 percent 
to 65 percent for various compounds. As the collision gas pressure increases, the 
fragmentation efficiency for all compounds approaches 100 percent due to multiple collisions. 
The collection efficiency decreases, however, due to scattering.

Overall CID efficiency: The product of the collection efficiency and the fragmentation 
efficiency. The overall CID efficiency exhibits a maximum with intermediate pressure. As the 
pressure is increased beyond the optimum value, more and more collisions take place, the 
probability of scattering increases, and fewer and fewer ions pass through the collision cell. 
This results in the collection efficiency decreasing. The fragmentation efficiency also decreases 
as the pressure is decreased from its optimum value, because fewer and fewer collisions take 
place. 

Quadrupole Offset Voltage

The quadrupole offset voltage is a dc potential applied to the quadrupole rods in addition to 
the ramping dc voltage. The offset voltage applied to the two rod pairs of the assemblies is 
equal in magnitude and equal in sign. Because the quadrupole offset voltage accelerates or 
decelerates ions, it sets the TKE of the ions as they enter the quadrupole rod assembly. 

In general, for a given experiment, the mass spectrometer has fixed offset voltages for Q1 and 
Q2. However, in MS/MS experiments, the quadrupole offset voltage applied to Q3 usually 
varies as a scan proceeds. The mass spectrometer automatically computes the Q3 quadrupole 
offset voltage necessary and then varies the voltage, as appropriate, as each scan proceeds.

The offset voltage applied to Q2 (which contains the collision cell) is responsible for the 
collision energy. The collision energy is the difference in potential between the ion source 
(where parent ions are formed) and Q2 (where they collide with collision gas). As the offset 
voltage on Q2 increases, the TKE of the parent ions also increases. As a result, increases in the 
Q2 offset voltage increase the energy of ion/Ar collisions. The collision energy is usually 
ramped downward with m/z to promote the fragmentation of low mass ions.

Before obtaining any mass spectra, the mass spectrometer tunes Q1 in the Q1MS scan mode 
(Q2 and Q3 rf voltage only), and tunes Q3 in the Q3MS scan mode (Q1 and Q2 rf voltage 
only). During tuning, the mass spectrometer determines the optimum quadrupole offset 
voltage for Q1 and for Q3.
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Mass Analyzer Lenses

The TSQ Quantum XLS Series mass analyzers have three lens sets. See Figure 22 on page 32. 
Those between Q1 and Q2 are designated L21, L22, L23; those between Q2 and Q3 are 
designated L31, L32, L33; and the lens between Q3 and the ion detection system is 
designated the exit lens. All of the lenses have circular holes in their centers that the ion beam 
passes through.

The lens assemblies also retain the three rod assemblies to ensure accurate and automatic axial 
alignment of the rod assemblies.

The L2x lens set (between Q1 and Q2),where x=1,2,3, and the L3x lens set (between Q2 and 
Q3) serve these functions:

• To minimize the amount of collision gas that enters the mass analyzers (Q1 and Q3) from 
the collision cell (Q2). Lenses L22 and L21 on one side of Q2 and lenses L32 and L33 on 
the other side of Q2 act as baffles. (For high-mass transmission, be sure to maintain a low 
pressure in the mass analyzers.) 

• To retain the collision gas. Lenses L23 and L3 form two of the walls of the collision cell, 
so they tend to hold the collision gas in the collision cell. The collision gas escapes, 
however, through the same lens holes that the ion beam passes through.

• To shield Q1 from the rf voltage applied to Q2 and vice versa (L2x lens set) and to shield 
Q3 from the rf voltage applied to Q2 and vice versa (L3x lens set).

• To focus the ion beam. The three lenses between Q1 and Q2 (and those between Q2 and 
Q3) together form a three-element aperture lens. The first and third lenses are generally 
set to similar or identical values and the central lens is set to a value different (either 
higher or lower) from the other two.

The voltage applied to each of the lenses can vary from about –300 to +300 V. Typically, 
however, the voltage applied to the first and third elements of the L2x lens set is somewhat 
greater than the quadrupole offset voltage applied to Q1. Because the Q1 quadrupole offset 
voltage is generally set to about ±5 V (depending on the charge of the ions of interest), the 
voltage applied to lenses L21 and L23 is typically about –10 V for positive ions and +10 V for 
negative ions. The voltage applied to the central lens of the L2x lens set is typically about 
±225 V.

In the Q3MS scan mode, the voltage applied to the lenses of the L3x lens set is about the same 
as that applied to the corresponding lens in the L2x lens set. Note, however, that in the 
MS/MS scan modes, the voltage applied to the L3x lens set automatically varies with the 
quadrupole offset voltage applied to Q3. As the Q3 quadrupole offset voltage ramps, the 
voltages applied to the lenses ramp correspondingly. 

The exit lens is located between Q3 and the ion detection system. The exit lens is held at 
ground potential. Its purpose is to shield Q3 from the high voltage applied to the ion 
detection system and to shield the ion detection system from the high rf voltages applied 
to Q3.
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Ion Detection System

The TSQ Quantum XLS Series mass spectrometers are equipped with a high-sensitivity, 
off-axis ion detection system. See Figure 25. This system produces a high signal-to-noise ratio 
and provides for voltage polarity switching between positive ion and negative ion modes of 
operation. The ion detection system includes a 10 kV conversion dynode and a channel 
electron multiplier. The ion detection system is located on the back of the vacuum manifold 
behind the mass analyzer. 

The conversion dynode is a concave metal surface located at a right angle to the ion beam. 
The mass spectrometer applies to the conversion dynode a potential of +10 kV for negative 
ion detection or –10 kV for positive ion detection. When an ion strikes the surface of the 
conversion dynode, one or more secondary particles are produced. These secondary particles 
can include positive ions, negative ions, electrons, and neutrals. When positive ions strike a 
negatively charged conversion dynode, the secondary particles of interest are negative ions and 
electrons. When negative ions strike a positively charged conversion dynode, the secondary 
particles of interest are positive ions. The curved surface of the conversion dynode focuses 
these secondary particles and a voltage gradient accelerates the particles into the electron 
multiplier. 

The electron multiplier includes a cathode and an anode. The cathode of the electron 
multiplier is a lead-oxide, funnel-like resistor. The high voltage ring applies a potential of up 
to –2.5 kV to the cathode. The exit end of the cathode (at the anode) is near ground 
potential. 

The anode of the electron multiplier is a small cup located at the exit end of the cathode. The 
anode collects the electrons produced by the cathode. The anode screws into the anode 
feedthrough in the base plate.
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Figure 25. Ion detection system, showing the electron multiplier (top) and conversion dynode 
(bottom)

Secondary particles from the conversion dynode strike the inner walls of the electron 
multiplier cathode with sufficient energy to eject electrons. The ejected electrons are 
accelerated farther into the cathode, drawn by the increasingly positive potential gradient. 
The funnel shape of the cathode causes the ejected electrons not to travel far before they again 
strike the inner surface of the cathode, which causes the emission of more electrons. A cascade 
of electrons is then created that finally results in a measurable current at the end of the 
cathode where the anode collects the electrons. The current collected by the anode is 
proportional to the number of secondary particles striking the cathode.

Typically, the electron multiplier is set to a gain of about 3 × 105 (that is, for each ion or 
electron that enters, 3 × 105 electrons exit) in MS mode and 2 × 106 in MS/MS mode. The 
electrometer circuit converts the current that leaves the electron multiplier via the anode to a 
voltage, and the data system records the voltage. 

The ion detection system of the mass spectrometer increases signal and decreases noise. The 
high voltage applied to the conversion dynode results in a high conversion efficiency and 
increased signal—that is, each ion that strikes the conversion dynode produces many 
secondary particles. The increase in conversion efficiency is more pronounced for more 
massive ions than it is for less massive ions.

Because of the off-axis orientation of the ion detection system relative to the mass analyzer, 
neutral molecules from the mass analyzer tend not to strike the conversion dynode or electron 
multiplier. As a result, noise from neutral molecules is reduced.
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Vacuum System and Inlet Gasses Hardware

The vacuum system evacuates the region around the ion source, ion optics, mass analyzer, and 
ion detection system. The principal components of the vacuum system include the following:

• Vacuum Manifold

• Turbomolecular Pump

• Forepump

• Convectron Gauges

• Ion Gauge

The inlet gasses hardware controls the flow of collision gas, CI reagent gas, calibration 
compound, and air (during venting) into the mass spectrometer. The hardware for the inlet 
gases includes the following components:

• Vent Valve

• Collision Gas Flow Control Valves

• Calibration Compound and CI Reagent Gas Flow Control

Figure 26 shows a functional block diagram of the vacuum system and inlet gasses hardware.

Figure 26. Functional block diagram of the vacuum system and inlet gases hardware 
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Vacuum Manifold

The vacuum manifold encloses the ion source, ion optics, mass analyzer, and ion detection 
system assemblies. The vacuum manifold is a thick-walled, aluminum chamber with two 
removable side cover plates, with openings on the front, sides, and top, and various electrical 
feedthroughs and gas inlets. 

The main vacuum manifold is divided into two chambers by a baffle. See Figure 27. The high 
vacuum port of the turbomolecular pump evacuates the region inside the first chamber, called 
the analyzer region, to less than 10–5 Torr. The turbomolecular pump then discharges into the 
forepump through the foreline. 

The region inside the second chamber, called the Q0 quadrupole region, is evacuated to 
1 mTorr by the interstage port of the turbomolecular vacuum pump. 

A second vacuum manifold houses the ion source, which is open to the Q0 quadrupole 
chamber. The interstage port of the turbomolecular pump also evacuates the ion source 
region.

When CID is turned on, the collision cell chamber, inside the analyzer chamber, has a 
user-controlled argon pressure of between 1 and 4 mTorr. The forepump evacuates the argon 
in the collision cell when CID is turned off.

Two removable side cover plates on the left side of the vacuum manifold allow access to the 
Q0 ion optics, mass analyzer, and ion detection system. Two electrically conductive O-rings 
provide a vacuum-tight seal between the side cover plates and the vacuum manifold. 
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Figure 27. Vacuum manifold (interior)

Turbomolecular Pump

A Leybold TW220/150/15S double-inlet turbomolecular pump provides the vacuum for the 
ion source, Q0 quadrupole region, and analyzer region of the vacuum manifold. The 
turbomolecular pump mounts onto the top of the vacuum manifold (Figure 27). 

The turbomolecular pump has two pumping inlets: 

• A high-vacuum inlet at the top of the rotor stack, which evacuates the analyzer chamber

• An interstage inlet about halfway down the rotor stack, which evacuates the ion source 
and Q0 quadrupole chambers 
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The turbomolecular pump is controlled by a Leybold TDS controller and powered by a 
+24 V dc (250 W) power supply. The mass spectrometer circuit breaker switch and the 
vacuum service switch, but not the electronics service switch, turn power for the 
turbomolecular pump off and on. A fan draws air in from the front of the instrument to cool 
the pump.

Power to the turbomolecular pump shuts off if the foreline pressure, as measured by the 
Convectron™ gauge, is too high, or if the turbomolecular temperature is too high. 

Forepump

An Edwards™ E2M30 forepump (or roughing pump) establishes the vacuum necessary for the 
proper operation of the turbomolecular pump. The forepump also evacuates the inlet valve 
and the collision cell. The pump has a maximum displacement of 650 L/min and maintains a 
minimum pressure of approximately 0.01 Torr (1 Pa). 

The forepump is connected to the turbomolecular pump by a section of reinforced PVC 
tubing. The power cord of the forepump is plugged into the outlet labeled Forepump on the 
power panel (see Figure 14 on page 25). This outlet supplies power to the pump and is 
controlled by the main power circuit breaker switch and vacuum service switch, not by the 
electronics service switch.

Convectron Gauges

A Convectron gauge measures the pressure in the inlet valve and the foreline, which connects 
the turbomolecular pump and the forepump. A second Convectron gauge measures the 
pressure of argon collision gas in the collision cell.

The Convectron gauge uses a Wheatstone bridge with a temperature dependent resistor to 
measure pressure down to a fraction of a mTorr. The voltage present at the top of the bridge 
depends on how fast the resistor can radiate heat, which is related to the pressure. The 
pressure that the Convectron gauge measures is monitored by vacuum protection circuitry on 
the Source PCB, which in turn is monitored by the embedded computer on the System 
Control PCB. The vacuum protection circuitry detects whether the foreline pressure is too 
high for the proper operation of the turbomolecular pump. 

Ion Gauge

A Granville-Phillips™ 342 mini ion gauge measures the pressures in the analyzer region of the 
vacuum manifold. The ion gauge produces energetic electrons that cause the ionization of 
molecules in the ion gauge. Positive ions formed in the ion gauge are attracted to a collector. 
The collector current is related to the pressure in the vacuum manifold. The ion gauge is also 
involved in vacuum protection.

CAUTION  Always plug the forepump power cord into the outlets labeled Forepump on the 
right side power panel of the mass spectrometer. Never plug it directly into a wall outlet.
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Vent Valve

The vent valve, located in the area of Q2, allows the vacuum manifold to be vented with 
nitrogen, if you have a nitrogen cylinder connected, or else with air that has been filtered 
through a sintered nylon filter. The vent valve is a solenoid-operated valve, which is controlled 
by the Vent Delay PCB. When the solenoid is energized, the vent valve closes. If the power 
fails or the main power circuit breaker is placed in the Off (O) position, a 4-farad capacitor 
located in the Power Entry Module keeps the solenoid in the closed position for several 
minutes. If power is not restored in this time, then the solenoid opens and the system is 
vented with nitrogen or filtered air. The vent valve closes after power is restored to the mass 
spectrometer. 

Collision Gas Flow Control Valves

The collision gas flow control valves control the flow of argon collision gas into and out of the 
Q2 collision cell. A solenoid valve acts to shut off argon gas flow to the cell. The collision gas 
pressure is regulated by a proportional valve that is controlled by the data system. You can set 
the collision gas pressure (0 to 5 mTorr) in the Define Scan dialog box of the EZ Tune 
window. 

Ions enter the Q2 collision cell, collide with the argon collision gas, and then, because of the 
collision, dissociate into smaller fragments. See “Collision Cell and CID Efficiency” on 
page 35.

Argon enters the mass spectrometer through a 1/8 in. port on the left side of the mass 
spectrometer. 

A second proportional valve allows the forepump to evacuate the Q2 collision cell of argon 
and waste gases when CID is turned off. The mass spectrometer automatically opens and 
closes the collision gas evacuation valve, depending on whether Q2 is acting as an ion 
transmission device or a collision cell. 

Calibration Compound and CI Reagent Gas Flow Control

The calibration compound gas flow control valve controls the flow of calibration compound 
gas into the ion source, via the transfer line. The calibration gas flow can be either high or low. 
Normally, you use low flow, but high flow might be necessary for negative ion CI calibration. 

The CI gas flow control valve controls the flow of chemical ionization reagent gas into the ion 
source, via the transfer line. The maximum CI gas flow rate is about 4 mL/min, depending on 
the gas.
44 TSQ Quantum XLS Series User Guide Thermo Scientific



 2 Functional Description
Mass Spectrometer
Electronic Assemblies 

The electronic assemblies that control the operation of the mass spectrometer are distributed 
among various PCBs and other modules located in the tower, in the embedded computer, and 
on or around the vacuum manifold of the mass spectrometer. 

The Power Entry Module provides the following:

• Mass spectrometer power control
• A contact closure interface
• Vent valve control
• An Ethernet 100 base-T connection from the System Control PCB to the data system PC
• A mechanical pump failure protection circuit (linked to vent valve control)
• A system reset button
• Status LEDs
• Service ports

The right-side power panel, shown in Figure 14 on page 25, is part of the Power Entry 
Module.

The Power Entry Module accepts line power, filters it, and provides it to various components 
of the mass spectrometer. The Power Module includes these components:

• Main power circuit breaker switch
• Surge suppressor
• Line filter
• Electronics service switch
• Vacuum service switch

The “brains” of the mass spectrometers is the System Control PCB. The System Control PCB 
and embedded computer include the following:

• PowerPC processor
• Serial Peripheral Interconnect (SPI) bus
• I/O coprocessor
• Super Harvard Architecture Computer (Sharc) bus
• Scan generator DSP
• Acquisition processor DSP
• Interbus bridge
• 100 base-T Ethernet port
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The rf voltage generation electronic assemblies produce the Q0, Q1, Q2, and Q3 rf voltages 
that enable ion transmission and mass analysis. All rf voltages are controlled by the Analyzer 
Control PCB and the System Control PCB. 

The Q1 and Q3 rf voltage amplifier circuits are identical, and the circuits for Q0 and Q2 are 
similar. 

The rf voltage generation electronic assemblies include the following components: 

• rf oscillator
• rf Voltage Amplifier PCB
• Low Pass Filter PCB
• rf voltage coil
• rf voltage detector
• Mass DAC
• Integrating amplifier

The ion detection system electronic assemblies provide high voltage to the electron multiplier 
and conversion dynode of the ion detection system. They also receive the electron multiplier 
output current signal, convert it to a voltage (by the electrometer circuit), and pass it to the 
embedded computer.

The ion detection system electronic assemblies include the following:

• Electron multiplier power supply
• Conversion dynode power supply
• Electrometer PCB
• Acquisition DSP

The Analyzer Control PCB contains circuitry for controlling and monitoring the operation of 
the ion source, ion optics, mass analyzer, and ion detection system. These circuits are in turn 
monitored by the PowerPC processor of the System Control PCB via the SPI bus. 

The Analyzer Control PCB controls and monitors the rf voltages for Q0, Q1, Q2, and Q3 
quadrupoles. It also has lens voltage drivers that convert ±330 V dc power from the DC Rod 
Driver PCB to dc voltages that are applied to the lenses.

Data System
The data system controls and monitors the mass spectrometer. The data system also processes 
data that the mass spectrometer acquires. The data system is composed of the following:

• Computer Hardware

• Data System/Mass Spectrometer/GC Interface

• Data System/Local Area Network Interface
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Computer Hardware

These are the major features of the data system computer:

• Intel™ Pentium™, Core™ 2 Duo, or Xeon™ processor
• High-capacity hard disk drive
• Primary Ethernet port (data system to mass spectrometer)
• Secondary Ethernet port (data system to local area network)
• High-performance video graphics card 
• CDRW drive
• DVD drive
• 1280 ×1024 resolution color monitor
• Keyboard and mouse

For more information about the computer, refer to the appropriate manuals.

Data System/Mass Spectrometer/GC Interface 

The data system computer contains a 100 base-T Ethernet adapter (called the primary 
Ethernet adapter) that is dedicated to data system/mass spectrometer/GC communication. 
This primary Ethernet adapter communicates with the mass spectrometer and GC modules 
via a 10/100 base-T Ethernet switch. The Ethernet adapter on the mass spectrometer resides 
on the System Control PCB. A twisted pair, Ethernet cable connects the primary Ethernet 
adapter of the data system to the Ethernet switch, which is connected to the Ethernet 
connector on the power panel of the mass spectrometer and to the GC.

Data System/Local Area Network Interface 

The data system computer contains a secondary Ethernet adapter. This secondary Ethernet 
adapter is not involved in data system/mass spectrometer or GC communications. You can 
use this secondary Ethernet adapter to access your local area network.
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System Shutdown, Startup, and Reset

Many maintenance procedures for the TSQ Quantum XLS Series systems require that the 
mass spectrometer be shut down completely. In addition, you can place the mass spectrometer 
in Standby mode if you plan to not use the system for 12 hours or more.

Shutting Down the System in an Emergency
You can turn off all power to the mass spectrometer, gas chromatograph, and autosampler by 
pressing the System Power Off button, located on the front of the electronics module (see 
Figure 28), or the main power circuit breaker, located on the back of the electronics module 
(see Figure 29). You can turn on the system power only with the main power circuit breaker 
on the back of the electronics module and not the System Power Off switch.

To turn off the mass spectrometer in an emergency

Contents

• Shutting Down the System in an Emergency

• Placing the System in Standby Mode

• Shutting Down the System Completely

• Starting Up the System after a Complete Shutdown

• Resetting the Mass Spectrometer

• Resetting the Data System

• Turning Off Selected Mass Spectrometer Components

CAUTION  Press the System Power Off button located on the front of the electronics 
module. See Figure 28. The System Power Off button turns off all power to the mass 
spectrometer (including the vacuum pumps), gas chromatograph, and autosampler. 
Although removing power abruptly does not harm components within the system, 
under normal conditions do not shut down the system using the System Power Off 
button. For the recommended procedure, see “Shutting Down the System 
Completely” on page 51. 
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Shutting Down the System in an Emergency
Figure 28. System Power Off button on the front of the electronics module

Figure 29. Power panel on the back of the electronics module
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Placing the System in Standby Mode
If you are not going to use the TSQ Quantum XLS Series system for a short period of time, 
such as overnight or over weekends, you do not need to shut it down completely. When you 
are not going to operate the system for 12 hours or more, you can leave the system in Standby 
mode.

To place the system in Standby mode

1. Wait until data acquisition, if any, is complete.

2. From the TSQ EZ Tune window, choose Control > Standby (or click the On/Standby 
button) to put the mass spectrometer in standby.

When you choose Control > Standby, the TSQ Quantum XLS Series system turns off the 
electron multiplier, the conversion dynode, the ion source filament and lenses (but not 
the heater), and the mass analyzer and ion optics rf voltages. See Table 4 on page 59 for 
the On/Off status of mass spectrometer components when the mass spectrometer is in 
Standby mode. The System LED on the front panel of the mass spectrometer illuminates 
yellow when the system is in standby.

3. Leave the mass spectrometer power on.

4. Leave the GC power on with column flow.

5. Leave the autosampler power on.

6. Leave the data system power on.

Shutting Down the System Completely
Shut down the TSQ Quantum XLS Series system completely only when you do not use it for 
an extended period, or if it must be shut down for a maintenance or service procedure. For a 
short period of time, such as overnight or over weekends, you can place the system in Standby 
mode. See “Placing the System in Standby Mode.” 

To shut down the system completely

1. Cool the GC oven, injector, transfer line, and ion source: 

• GC oven: 30 °C (from the Oven page of the TRACE GC Ultra Setup view)

• Injector: off (from the SSL page of the TRACE GC Ultra Setup view)

• Transfer line: off (from the Aux Zones page of the TRACE GC Ultra Setup view)

• Ion source: 30 °C (from the TSQ EZ Tune window)

On

Off

Standby

Note  If you do not plan to change the column or perform maintenance on the gas 
chromatograph, you do not have to lower the injector temperature.
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2. From the TSQ EZ Tune window, choose Control > Standby (or click the On/Standby 
button) to put the mass spectrometer in standby.

3. Place the electronics service switch, located on the right-side power panel, in the Service 
Mode. See Figure 30.

Figure 30. Right-side power panel of the mass spectrometer

4. Place the vacuum service switch, located on the right-side power panel, in the Service 
Mode position. 

5. Place the mass spectrometer main power circuit breaker switch, located on the right-side 
power panel, in the Off position. When you place the main power circuit breaker switch 
in the Off position, the following occurs:

• All power to the mass spectrometer is turned off. (All LEDs on the front panel of the 
mass spectrometer are off.)

• A capacitor on the Vent Delay PCB provides power to the vent valve for two to four 
minutes (to allow the turbomolecular pump to spin down). After the capacitor 
discharges, power to the vent valve solenoid shuts off. When power to the vent valve 
solenoid shuts off, the vent valve opens and the vacuum manifold vents with 
nitrogen, if you have a nitrogen cylinder connected, or else with filtered air. 

• After about two minutes, the pressure of the vacuum manifold reaches atmospheric 
pressure.

6. Unplug the power cord for the mass spectrometer. 

Qualified
Service

Personnel
Only

!

Electronics Vacuum

Pump On

WARNING  Burn Hazard. Allow heated components to cool before servicing them. 
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7. Turn off the GC. Follow the procedure described in the manual that came with the GC.

8. Turn off the autosampler by using the main power on/off switch.

9. Press the System Power Off button (Figure 28 on page 50) to remove all power from the 
TSQ Quantum XLS Series system.

10. If you do not plan to use the system for an extended period, turn off the argon collision 
gas supply at the tank. 

11. Turn off the data system: 

a. Choose Start > Shut Down from the Windows task bar. The Shut Down Windows 
dialog box appears.

b. To start the Windows shutdown procedure, select Shut down and click OK.

12. Turn off the (optional) printer by using the on/off switch.

Starting Up the System after a Complete Shutdown
Starting the TSQ Quantum XLS Series system after it has been shut down requires 
completion of these tasks:

• Restoring Power to the TSQ Quantum XLS Series System

• Starting Up the GC 

• Starting Up the Data System

• Starting Up the Mass Spectrometer

• Starting Up the Autosampler (autosampler is optional)

• Setting Up Conditions for Operation

Note  If you plan to perform routine or preventive system maintenance on the mass 
spectrometer only, you can leave the argon, data system, GC, and autosampler on. In 
this case, the shutdown procedure is complete. However, if you do not plan to operate 
your system for an extended period of time, Thermo Fisher Scientific recommends 
that you turn off the GC, data system, and autosampler as described in step 7 through 
step 12 below.

WARNING  Burn Hazard. The ion source, GC oven, injector, and transfer line are 
hot. Allow them to cool to room temperature before touching them.
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Restoring Power to the TSQ Quantum XLS Series System

To restore power to the TSQ Quantum XLS Series system, place the main power circuit 
breaker, located on the back of the electronics module (Figure 29 on page 50), in the 
On position.

Starting Up the GC

To start the gas chromatograph (GC), follow the startup procedure described in the manual 
that came with the GC. Verify that the gas chromatograph is on and there is carrier gas 
flowing through the column into the mass spectrometer.

Starting Up the Data System

To start the data system 

1. Turn on the monitor, computer, and printer.

2. Observe the Windows startup procedure on the monitor. At the prompt, press 
CTRL+ALT+DELETE. 

3. Click OK or enter your password (if you have one) in the Logon Information dialog box.

Starting Up the Mass Spectrometer

To start the mass spectrometer

1. Turn on the flow of argon at the tank if it is off. 

2. Make sure that the mass spectrometer main power circuit breaker switch, on the right side 
power panel (Figure 30 on page 52), is in the Off (O) position, and the electronics service 
switch and the vacuum service switch are both in the Service Mode position.

3. Plug in the power cord for the mass spectrometer.

CAUTION  Do not turn on the mass spectrometer without GC capillary column flow. 
Air can damage the GC column and contaminate the ion source.

IMPORTANT  Make sure that the data system is running before you start the mass 
spectrometer. The mass spectrometer can not operate until it receives software from 
the data system.
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4. Place the mass spectrometer main power circuit breaker switch in the On (|) position. 
Placing the main power circuit breaker switch in the On (|) position supplies power to 
those mass spectrometer components that are not affected by the vacuum service switch 
and the electronics service switch.

5. Place the vacuum service switch in the Operational position.

6. Place the electronics service switch in the Operational position. The following occurs:

• The Power LED on the mass spectrometer front panel illuminates green to indicate 
that power is provided to the mass spectrometer electronics. (The electron multiplier, 
conversion dynode, ion source, and mass analyzer and ion optics rf voltages remain 
off.) See Figure 31 and Figure 32.

• The embedded computer restarts. After several seconds the Communication LED on 
the front panel illuminates yellow to indicate that the data system and the mass 
spectrometer have started to establish a communication link.

• After several more seconds, the Communication LED illuminates green to indicate 
that the data system and the mass spectrometer have established a communication 
link. Software for the operation of the mass spectrometer is then transferred from the 
data system to the mass spectrometer.

• After three minutes, the System LED illuminates yellow to indicate that the software 
transfer from the data system to the mass spectrometer is complete and that the 
instrument is in standby.

• The Vacuum LED on the front panel of the mass spectrometer remains off until the 
turbomolecular pump reaches 80 percent of its operational speed of 750 Hz. At this 
time the ion gauge is turned on and the Vacuum LED illuminates yellow. The 
Vacuum LED illuminates green, and the high voltage can be turned on, only if the 
pressure in the mass analyzer region of the vacuum manifold is less than the 
appropriate value listed in Table 3. 

Figure 31. Front panel LEDs of the TSQ Quantum XLS Ultra mass spectrometer

Table 3. Maximum allowed pressure to turn on high voltage

Carrier gas Ar collision gas Maximum pressure (Torr)

He Off 8 × 10–6

He On 5 × 10–5

Power Vacuum Communication System Scan
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Figure 32. Front panel LEDs of the TSQ Quantum XLS mass spectrometer

If you have an autosampler, go to Starting Up the Autosampler. If you do not have an 
autosampler, go to Setting Up Conditions for Operation.

Starting Up the Autosampler

To start the autosampler, place the main power switch on the autosampler in the On position. 
If necessary, configure the autosampler. 

For procedures for placing sample vials, preparing solvent and waste bottles, installing 
syringes, and so on, refer to the manual that came with the autosampler. 

Setting Up Conditions for Operation

To set up your TSQ Quantum XLS Series mass spectrometer for operation

1. Before you begin data acquisition with your TSQ Quantum XLS Series system, allow the 
system to pump down for at least one hour. Operation of the system with excessive air 
and water in the vacuum manifold can cause reduced sensitivity, tuning problems, and 
reduced lifetime of the electron multiplier.

2. Ensure that the argon pressure is within the operational limits (argon: 135 ±70 kPa 
[20 ±10 psig]).

3. In the TSQ EZ Tune window, choose View > Instrument Status. Look at the Status 
view. Check that the pressure measured by the ion gauge is below about 3 × 10–6 Torr 
with the collision gas turned off.

CommunicationVacuumPower

System Scan

Note  Air in the argon line must be purged or given sufficient time to be purged for 
normal mass spectrometer performance.

Note  You do not need to calibrate and tune the mass spectrometer each time you 
restart the TSQ Quantum XLS Series system. To tune and calibrate the mass 
spectrometer, see Chapter 4, “Tuning and Calibrating.” 
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Resetting the Mass Spectrometer
If communication between the mass spectrometer and data system computer is lost, it might 
be necessary to reset the mass spectrometer using the System Reset button on the right-side 
power panel. Pressing the System Reset button creates an interrupt in the embedded 
computer. This causes the embedded computer to restart in a known (default) state. For the 
location of the System Reset button, see Figure 30 on page 52.

The procedure given here assumes that the mass spectrometer and data system computer are 
both powered on and operational. If the mass spectrometer, data system computer, or both are 
off, go to “Starting Up the System after a Complete Shutdown” on page 53.

To reset the mass spectrometer

Press the System Reset button located on the right-side power panel. Make sure the 
Communication LED is extinguished before releasing the System Reset button. When you 
press the Reset button, the following occurs:

• An interrupt on the embedded computer causes the CPU to restart. All LEDs on the 
front panel of the mass spectrometer are off except the Power LED.

• After several seconds, the Communication LED illuminates yellow to indicate that the 
data system and the mass spectrometer are starting to establish a communication link.

• After several more seconds, the Communication LED illuminates green to indicate that 
the data system and the mass spectrometer have established a communication link. 
Software for the operation of the mass spectrometer is then transferred from the data 
system to the mass spectrometer.

• After three minutes the software transfer is complete. The System LED illuminates either 
green to indicate that the instrument is functional and the high voltages are on, or yellow 
to indicate that the instrument is functional, and it is in standby.

Resetting the Data System
If possible, use the Windows shutdown and restart procedure to shut down and restart the 
data system so that Windows can properly close programs and save changes to files.

To reset the data system by using the Windows shutdown and restart procedure

1. Choose Start > Shut Down from the Windows task bar. The Shut Down Windows 
dialog box appears.

2. Select Restart and click OK to start the Windows shutdown and restart procedure.

3. Observe the Windows shutdown and restart procedure on the monitor. At the prompt, 
press CTRL+ALT+DELETE. 

4. Click OK or enter your password (if you have one) in the Logon Information dialog box.
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Turning Off Selected Mass Spectrometer Components
There are different ways that you can turn off some or all of the mass spectrometer 
components:

• Turn off individual mass spectrometer components from the TSQ EZ Tune window. 
Turning off individual mass spectrometer components might be necessary when you are 
troubleshooting or when you are running certain diagnostic procedures.

• Place the mass spectrometer in Standby mode. Standby is the normal state for the mass 
spectrometer when it is not in use. To place the mass spectrometer in standby, choose 
Control > Standby (or toggle the On/Standby button) from the TSQ EZ Tune window.

• Place the mass spectrometer in the Off condition. The Off condition is similar to 
Standby, except all high voltage components of the mass spectrometer are turned off. 
To place the mass spectrometer in the Off condition, choose Control > Off from the 
TSQ EZ Tune window.

• Place the electronics service switch in the Service Mode position. The electronics service 
switch turns off all components in the mass spectrometer other than the +24 V power 
supply, forepump, turbomolecular pump, Vent Delay PCB, and fans.

• Place the vacuum service switch in the Service Mode position. The vacuum service switch 
turns off all vacuum system components, including the +24 V power supply, forepump, 
turbomolecular pump, Vent Delay PCB, and fans.

• Place the right-side power panel circuit breaker switch in the Off position. Placing the 
right-side power panel circuit breaker switch in the Off position removes all power to the 
mass spectrometer, including the vacuum system.

• Press the System Power Off button. Pressing the System Power Off button removes all 
power to the mass spectrometer, gas chromatograph, and autosampler.

Table 4 summarizes the on/off status of mass spectrometer components, voltages, and gas 
flows.

Note  The communications link between the data system and the mass spectrometer 
should automatically reestablish after you reset the data system. When this occurs, the 
Communication LED on the front panel of the mass spectrometer illuminates yellow and 
then green. If the system is unable to reestablish the communications link, press the 
System Reset button on the power panel of the mass spectrometer. 
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 3 System Shutdown, Startup, and Reset
Turning Off Selected Mass Spectrometer Components
Table 4. On/Off status of mass spectrometer components and voltages

Mass spectrometer 
component

Standby Off Electronics 
service switch in 
Service Mode 
position

Vacuum service 
switch in 
Service Mode 
position

MS Main power 
circuit breaker 
switch in 
Off position

Electron multiplier Off Off Off Off Off

Conversion dynode Off Off Off Off Off

Mass analyzer rf voltage Off Off Off Off Off

Mass analyzer dc offset voltage Off Off Off Off Off

Q0 ion optics rf voltage Off Off Off Off Off

Q0 ion optics dc offset voltage Off Off Off Off Off

Ion source filament Off Off Off Off Off

Ion source heater On Off Off Off Off

Ion source lenses Off Off Off Off Off

Argon collision gas Off Off Off Off Off

Vent valve Closed Closed Closed Open 
(after 2 to 4 min)

Open 
(after 2 to 4 min)

Turbomolecular pump On On On Off Off

Forepump On On On Off Off

Vent Delay PCB On On On On Off 

Embedded computer On On Off On Off

Turbomolecular pump controller On On On Off Off

Power supply, electron multiplier, 
and conversion dynode

Off Off Off On Off

Power supply, 8 kV Off Off Off On Off

PS1 power supply, +24 V On On On Off Off

PS2 power supply, +5, ±15, 
±24 V dc 

On On Off Off Off

PS3 power supply, +36, –28 V dc On On Off Off Off

Fan, turbomolecular pump On On On Off Off

Fan, above manifold On On On Off Off

Fan, center wall On On On Off Off

Convectron gauge, foreline On On On On Off

Convectron gauge, collision cell On On Off On Off

Ion gauge On On Off Off Off
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4

Tuning and Calibrating

Tune parameters are instrument parameters that affect the intensity of the ion signal. 
Calibration parameters are instrument parameters that affect the mass accuracy and resolution 
of the mass spectrum. Tuning and calibrating the TSQ Quantum XLS Series mass 
spectrometer automatically with TSQ EZ Tune uses perfluorotributylamine (FC-43) as the 
tuning and calibration compound. FC-43 resides in a vial inside the mass spectrometer. 

Record the ion signal intensity of FC-43 (see Figure 34) just after you tune and calibrate the 
mass spectrometer. Periodically check the FC-43 ion signal. Retune and calibrate the mass 
spectrometer if the FC-43 ion signal falls below 50 percent of the tuned value. Also, retune 
and calibrate after switching between EI and CI modes or between positive and negative 
polarity modes.

Table 5 lists typical peaks that are observed in the FC-43 mass spectrum in EI, positive 
polarity mode.

Contents

• Displaying the FC-43 Mass Spectrum

• Running Auto Tune and Calibration

• Saving the Tune and Calibration Report

• Running Maintenance Tune

• Creating a Quality Control (QC) Tune Report

Note  You might need to calibrate more often if you operate in H-SRM mode (as opposed 
to SRM mode only).
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4 Tuning and Calibrating
Displaying the FC-43 Mass Spectrum
Displaying the FC-43 Mass Spectrum
The first step in tuning and calibrating the mass spectrometer is to display the FC-43 mass 
spectrum.

To display the FC-43 mass spectrum

1. Choose Start > Programs > Thermo Instruments > TSQ > TSQ Tune to open the EZ 
Tune window.

2. Choose a polarity mode. In this example the mass spectrometer is in positive polarity 
mode. If necessary, click the polarity button.

3. Click the Define Scan button to display the Define Scan dialog box. See Figure 33.

4. In the Define Scan dialog box, select or enter the following settings:

• Scan type: Full Scan

• Scan mode: Q1MS

• Scan range entry mode: FM/LM

• First mass: 50

• Last mass: 650

• Scan time: 0.500

Table 5. Typically observed FC-43 peaks in EI, positive polarity mode

m/z 69 m/z 314

m/z 100 m/z 352

m/z 114 m/z 402

m/z 119 m/z 414

m/z 131 m/z 464

m/z 169 m/z 502

m/z 219 m/z 614

m/z 264

Positive

Negative
Note  For EI negative polarity mode, you might have to set the calibration gas flow to 
high.
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 4 Tuning and Calibrating
Displaying the FC-43 Mass Spectrum
Figure 33. Define Scan dialog box

5. Click Apply to apply the settings.

6. To turn on the flow of calibration gas into the ion source, click the Calibration Gas 
button in the EZ Tune toolbar. 

7. To turn on the filament, click the Filament button in the EZ Tune toolbar to turn on the 
filament.

8. Choose Control > On to start the mass spectrometer scanning.

9. Observe the mass spectrum. If your mass spectrum looks very different from the one in 
Figure 34, see “Diagnostics and Troubleshooting” on page 113.

Cal Gas Off

Cal Gas On

Filament Off

Filament On
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4 Tuning and Calibrating
Running Auto Tune and Calibration
Figure 34. EZ Tune EZ Workspace, showing the FC-43 mass spectrum in EI, positive polarity mode before tuning and 
calibrating 

Running Auto Tune and Calibration
Run the tune and calibration procedure after you obtain a good FC-43 ion signal.

To tune and calibrate your mass spectrometer automatically in the EI, positive 
ion mode

1. Display the FC-43 positive ion mass spectrum as described in the previous section.

2. Click the System Tune and Calibration button (or choose Setup > System Tune and 
Calibration) to display the System Tune and Calibration dialog box (see Figure 35). 
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 4 Tuning and Calibrating
Running Auto Tune and Calibration
Figure 35. System Tune and Calibration dialog box

3. In the Compound list, select FC43 Pos. Ions. This automatically selects the positively 
charged FC-43 ions to be used for automatic tuning and calibrating. 

4. To start the automatic tuning and calibration procedure, click Start.

The Status box displays real-time messages about the system tune and calibration so that 
you can monitor the progress of each subprocedure. After a subprocedure is complete, the 
system reports the result (for example, whether it passed or failed). At the end of the 
entire procedure, it displays a summary. 

• If errors occur during the automatic tuning and calibration procedure, go to step 5.

• If the automatic tuning and calibration procedure finishes without errors, go 
to step 6.

5. If errors occur during the automatic tuning and calibration procedure, restore the 
previous mass spectrometer device settings and perform the tuning and calibration 
procedure again by completing the following steps:

a. To restore the prior tuning and calibration settings, click Undo.

b. To reload the prior tuning and calibration settings to the mass spectrometer, click 
Accept.

c. Troubleshoot and correct the problem that caused the tuning and calibration 
procedure to fail. See “Tuning Issues” on page 128.

d. Go to step 4 and restart the tuning and calibration procedure.

Figure 36 shows a typical parameter optimization plot.
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4 Tuning and Calibrating
Running Auto Tune and Calibration
Figure 36. Typical parameter optimization plot 

6. To accept the results of the tuning and calibration procedure, click Accept.

After you accept the results of the tuning and calibration procedure, a message box 
prompts you to copy the positive ion tuning and calibration settings to the negative ion 
mode. 

• If you have already tuned and calibrated the instrument successfully in the negative 
ion mode, click No. (Do not copy the positive ion mode parameters to the negative 
ion mode.)

• If you have not tuned and calibrated the instrument in the negative ion mode, 
click Yes.

Note  If you intend to perform high-sensitivity, negative-ion mass spectrum 
analysis, Thermo Fisher Scientific recommends that you also perform a full tune 
and calibration of the instrument in the negative ion mode.
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 4 Tuning and Calibrating
Saving the Tune and Calibration Report
7. Save the calibration file as follows:

a. Click Save Calib. As to open the Save Calibration File dialog box. 

b. In the File Name box, enter a name for your calibration file.

c. Click Save to save the calibration file. The Save As dialog box appears.

8. Save the tune method file as follows: 

a. In the File Name box, enter a name for your tune method file.

b. Click Save to save the tune method file. 

The mass spectrometer is now tuned and calibrated in the EI positive ion mode.

Saving the Tune and Calibration Report
You can save the information that appears in the Status box and in the parameter optimization 
plots as a PDF file. Examples of status information and parameter optimization plots from the 
tune and calibration report follow in Figure 37, and Figure 38 on page 69.
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4 Tuning and Calibrating
Saving the Tune and Calibration Report
Figure 37. Tune and calibration report, status page

Results from System Tune and Calibration using FC43 Pos. Ions:

Q1 and Q3 Tuning & Calibrating

10:55:29:  Tuning and Calibrating Q1
10:55:39:  Tuning Q1MS at mass 69.00 m/z
10:55:41:    Opening resolution
10:55:42:    Adjusting resolution
10:56:02:    The adjusted resolution is -13.33 at the width 0.78
10:56:02:    Coarse resolution done - Quick calibration
10:56:07:    The adjusted calibration of mass 69.0 is -0.88
10:56:08:    Averaging Stopping Curve...
10:56:12:    Q1 Quadrupole Offset set to -0.85 for all reswidths
10:56:14:  Optimizing Lens 2 for ion 69.00 m/z
10:56:20:    Previous Setting = -7.00, New Setting = -0.80
10:56:20:    Maximum Intensity = 1.04e+06
10:56:20:    322 % Improvement
10:56:20:  Optimizing Lens 4 for ion 69.00 m/z
10:56:26:    Previous Setting = -10.00, New Setting = -46.55
10:56:26:    Maximum Intensity = 1.61e+06
10:56:26:    60 % Improvement
10:56:26:  Optimizing Lens 1-1 for ion 69.00 m/z
10:56:32:    Previous Setting = -5.00, New Setting = -0.86
10:56:32:    Maximum Intensity = 1.93e+06
10:56:32:    15 % Improvement
10:56:32:  Optimizing Lens 1-2 for ion 69.00 m/z
10:56:38:    Previous Setting = -21.90, New Setting = -5.00
10:56:38:    Maximum Intensity = 2.43e+06
10:56:38:    41 % Improvement
10:56:38:  Optimizing Lens 2-1 for ion 69.00 m/z
10:56:45:    Previous Setting = -8.45, New Setting = 3.92
10:56:45:    Maximum Intensity = 2.56e+06
10:56:45:    17 % Improvement
10:56:45:  Tuning Q1MS at mass 501.97 m/s
10:56:47:    Opening resolution
10:56:48:    Adjusting resolution
10:57:04:    The adjusted resolution is -14.38 at the width 0.78
10:57:04:    Coarse resolution done - Quick calibration
10:57:10:    The adjusted calibration of mass 502.0 is -0.16
10:57:11:    Averaging Stopping Curve...
10:57:16:    Q1 Quadrupole Offset set to -2.00 for all reswidths
10:57:18:  Optimizing Lens 2 for ion 501.97 m/z
10:57:24:    Previous Setting = -7.00, New Setting = -2.70
10:57:24:    Maximum Intensity = 2.97e+05
10:57:24:    223 % Improvement
10:57:24:  Optimizing Lens 1-2 for ion 501.97 m/z
10:57:30:    Previous Setting = -50.14, New Setting = -51.11
10:57:30:    Maximum Intensity = 4.35e+05
10:57:30:    6 % Improvement
10:57:30:  Optimizing Lens 2-1 for ion 501.97 m/z

Page 1 of 10May 09, 2007 11:17:28

Quantum Tune Master - Tune and Calibration

Signature: __________________________________________
68 TSQ Quantum XLS Series User Guide Thermo Scientific



 4 Tuning and Calibrating
Saving the Tune and Calibration Report
Figure 38. Tune and calibration report, parameter optimization plots

To save the tune and calibration report

1. In the System Tune and Calibration dialog box, click Save Report. The Save As dialog 
box appears.

2. Enter the name and the path of the report, and click Save.
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Quantum Tune Master - Tune and Calibration
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4 Tuning and Calibrating
Running Maintenance Tune
Running Maintenance Tune
Use the maintenance tune procedure in EZ Tune to quickly increase the ion signal of the mass 
spectrometer. The maintenance tune adjusts the lens L1 voltage and the lens L11 offset 
voltage to maximize the ion signal for, for example, m/z 219 in FC-43 positive polarity mode. 
At the end of the procedure you can save the optimized lens L1 voltage to a tune file and the 
optimized lens L11 offset voltage to a calibration file. Figure 39 shows a maintenance tune 
report.

Figure 39. Maintenance tune report, page 2
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 4 Tuning and Calibrating
Creating a Quality Control (QC) Tune Report
To run maintenance tune

1. Display the FC-43 mass spectrum in positive or negative polarity mode as described in 
“Displaying the FC-43 Mass Spectrum” on page 62.

2. Click the System Tune and Calibration button (or choose Setup > System Tune and 
Calibration) to display the System Tune and Calibration dialog box. See Figure 35 on 
page 65.

3. Select the calibration compound

4. Click Start Main. Tune to start the maintenance tune procedure.

5. After the procedure terminates you can accept the maintenance tune and save the 
calibration, or undo the tune.

Creating a Quality Control (QC) Tune Report
Use the TSQ QC (quality control) Report dialog box in EZ Tune to produce a report that 
displays tune parameters and mass spectra relevant to the performance of the mass 
spectrometer. You can save the report as a PDF file. 

The TSQ QC tune report includes the following:

• Profile spectra of the three FC-43 peaks

• Setpoints and readbacks of the ion source lenses and L11 voltages

• Q1/MS full scan centroid spectrum from m/z 50 to 650

• FC-43 peak positions and intensity ratios

• Results of a leak check (pass or fail)

Figure 40 shows a QC tune report.
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4 Tuning and Calibrating
Creating a Quality Control (QC) Tune Report
Figure 40. QC tune report 
 

To create and save a QC tune report

1. Choose View > QC Report to open the TSQ QC Report dialog box.

2. Click Start to start the QC report procedure.

3. After the procedure terminates, click View Report to view the QC report as a PDF file.

4. Save the PDF file.

Q Q Q p
Dec 02, 2011 15:51:56                             TSQ Quantum XLS Ultra           S/N: TQU01792

Device               SetPoint   Readback

Lens 1 (V)            -45.0      -45.5

Lens 2 (V)            -180.0     -180.7

Lens 3 (V)            -25.0      -25.2

Lens 4 (V)            -10.0      -10.0

Lens 1-1 Offset (V)   -9.6       -10.0

Emission Current (uA)  50         48

Electron Lens (V)      10         10

Electron Energy (eV)  -70        -69

Source Temperature (C)  100       100

Ion Gauge Pressure (Torr)      7.1e-06

Q1 Peak Width(amu):  0.7

Air/Water Leak Check: FAIL

qcr20111202155106#1 ST: 3.02 uS: 1 NL: 2.07E7
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qcr20111202155106#11 ST: 1.02 uS: 1 NL: 2.76E7  + c CI Q1MS [46.500-700.500]
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130.966

263.972
501.946

413.943
99.960

463.946313.982 613.997375.932 551.963 673.685

Cal. Mass(m/z)      Exact Mass(m/z)     Intensity(cts)      Ion Ratio(%)

68.971               68.995               14484893             52

218.977              218.986              27647784             100

501.946              501.971              6361739              23

Signature_____________________________     Date________________________
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5

Changing Ionization Modes

You can operate the TSQ Quantum XLS Series mass spectrometers in either EI or CI 
ionization mode. Changing ionization modes requires changing ion volumes. You do not 
need to shut down the mass spectrometer to change ion volumes.

The following sections describe how to change the ionization mode.

Removing the Ion Volume

To remove the ion volume

1. Install the guide bar:

a. With the guide ball track facing left, insert the guide bar into the entry housing. 
See Figure 41. 

b. Push the guide bar in as far as it can go; then, rotate it 90° clockwise to lock the guide 
bar in the entry housing.

Contents

• Removing the Ion Volume

• Installing the Ion Volume

Tools needed
• Gloves, clean, lint- and powder-free
• Insert/removal (I/R) tool and guide bar

Frequency 
When you change ionization modes or as needed to clean the ion volume
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5 Changing Ionization Modes
Removing the Ion Volume
Figure 41. Insertion/removal (I/R) tool and guide bar

2. Prepare the inlet valve and I/R tool for insertion:

a. Make sure the inlet valve is closed. Figure 42 shows the inlet valve lever is down for 
closed.

b. Loosen the inlet valve knob counterclockwise and remove the inlet valve plug. The 
inlet valve plug prevents air from entering the vacuum manifold in case the inlet valve 
is inadvertently opened.

c. Turn the I/R tool to the unlock position , which indicates the I/R tool is 
in position to accept the ion volume.

I/R tool

Guide ball 
hole

First stop

Guide ball 
track Guide bar

Bayonet 
lock

Guide ball
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 5 Changing Ionization Modes
Removing the Ion Volume
Figure 42. Inlet valve components

3. Choose Start > All Programs > Thermo Instruments > TSQ > TSQ Tune to open the 
EZ Tune window.

4. Click the Probe button, , in the EZ Tune toolbar. The Insert Probe message 
appears (Figure 43).

Figure 43. Insert Probe message

5. Insert the I/R tool into the inlet valve:

a. Insert the guide ball into the guide ball hole. 

b. Slide the I/R tool forward into the inlet valve until the guide ball is at the guide bar’s 
first stop (see Figure 44).

c. Tighten the inlet valve knob clockwise to ensure a leak-tight seal.

Inlet valve 
knob

Inlet valve
plug

Entry housing

Inlet valve lever
(down is closed, 
up is open)
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5 Changing Ionization Modes
Removing the Ion Volume
Figure 44. I/R tool at the first stop on guide bar and the inlet valve knob tightened

6. Click OK. The forepump evacuates the inlet valve. Wait until you can safely insert the 
probe (Figure 45), and then click OK.

Figure 45. Safe to insert the probe message

7. Once evacuation is complete, pull the inlet valve lever up (Figure 46).

Inlet valve knob

First stop of 
guide bar

I/R tool
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 5 Changing Ionization Modes
Removing the Ion Volume
Figure 46. I/R tool at first stop and inlet valve lever up

The inlet valve is now open.

8. Remove the ion volume:

a. Slide the I/R tool into the vacuum manifold until the tip of the I/R tool is fully 
inserted into the ion volume holder. See Figure 47. The head of the arrow on the I/R 
tool, when viewed through the window of the ion source manifold, should not be 
visible. 

Inlet valve lever

First stop of 
guide bar

I/R tool
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5 Changing Ionization Modes
Removing the Ion Volume
Figure 47. I/R tool inserted into the inlet valve

b. Turn the I/R tool handle counterclockwise to put the I/R tool into lock position, 
. Listen for a click, which indicates that the handle is fully engaged in the 

lock position and is holding the ion volume. 

c. Withdraw the I/R tool (with the ion volume attached) until the guide ball reaches the 
first stop (see Figure 46 on page 77). 

d. Pull the lever down to close the inlet valve.

e. Loosen the inlet valve knob by turning it counterclockwise to release the seal.

f. Continue withdrawing the I/R tool completely from the inlet valve by sliding the I/R 
tool through the guide ball track in the guide bar. 

I/R tool inserted 
into the vacuum 
manifold

CAUTION  Do not withdraw the I/R tool beyond the point where the guide ball 
reaches the first stop in the guide bar. Close the inlet valve first. Otherwise, the 
system vents to the atmosphere.
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 5 Changing Ionization Modes
Removing the Ion Volume
9. Remove the ion volume from the I/R tool (see Figure 48):

a. Wearing clean gloves, press the ion volume forward into the tip of the I/R tool and 
rotate it to disconnect the bayonet pins from the pin guides. 

b. Pull the ion volume out of the I/R tool.

Figure 48. Ion volume, ion volume holder, and I/R tool

10. To clean the ion volume, use the instructions in “Cleaning Stainless Steel Parts” on 
page 98. If you are cleaning a CI ion volume, be sure to clean out the small electron 
entrance hole. Aluminum oxide can get trapped in this hole, which can adversely affect 
sensitivity. Use a dental pick or old syringe needle to clean the hole.

WARNING  Burn Hazard. Because the ion volume might be too hot to touch, let 
it cool to room temperature before handling it.

Arrow

Bayonet
pin

Bayonet
lock

Arrow

I/R tool

Bayonet pin 
guide

Ion volume holder

Spring washer

Ion volume
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Installing the Ion Volume
Install an ion volume after cleaning or when you change ionization modes.

To install the ion volume

1. Place the clean ion volume on the I/R tool with the arrows aligned. See Figure 48.

2. Turn the I/R tool handle to the lock position, .

3. Install the guide bar:

a. With the guide ball track facing left, insert the guide bar into the entry housing (see 
Figure 41 on page 74). 

b. Push the guide bar in as far as it will go, and then rotate it 90° clockwise to lock the 
guide bar into the entry housing.

4. Prepare the inlet valve for insertion:

a. Make sure the inlet valve is closed. Figure 42 shows the inlet valve lever, closed in the 
down position.

b. Loosen the inlet valve knob counterclockwise and remove the inlet valve plug. The 
inlet valve plug prevents air from entering the vacuum manifold in case the inlet valve 
is inadvertently opened.

5. Choose Start > Programs > Thermo Instruments > TSQ > TSQ Tune to open the EZ 
Tune window.

6. Click the Probe button, , in the EZ Tune toolbar. The Insert Probe message 
appears. See Figure 43.

7. Inset the I/R tool into the inlet valve:

a. Insert the guide ball into the guide ball hole. 

b. Slide the I/R tool forward into the inlet valve until the guide ball is at the guide bar’s 
first stop. See Figure 44 on page 76.

c. Tighten the inlet valve knob clockwise to ensure a leak-tight seal.

8. Click OK. The forepump evacuates the inlet valve. Wait until you can safely insert the 
probe (Figure 45 on page 76); then click OK.

9. Once evacuation is complete, pull the inlet valve lever up to open the inlet valve.

Note  Wear clean, lint- and powder- free gloves when you handle a clean ion volume.

CAUTION  To avoid damage to the ion source, make sure to align the arrows on the 
I/R tool and ion volume. 
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Installing the Ion Volume
10. Install the ion volume:

a. Slide the I/R tool and ion volume assembly into the vacuum manifold until the ion 
volume assembly is fully inserted and seated into the ion source block. Listen for a 
click, which indicates that the ion volume has connected with the ion source block. 

b. Turn the I/R tool handle to the unlock position, , to release the ion 
volume from the I/R tool.

Figure 49. Ion volume seated in the ion source block 

11. Verify that the ion volume is fully seated in the ion source block:

• Withdraw the I/R tool away from the ion volume about 2.5 cm (1 in.), and turn the 
I/R tool handle to the lock position. 

• Slide the I/R tool back into the vacuum manifold until the end of the I/R tool just 
touches the ion volume. 

• Test that the I/R tool does not go into the inlet valve completely, which indicates that 
the ion volume is seated properly. 

12. Remove the I/R tool:

a. Withdraw the I/R tool until the guide ball reaches the first stop (see Figure 46 on 
page 77). 

b. Close the inlet valve by pulling the inlet valve lever down (see Figure 44 on page 76).

c. Loosen the inlet valve knob by turning it counterclockwise.

d. Continue withdrawing the I/R tool completely from the inlet valve by sliding the I/R 
tool through the guide ball track in the guide bar.

Ion source block Ion volume

CAUTION  Do not withdraw the I/R tool beyond the point where the guide ball 
reaches the first stop in the guide bar. Close the inlet valve first. Otherwise, the system 
vents to the atmosphere.
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13. Remove the guide bar by rotating it 90° counterclockwise and sliding it out of the entry 
housing. 

14. Replace the inlet valve plug. Orient the plug to indicate whether an EI or CI ion volume 
is installed. 

15. Tighten the inlet valve knob clockwise to create a leak-tight seal.

16. (Optional) To prevent the inlet valve from being opened accidentally, pull free and 
remove the inlet valve lever.
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6

Maintenance

This chapter describes routine maintenance procedures that you must perform to ensure 
optimum performance of the TSQ Quantum XLS Series mass spectrometer. Optimum 
performance of the mass spectrometer depends on the maintenance of all parts of the 
instrument. You are responsible for properly maintaining your instrument through regular 
performance of these maintenance procedures.

Table 6 lists routine and infrequent mass spectrometer maintenance procedures. For 
instructions on maintaining the GC or autosampler, refer to the manuals that come with the 
GC or autosampler.

Contents

• Cleaning Ion Source Components

• Replacing the Filament of the Ion Source

• Completely Disassembling and Reassembling the Ion Source

• Maintaining the Forepump

• Adding Calibration Compound

• Replacing the Ball Valve Seal

• Removing and Installing a GC Capillary Column

Tip  When you perform maintenance procedures, be methodical; always wear clean, 
lint-free gloves when handling the components of the ion source; always place the 
components on a clean, lint-free surface; and never overtighten a screw or use excessive 
force.

Table 6. Maintenance procedures (Sheet 1 of 2)

Mass spectrometer 
component Procedure Frequency Reference

Ion source Cleaning the ion 
volume

As neededa Page 87

Ion source Cleaning the lenses As neededa Page 87 
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Ion source Cleaning the entire ion 
source

As neededa Page 96 

Ion source Replacing the filament If the filament fails Page 93 

Inlet valve Replacing the ball valve 
seal

If there is an air leak in 
the inlet valve

Page 105

Calibration 
compound

Adding calibration 
compound

If EZ Tune error 
message indicates low 
intensity of calibration 
gas ions

Page 102

Gas 
chromatograph

Replacing the capillary 
column

If chromatographic 
separation is bad or if a 
different stationary 
phase is needed for the 
application

Page 107

Q0 ion optics Cleaning the Q0 
quadrupole and L11 
and L12 lensesb

As neededa

Mass analyzer Cleaning the Q1, Q2, 
and Q3 quadrupoles 
and lensesb

As neededa

Forepump Purging the forepump 
pump oil

If pump oil is cloudy Manufacturer’s 
documentation

Forepump Adding pump oil If pump oil level is low Manufacturer’s 
documentation

Forepump Changing the pump oil Every 4 months or if 
pump oil is cloudy and 
discolored

Manufacturer’s 
documentation

Ion detection 
system

Replacing the electron 
multiplier assemblyb

If noise in spectrum is 
excessive or proper 
electron multiplier gain 
cannot be achieved

Electronic modules Replacing an electronic 
moduleb

If electronic module 
fails

PCBs Replacing a PCBb If PCB fails
a The frequency of cleaning the components of the mass spectrometer depends on the types and amounts of samples 

and solvents that are introduced into the instrument. Cleaning of the Q0, Q1, Q2, and Q3 quadrupoles is rarely 
(if ever) needed.

b A Thermo Fisher Scientific Field Service Engineer must perform this maintenance procedure.

Table 6. Maintenance procedures (Sheet 2 of 2)

Mass spectrometer 
component Procedure Frequency Reference
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Cleaning Ion Source Components
An important part of maintaining your TSQ Quantum XLS Series mass spectrometer is 
making sure that the ion source components are clean. Follow the cleaning procedures in this 
section to clean stainless steel and non-stainless steel parts. 

When your mass spectrometer is clean and in good working order, perform benchmark tests 
and record the results. When the tested performance of your system decreases significantly 
from your benchmark test results, clean the ion volume. If this does not restore performance, 
clean the lenses. 

How often you clean the ion source depends on the types and amounts of samples and 
solvents you introduce into the system. In general, the closer a component is to the sample 
introduction point, the more rapidly the component becomes dirty. The ion volume becomes 
dirty faster than other parts. If you just want to change or clean the ion volumes, you do not 
need to shut down the system. 

You can remove and disassemble most parts by hand. Make sure you have all the tools needed 
before starting each procedure. 

Figure 50 shows exploded and assembled views of the ion source assembly.
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Cleaning Ion Source Components
Cleaning Ion Volumes

You do not need to vent the mass spectrometer to atmosphere to clean the ion volume.

To clean the ion volume

1. Remove the ion volume. See “Removing the Ion Volume” on page 73.

2. Clean the ion volume. See “Cleaning Stainless Steel Parts” on page 98. If you are cleaning 
a CI ion volume, be sure to clean out the small electron entrance hole. Aluminum oxide 
can get trapped in this hole, which can adversely affect sensitivity. Use a dental pick or old 
syringe needle to clean the hole.

3. Reinstall the ion volume. See “Installing the Ion Volume” on page 80.

Cleaning the Lenses of the Ion Source

If cleaning the ion volume does not restore system performance, clean the ion source lenses.

To clean the ion source lenses

1. Shut down and vent the system. See “Shutting Down the System Completely” on 
page 51.

2. Remove the ion source. See “Removing the Ion Source” on page 88.

3. Remove the ion source lens assemblies from the ion source and disassemble it. See 
“Removing the L1, L2, L3 Lens Assembly and the Heated Q0 Quadrupole Assembly” on 
page 90.

4. Clean the lenses and the spacers. See “Cleaning Stainless Steel Parts” on page 98 and 
“Cleaning Non-Stainless Steel or Hybrid Parts” on page 100, respectively.

5. Reassemble L1, L2, L3 lens assembly and install it and the heated Q0 quadrupole onto 
the ion source. See “Reassembling the L1, L2, L3 Lens Assembly” on page 92.

WARNING  Burn Hazard. The ion volume might be hot. Allow the ion volume to 
cool to room temperature before touching it.

WARNING  Shock Hazard. Unplug the TSQ Quantum XLS Series system before 
proceeding.

WARNING  Burn Hazard. The ion source might be hot. Allow the ion source to cool 
to room temperature before touching it.
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6. Reinstall the ion source into the mass spectrometer and reinsert the capillary column into 
the ion source. See “Reinstalling the Ion Source” on page 92.

7. Restart the system. See “Starting Up the System after a Complete Shutdown” on page 53.

Removing the Ion Source 

Remove the ion source to clean the lenses or replace the filament.

To remove the ion source 

1. Shut down and vent the mass spectrometer. See “Shutting Down the System Completely” 
on page 51.

2. Pull back the capillary column:

a. Lower the oven, injector, and transfer line temperatures to 30 °C and allow them to 
cool before continuing.

b. Once the oven, injector, and transfer line are cool, turn off the gas chromatograph.

c. Loosen the transfer line nut. See Figure 61 on page 108.

d. Pull back the column. (You can first mark the column’s position with white 
correction fluid or something similar.)

3. Prepare a clean work area by covering the area with lint-free cloth.

4. Undo the two latches that secure the lid of the ion source vacuum manifold, and open 
the lid.

Tools needed
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Lint-free cloth

Frequency 
As needed to perform ion source maintenance

WARNING  Shock Hazard. Unplug the mass spectrometer before proceeding.

CAUTION  Do not remove the ion source without first pulling back the GC capillary 
column, or else the capillary column might break.

WARNING  Burn Hazard. The GC oven, injector, and transfer line are hot. 
Allow them to cool to room temperature before touching them.
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Cleaning Ion Source Components
5. Disconnect the connectors from the lead pins at the EI/CI Source PCB, and L1, L2, L3 
lens assembly. See Figure 51.

Figure 51. TSQ Quantum XLS Series ion source, installed

6. While holding the ion source assembly, loosen the two thumbscrews that secure the ion 
source assembly to the Q0 quadrupole mount. 

7. Pull the ion source assembly away from the Q0 quadrupole mount and slightly to the 
right to clear the transfer line bellows.

8. Slide the ion source off the magnet yoke.

9. Place the ion source and magnet yoke on a clean, lint-free cloth.

10. Close the lid of the ion source vacuum manifold.

Q0 quadrupole mount

Lens L1, L2, L3 connector

EI/CI Source PCB 
connector

Transfer line

Thumbscrew

Thumbscrew

WARNING  Burn Hazard. The ion source might be hot. Allow the ion source to cool 
to room temperature before touching it.

Note  Wear clean, lint- and powder-free gloves when you handle the ion source.
Thermo Scientific TSQ Quantum XLS Series User Guide 89



6 Maintenance
Cleaning Ion Source Components
Removing the L1, L2, L3 Lens Assembly and the Heated Q0 Quadrupole Assembly

The ion source includes the L1, L2, L3 lens assembly and the heated Q0 quadrupole 
assembly. You must remove and disassemble the L1, L2, L3 lens assembly to clean the lenses. 
A retainer clip fastens the L1, L2, L3 lens assembly and the heated Q0 quadrupole assembly to 
the ion source block.

To remove the ion source lens assemblies

1. Wearing clean, lint- and powder- free gloves, unscrew the threaded hexagonal standoff 
and remove the retainer clip that secures the lens assembly to the ion source block. See 
Figure 52.

2. Remove the heated Q0 quadrupole assembly and the L1, L2, L3 lens assembly from the 
heater cartridges of the ion source. Place them on a clean surface.

Figure 52. L1, L2, L3 lens assembly and heated Q0 quadrupole assembly removed from the ion source 
 

L1, L2, L3 lens 
assembly

Heated Q0 quadrupole 
assembly

Retainer clip

Ion source

Threaded standoff
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Cleaning Ion Source Components
Disassembling the L1, L2, L3 Lens Assembly

To disassemble the L1, L2, L3 lens assembly

1. Remove the lens retainer clip by pinching the ends with your fingers or a pair of tweezers. 
See Figure 53.

2. Remove the lenses and spacers from the lens holder.

3. Place the components on a clean surface.

Figure 53. L1, L2, L3 lens assembly, assembled and exploded views

Lens holder

Lens L3

Lens spacer

Lens L2

Lens spacer

Lens L1

Lens retainer clip

Note  To clean the ion source lenses, follow the procedure in “Cleaning Stainless Steel 
Parts” on page 98. To clean the remaining parts, follow the procedure in “Cleaning 
Non-Stainless Steel or Hybrid Parts” on page 100.
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Reassembling the L1, L2, L3 Lens Assembly

Ensure that the lenses are clean and dry before you reassemble the lens assembly.

To reassemble the L1, L2, L3 lens assembly

1. Wearing clean, lint- and powder- free gloves, reinstall the lenses and spacers in the lens 
holder in the order and orientation shown in Figure 53 on page 91, starting with lens L3.

2. Reinstall the lens clip by pinching the ends with your fingers or a pair of tweezers and 
seating it in the lens holder. 

3. Insert the lens alignment tool (in the TSQ Quantum XLS Accessory Kit) into the lens 
assembly and align the lenses.

Reinstalling the Ion Source Lens Assemblies

To reinstall the ion source lens assemblies onto the ion source

1. Wearing clean, lint- and powder- free gloves, insert the three heater cartridges of the ion 
source through their corresponding holes in the L1, L2, L3 lens assembly. See Figure 52 
on page 90.

2. Insert the three heater cartridges of the ion source through their corresponding holes in 
the heated Q0 quadrupole assembly. Verify the correct orientation of the guide pin hole 
and the retainer clip groove on the heated Q0 quadrupole assembly.

3. Use the retainer clip and threaded standoff to secure the lens assemblies to the ion source. 

Reinstalling the Ion Source

For the location of the ion source components, see Figure 50 on page 86.

To reinstall the ion source into the vacuum manifold

1. Wearing clean, lint- and powder- free gloves, place the ion source onto the magnet yoke.

2. Position the ion source in the vacuum manifold and ensure the following:

• The transfer line is seated in the sample inlet aperture in the ion source. 

• The guide pin on the Q0 quadrupole mount inserts into the guide pin groove on the 
heated Q0 lens assembly.

• The two thumbscrews are aligned with the screw holes in the Q0 quadrupole mount. 

3. Secure the ion source to the Q0 quadrupole mount by alternately tightening each 
thumbscrew one-half turn at a time. Make sure there is no play in the ion source.

IMPORTANT      For accurate temperature readings of the heater block, fully screw the 
threaded standoff into the ion source to ensure contact between the temperature 
sensor and the heater block. 
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4. Align and reconnect the 8-pin connector to the lead pins on the EI/CI Source PCB. 

5. Align the 3-pin connector so that the side with the beveled edge is closest to the L3 lead 
pin and the side with the rounded corners is closest to the L1 lead pin. 

6. Reconnect the 3-pin connector to the lead pins on the L1, L2, and L3 lenses. 

7. Reinsert the capillary column into the ion source:

a. Using the I/R tool, remove the ion volume. See “Removing the Ion Volume” on 
page 73.

b. Push the capillary column in until you can see it in the ion source.

c. Pull the column back just far enough that you cannot see it.

d. Tighten the transfer line nut and transfer line union.

e. Using the I/R tool, install the ion volume. See “Installing the Ion Volume” on 
page 80.

8. Close and secure the cover to the ion source vacuum manifold.

Replacing the Filament of the Ion Source
The number of ions produced in the ion source is approximately proportional to the filament 
emission current. If ion production is lacking, you might have to replace the filament. If the 
measured emission current is substantially less than the value that the emission current is set 
to, or if the measured emission current decreases over time, then the filament has failed or is 
failing and requires replacement.

For the location of the ion source components, see Figure 50 on page 86 and Figure 54 on 
page page 94.

To replace the filament of the ion source

1. Prepare a clean work area by covering the area with lint-free cloth.

2. Shut down and vent the mass spectrometer. See “Shutting Down the System Completely” 
on page 51.

Tools needed
• Filament (P/N 120320-0030)
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Lint-free cloth

Frequency 
If filament fails
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3. Remove the ion source. See “Removing the Ion Source” on page 88. 

4. Wearing clean, lint- and powder-free gloves, remove the ion source from the magnet yoke.

Figure 54. Disassembling the source to replace the filament 

5. Unscrew the threaded standoff and remove the retainer clip that secures the heater ring 
and lens assemblies to the ion source block. See Figure 54.

6. Pull the heater ring and lens assemblies off of the cartridge heaters on the ion source 
block. Place them on a clean surface.

7. Remove the retainer clip that secures the filament and centering ring to the ion source 
block.

8. Remove the filament and centering ring from the ion source block.

WARNING  Shock Hazard. Unplug the mass spectrometer before proceeding.

Heater ring and lens 
assemblies

Centering ring

Heater ring and lens 
assemblies retainer clip

Threaded standoff

Filament retainer clip

Filament

Ion source block and 
EI/CI Source PCB
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Inspect and install a new filament (P/N 120320-0030, in the TSQ Quantum XLS Accessory Kit): 

a. Verify that the filament wire is centered in the electron lens hole.

b. Insert the filament into the centering ring.

c. Align the filament leads with the EI/CI Source PCB connectors and gently press the 
leads into the connectors. Normally, there is a small gap of about 0.4 mm (0.016 in.) 
between the filament and the connectors. The gap allows the ceramic centering ring 
to properly position and align the electron lens hole with the ion volume.

d. Secure the filament and centering ring with the retainer clip.

9. Press the heater ring and lens assemblies onto the cartridge heaters on the ion source 
block.

10. Use the retainer clip and threaded standoff to secure the lens assemblies to the ion source. 
See Figure 54 on page 94.

11. Reinstall the ion source onto the magnet yoke.

12. Reinstall the ion source into the vacuum manifold and reinsert the capillary column into 
the ion source. See “Reinstalling the Ion Source” on page 92.

Restart the system. See “Starting Up the System after a Complete Shutdown” on page 53.

Completely Disassembling and Reassembling the Ion Source 
Disassemble the ion source completely to clean the ion source block or to replace the EI/CI 
Source PCB.

Tip  Now is a good time to clean the ion source block and lenses. To do so, use the 
procedure described in “Cleaning Stainless Steel Parts” on page 98.

IMPORTANT      For accurate temperature readings of the heater block, fully screw the 
threaded standoff into the ion source to ensure contact between the temperature 
sensor and the heater block.

Tools Needed
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Lint-free cloth

Frequency 
As needed
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Complete Disassembly and Reassembly of the Ion Source 

See Figure 55 for the location of the ion source components. 

To disassemble the ion source completely

1. Prepare a clean work area by covering the area with lint-free cloth.

2. Shut down and vent the TSQ Quantum XLS Series system. See“Shutting Down the 
System Completely” on page 51.

3. Wearing clean, lint- and powder- free gloves, remove the ion source. See “Removing the 
Ion Source” on page 88.

4. Remove the ion source from the magnet yoke.

Figure 55. TSQ Quantum XLS Series ion source, disassembled

5. Unscrew the threaded hexagonal standoff and remove the retainer clip that secures the 
heater ring and lens assemblies to the ion source block.

6. Pull the heated Q0 quadrupole assembly and the L1, L2, L3 lens assembly off the ion 
source. 

WARNING  Shock Hazard. Unplug the mass spectrometer before proceeding.

L1, L2, L3 lens assembly 
70111-60842

Heater ring 
70111-22052

Centering ring
70111-22061

Ion source block
70111-22019

Heater ring and lens 
assemblies retainer clip 
70111-22070

Threaded standoff 
70111-22060

Ion volume holder
70111-20532

Closed EI ion volume
70111-22038

Heated Q0 quadrupole
assembly 70111-60843

Filament
120320-0030

Filament retainer clip
70111-22071

L1, L2, L3 lens assembly 

Heater ring 
Centering ring

Ion source block

Heater ring and lens 
assemblies retainer clip 

Threaded standoff 
Ion volume retaining 
thumbscrew EI/CI Source PCB Base studs 

Ion volume holder

Closed EI ion volume

Heated Q0 quadrupole

Filament

Filament retainer clip
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7. Pull the heater ring off the ion source.

8. Unscrew and remove the three base studs.

9. Remove the EI/CI Source PCB:

a. Place the ion source on a clean surface with the cartridge heaters down and the EI/CI 
Source PCB up. 

b. Press down on the ion source block to separate it from the EI/CI Source PCB.

10. Remove the retainer clip that secures the filament and centering ring to the ion source 
block.

11. Remove the filament and centering ring from the ion source block.

12. Clean the ion source block and lenses. See “Cleaning Stainless Steel Parts” on page 98. 
Clean non-stainless steel parts as described in “Cleaning Non-Stainless Steel or Hybrid 
Parts” on page 100.

To reassemble the ion source

1. Reinstall the EI/CI Source PCB:

a. Align and insert the cartridge heaters and temperature sensor on the EI/CI Source 
PCB with the corresponding holes in the ion source block.

b. Reinstall the three base studs.

2. Reinstall the filament and centering ring:

a. Insert the filament into the centering ring.

b. Align the filament leads with the EI/CI Source PCB connectors and gently press the 
leads into the connectors. Normally, there is a small gap of about 0.4 mm (0.016 in.) 
between the filament and the connectors. The gap allows the ceramic centering ring 
to properly position and align the electron lens hole with the ion volume.

c. Secure the filament and centering ring with the retainer clip.

3. Press the heater ring and lens assemblies onto the ion source block.

4. Use the retainer clip and threaded standoff to secure the heater ring lens assembly to the 
ion source. See Figure 55 on page 96.

CAUTION   To prevent damage, do not pull the EI/CI Source PCB out of the ion 
source block. 

IMPORTANT      Ensure that the temperature sensor is seated snugly.
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5. Reinstall the ion source into the vacuum manifold and reinsert the capillary column into 
the ion source. See “Reinstalling the Ion Source” on page 92.

6. Restart the system. See “Starting Up the System after a Complete Shutdown” on page 53.

Cleaning Stainless Steel Parts

IMPORTANT      For accurate temperature readings of the heater block, fully screw the 
threaded standoff into the ion source to ensure contact between the temperature 
sensor and the heater block.

Tools needed
• Acetone, reagent grade (or other suitable polar solvent)
• Aluminum oxide abrasive, number 600 (P/N 32000-60340)
• Applicators, cotton-tipped (P/N 00301-01-00015)
• Beaker, 450 mL
• Clean, dry gas
• Deionized water
• Detergent (Alconox™, Micro, or equivalent)
• Dremel™ rotary tool or equivalent (recommended)
• Foil, aluminum
• Forceps (P/N 76360-0400)
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Glycerol, reagent grade
• Lint-free cloth
• Protective eyewear
• Tap water
• Toothbrush, soft
• Ultrasonic cleaner

Frequency 
As needed to clean these stainless steel parts:

• Ion volumes
• Ion source block
• Ion source lenses

WARNING  Material and Eye Hazard. Wear impermeable laboratory gloves and eye 
protection when performing cleaning procedures.
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To clean stainless-steel parts

1. Remove contamination from all the surfaces you are cleaning:

a. Use a slurry of number 600 aluminum oxide in glycerol and a cleaning brush or 
cotton-tipped applicator. Contamination appears as dark or discolored areas, but 
often is not visible. The heaviest contamination is usually found around the 
apertures, such as the electron entrance hole on an ion volume. 

b. Clean each part thoroughly, even if no contamination is visible. 

c. To clean the inside corners, use the wooden end of an applicator cut at an angle.

d. Use a Dremel tool with the polishing swab at its lowest speed. This increases cleaning 
efficiency as well as decrease the time required to clean the items. 

2. Rinse the parts with clean water. Use a clean applicator or toothbrush to remove the 
aluminum oxide slurry. Do not let the slurry dry on the metal; dried aluminum oxide is 
difficult to remove.

3. Sonicate the parts in a warm detergent solution: 

a. Using forceps, place the parts in a beaker containing warm detergent solution.

b. Place the beaker and contents in an ultrasonic bath for five minutes.

c. Rinse the parts with tap water to remove the detergent.

4. Sonicate the parts in deionized water:

a. Using forceps, place the parts in a beaker containing deionized water.

b. Place the beaker and contents in an ultrasonic bath for five minutes.

c. If the water is cloudy after sonicating, pour off the water, add fresh water, and place 
the beaker and its contents in an ultrasonic bath again for five minutes. Repeat until 
the water is clear.

5. Sonicate the parts in acetone:

a. Using forceps, place the parts in a beaker containing acetone.

b. Using forceps, transfer the parts to a beaker containing fresh acetone.

c. Place the beaker and contents in an ultrasonic bath again for five minutes.

6. Blow-dry the parts immediately. Use clean, dry gas to blow the acetone off the parts.

7. Using forceps, place the parts in a beaker, cover the beaker with aluminum foil, and put 
the beaker in the oven. 

8. Dry the parts in an oven set at 100 oC for 30 minutes.

WARNING  To prevent personal injury, be sure to keep the Dremel tool away 
from possible hazards, such as standing water or flammable solvents.
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9. Allow the parts to cool before putting them back together. 

Cleaning Non-Stainless Steel or Hybrid Parts

To clean non-stainless steel or hybrid parts

1. Remove contamination from stainless steel surfaces. You only need to clean a surface that 
comes in contact with the ion beam.

a. Use a slurry of number 600 aluminum oxide in glycerol and a cleaning brush or 
cotton-tipped applicator.

b. Clean each part thoroughly, even if no contamination is visible. 

c. To clean the inside corners, use the wooden end of an applicator cut at an angle.

d. Use a Dremel tool with the polishing swab at its lowest speed. This will increase 
cleaning efficiency as well as decrease the time required to clean the items. 

Tools needed
• Acetone, reagent grade (or other suitable polar solvent)
• Aluminum oxide abrasive, number 600 (P/N 32000-60340)
• Applicators, cotton-tipped (P/N 00301-01-00015)
• Beaker, 450 mL
• Clean, dry gas
• Deionized water
• Detergent (Alconox, Micro, or equivalent)
• Dremel rotary tool or equivalent (recommended)
• Forceps (P/N 76360-0400)
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Glycerol, reagent grade
• Lint-free cloth
• Protective eyewear
• Tap water
• Toothbrush, soft 

Frequency 
As needed to clean non-stainless steel parts (such as aluminum, ceramic, or 
gold plated), or to clean hybrid parts that are partially made of stainless steel:

• Lens holder and spacers
• Filament spacer
• Heater ring

WARNING  Material and Eye Hazard. Wear impermeable laboratory gloves and eye 
protection when performing cleaning procedures.

Note   Contamination appears as dark or discolored areas, but often is not visible.
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e. Rinse the parts with clean water. Use a clean applicator or toothbrush to remove the 
aluminum oxide slurry. Do not let the slurry dry on the metal; dried aluminum oxide 
is difficult to remove.

2. Scrub all of the parts with a warm detergent solution:

a. Scrub the parts with a toothbrush or clean applicator. Do not soak or sonicate the 
parts in detergent. 

b. Using forceps, rinse the parts thoroughly with tap water to remove the detergent.

3. Rinse the parts in deionized water.

Using forceps, dip the parts in a beaker of deionized water. Change the water if it becomes 
cloudy. Do not soak or sonicate the parts.

4. Rinse the parts with acetone. Using forceps, dip the parts in a beaker of acetone. Change 
the acetone if it becomes cloudy. Do not soak or sonicate the parts.

5. Blow-dry the parts immediately. Use clean, dry gas to blow the acetone off the parts.

Maintaining the Forepump
Inspecting, adding, purging, and changing the forepump oil are all that is required to 
maintain the forepump.

Forepump oil is a translucent, light amber color, which you must check often. During normal 
operation, oil must always be visible in the oil level sight glass between the MIN and MAX 
marks. If the oil level is below the MIN mark, add oil. If the oil is cloudy or discolored, purge 
the oil to decontaminate dissolved solvents. If the pump oil is still discolored, change it. Plan 
to change the pump oil every 3000 hours (about four months) of operation. Refer to the 
manufacturer’s documentation for procedures for purging, adding, and changing the 
forepump oil.

WARNING  To prevent personal injury, be sure to keep the tool away from 
possible hazards, such as standing water or flammable solvents.

CAUTION  Do not leave aluminum parts, such as the heater ring, in the detergent. 
Basic solutions, like detergent, discolor aluminum.

CAUTION  If you use ammonia as a chemical ionization reagent gas, change the oil every 
month. Ammonia is highly basic and quickly damages seals in the forepump. Purging the 
oil with the Gas Ballast Control helps remove dissolved ammonia from the oil.
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Adding Calibration Compound

The calibration compound is a liquid whose mass spectrum of ions is used to tune and 
calibrate the TSQ Quantum XLS Series mass spectrometers. The mass spectrometers use 
FC-43 as their calibration compound. Although you cannot visually determine when to add a 
calibration compound, Xcalibur Automatic Tune produces the error message: “the intensity of 
calibration gas ions is too low.” You must add calibration compound; however, many factors 
other than a decrease in the calibration compound can cause a shortage of calibration gas ions. 
As a rule, add calibration compound once a year.

The calibration compound resides in a cylindrical vial (see Figure 56).

Figure 56. Calibration gas flow modules, showing the calibration compound vial

To add calibration compound 

1. In EZ Tune, place the instrument in standby.

2. Remove the cover to the calibration compound vial compartment. See Figure 57.

Tools needed
• Calibration compound (P/N 50010-02500)
• Syringe (P/N 36502019)

Frequency 
Yearly or as needed

Calibration compound vial
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Figure 57. Location of the calibration compound vial compartment

3. Twist the calibration compound vial counterclockwise and remove it from the calibration 
gas flow module. See Figure 58. Set the vial on the work table.

Figure 58. Calibration compound vial

Calibration compound vial 
compartment

Calibration compound vial 
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4. Add the calibration compound.

a. Draw up no more than 0.1 mL of calibration compound into a clean syringe.

b. Insert the syringe in the calibration compound vial. 

c. Inject no more than 0.1 mL of calibration compound into the white frit. The frit 
absorbs the calibration compound, so if the calibration compound is pooled 
(calibrant covers the top of the frit), then you have too much in the vial. Immediately 
pour out the excess calibrant according to local environmental regulations.

5. Remove the syringe from the calibration compound vial.

6. Reinstall the calibration compound vial to the calibration gas flow module. Turn the vial 
clockwise to tighten it.

7. Reinstall the cover to the calibration compound vial compartment.

CAUTION  Having more than 0.1 mL of the calibration compound can contaminate 
the calibration gas flow module. Be sure that less than 0.1 mL of the calibration 
compound is in the vial. Be sure that liquid does not get into the flow module when 
you reattach the vial.
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Replacing the Ball Valve Seal

The ball valve seal in the inlet valve can become worn over time. Replace the ball valve seal if 
it leaks air after you insert the direct insertion probe or I/R tool and tighten the inlet valve 
knob. The ball valve seal kit (P/N 119265-0003) is included in the Accessory Kit. 

The ball valve seal consists of a Teflon™ spool and two O-rings. See Figure 59.

Figure 59. Components of the ball valve seal and inlet valve 

You use the ball valve seal extraction tool (part of the Ball Valve Seal Kit, P/N 119265-0003) 
to remove the ball valve seal. See Figure 60.

Tools needed
• Ball valve seal kit (P/N 119265-0003)

Frequency 
If the ball valve seal leaks air after you insert the direct insertion probe or 
I/R tool into the inlet valve and tighten the inlet valve knob

Ball valve seal 
components

Inlet valve 
insert

Inlet valve knob

Inlet valve 
housing
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To remove the ball valve seal

1. Loosen the inlet valve knob counterclockwise until you can remove it. 

2. Remove the inlet valve knob, plug, and insert.

3. Insert the not-engaged ball valve seal extraction tool into the inlet valve housing. 

4. Engage the ball valve seal by pushing the plunger of the ball valve seal extraction tool 
forward.

5. Remove the seal and tool.

6. Pull the plunger back to disengage the seal.

Figure 60. Ball valve seal extraction tool and ball valve seal, not engaged (left) and engaged (right)

To install the ball valve seal

1. Obtain the Ball Valve Seal Kit (P/N 119265-0003) from the Accessory Kit.

2. Assemble the ball valve seal by installing the two O-rings onto the Teflon spool.

3. Insert the ball valve seal into the ball valve manifold with your finger.

4. Install the inlet valve knob and insert.

5. Install the inlet valve plug and tighten the inlet valve knob clockwise.

Ball valve seal
extraction tool

Ball valve seal
106 TSQ Quantum XLS Series User Guide Thermo Scientific



 6 Maintenance
Removing and Installing a GC Capillary Column
Removing and Installing a GC Capillary Column
Replace the GC capillary column if the chromatographic separation is bad or if it does not 
have the appropriate stationary phase for your application.

Removing a GC Capillary Column

To remove a GC capillary column

1. Shut down the mass spectrometer and the gas chromatograph:

a. Shut down and vent the mass spectrometer. See “Shutting Down the System 
Completely” on page 51.

b. Lower the oven, injector, and transfer line temperatures to 30 °C and allow them to 
cool before continuing.

c. Once the oven, injector, and transfer line are cool, turn off the gas chromatograph.

2. Remove the column from the transfer line. See Figure 61.

a. Unscrew the transfer line nut.

b. Remove the column from the transfer line. 

Tools needed
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Wrench, open-ended, 5/16 in.
• Wrench, open-ended, 7/16 in.
• Wrench, open-ended, 6 mm

Frequency 
As needed for maintenance or column replacement

WARNING  Burn Hazard.The oven, injector, and transfer line are hot. Allow 
them to cool to room temperature before touching them.
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Figure 61. GC injector and transfer line unions

3. Remove the column from the injector. For instructions, refer to the Columns chapter of 
the TRACE GC Ultra Operating Manual.

Column retaining 
nut

Ferrule

Capillary 
column

Injector

Transfer line nut

Ferrule

Transfer line 
(end)
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Installing a GC Capillary Column

For additional GC column installation information, refer to the TRACE GC Ultra Operating 
Manual and the TRACE GC Ultra Maintenance and Troubleshooting Manual.

To install a GC capillary column

1. Connect the column to the injector. For instructions, refer to the Columns chapter of the 
TRACE GC Ultra Operating Manual. For the column depth length for your injector, refer 
to the TRACE GC Ultra Quick Reference card.

2. Set up the gas chromatograph:

a. Turn on the gas chromatograph.

b. Set the oven and injector temperatures to 30 °C.

c. Set the injector flow to 1.0 mL/min.

d. Turn off vacuum compensation (under the Right or Left Carrier menu).

e. Dip the column outlet in a small vial of methanol. Bubbles indicate there is flow 
through the column.

Tools needed
• Capillary column
• Gloves, cleanroom grade (P/N 23827-0008 and 23827-0009)
• Injector ferrule, for 0.25 mm column (P/N 290 134 88)
• Leak detector, hand-held electronic (GL Sciences, Inc., model LD-228, or 

equivalent)
• Lint-free tissue
• Magnifying glass
• Methanol or other suitable solvent
• Scoring wafer (or sapphire scribe) to cut capillary column
• Transfer line ferrule, 0.4 mm ID (P/N A0101-18100)
• Wrench, open-ended, 5/16 in.
• Wrench, two, open-ended, 7/16 in.
• Wrench, open-ended, 6 mm

Frequency 
As needed

WARNING  Burn Hazard. The injector, oven, and transfer line might be hot. Allow 
them to cool to room temperature before touching them.

Note  Wear clean, lint- and powder-free gloves when you handle the column and 
injector ferrule.
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f. Allow the column to purge for at least 10 minutes.

3. Perform a manual column leak check. For instructions, refer to the Ensuring Tightness 
chapter of the TRACE GC Ultra Maintenance and Troubleshooting Manual.

4. Perform a column evaluation. For instructions, refer to the Columns chapter of the 
TRACE GC Ultra Operating Manual. For expected K factors for various column 
diameters, column lengths, and carrier gases refer to the K-Factor Quick Reference card. 

5. Perform an automatic column leak check:

a. Run an automatic leak check. Refer to the Columns chapter of the TRACE GC Ultra 
Operating Manual for instructions.

b. If the report indicates a leak, look for leaks and use the leak detector to fix leaks at all 
the fittings in the GC.

c. Repeat column evaluation and leak check procedures until no leaks can be found.

6. Condition the capillary column according to the manufacturer’s instructions. You must 
condition new columns before inserting them in the mass spectrometer.

7. Connect the column to the transfer line:

a. Shut down and vent the mass spectrometer. See“Shutting Down the System 
Completely” on page 51.

b. Lower the GC oven temperature to 30 °C and allow it to cool before continuing.

Note  The K factor is a measure of the resistance of the column. A K factor that is too 
low might indicate a leak in the system, while a K factor that is too high might 
indicate a blockage.

CAUTION  Do not raise the oven temperature until you are sure the system is 
leak-free. At temperatures above 100 °C, oxygen exposure will destroy the 
column.

CAUTION  Do not insert the column into the transfer line during the conditioning. 
The material released from the column during the conditioning (column bleed) will 
contaminate the ion source, which you must then clean.

CAUTION  Never exceed the column manufacturer’s maximum operating 
temperature.

WARNING  Burn Hazard. The GC oven and transfer line might be hot. Allow 
them to cool to room temperature before touching them. Do not touch the 
injector when it is hot.
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c. Wearing clean, lint- and powder-free gloves, unwind about one turn of the capillary 
column (shown in Figure 61 on page 108) from the column outlet end.

d. Wipe about 450 mm (18 in.) of the column with a tissue soaked in methanol.

e. Insert the column through the transfer line nut and ferrule. Wipe the column again 
with a tissue soaked in methanol.

f. Score and break the end of the column with a scoring wafer. With the magnifying 
glass, check for an even, flat cut. Repeat if necessary.

g. Insert the column into the transfer line:

i. Open the lid of the ion source vacuum chamber so that you can get a better view 
of the column.

ii. Using the I/R tool, remove the ion volume. See “Removing the Ion Volume” on 
page 73.

iii. Insert the column into the transfer line and tighten the transfer line nut by hand.

iv. Push the column in until you can see it through the inlet valve.

v. Pull the column back just far enough so that you cannot see it.

vi. Tighten the transfer line nut and transfer line union.

vii. Using the I/R tool, replace the ion volume. See “Installing the Ion Volume” on 
page 80.

8. Condition the transfer line ferrule. Graphite/Vespel™ ferrules like the transfer line ferrule 
require conditioning to ensure a leak-tight seal.

a. Raise the oven temperature to the maximum temperature for operating the column 
(normally 300 °C). 

b. Wait 10 minutes.

c. Lower the oven temperature to 30 °C and allow it to cool before continuing.

d. Retighten the transfer line nut and the transfer line union.

9. Set up the gas chromatograph:

a. Make sure the column does not have any sharp bends and that it does not touch any 
metal objects or walls inside the oven.

Note  Sliding a septum on the column before the transfer line nut helps you 
measure the proper distance between the nut and the end of the column. Ensure 
that the column extends approximately 1 to 2 mm past the end of the transfer 
line.

WARNING  Burn Hazard.The oven might be hot. Allow it to cool to room 
temperature before opening it. Do not touch the injector, which will still be hot.
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b. Raise the oven temperature to the initial temperature that you will use (normally 
40 °C).

c. Turn on the vacuum compensation (under the Right or Left Carrier menu).
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Diagnostics and Troubleshooting

The TSQ Quantum XLS Series system diagnostics can test many components of the TSQ 
Quantum XLS Series mass spectrometers. If there is a problem in the instrument electronics, 
the diagnostics can often locate it. Replacing a faulty PCB or assembly will usually correct the 
problem. After replacing a PCB or assembly, your Thermo Fisher Scientific field service 
engineer will run diagnostic tests again to verify that the instrument is functioning properly. 

Diagnostics 
The TSQ Quantum XLS Series system diagnostics test the major electronic circuits within the 
instrument and indicate whether the circuits pass or fail the tests. If the instrument electronics 
do have a problem, the system diagnostics can often pinpoint the location. 

Because the system diagnostics only diagnose problems that are electrical in nature (for 
example, they do not diagnose poor sensitivity due to misaligned or dirty components or to 
improper tuning), whoever runs the diagnostics must be familiar with system operation and 
basic hardware theory as well as the details of the diagnostics. 

Before calling a Thermo Fisher Scientific field service engineer to run diagnostics, consider 
the following:

• Did the system fail when you were running samples?

• Did problems occur after you performed maintenance on the instrument, data system, or 
peripherals?

Contents

• Diagnostics

• Troubleshooting

• Replacing Fuses

• Replacing PCBs and Power Supplies

IMPORTANT  Typically, only a Thermo Fisher Scientific field service engineer runs 
diagnostic tests because certain tests can overwrite system parameters. 
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Troubleshooting
• Did you change the configuration of the system, cables, or peripherals just before the 
problem occurred?

If the answer is yes to the first item above, there is the possibility of a hardware failure, and 
running the diagnostics is appropriate.

If the answer is yes to either of the last two questions above, the problem is probably 
mechanical, not electrical. Reconfirm that alignment, configurations, and cable connections 
are correct before you call the Thermo Fisher Scientific field service engineer. Keep careful 
notes documenting the nature of the problem and the corrective steps you have taken. If you 
are not successful in correcting the problem, you can e-mail this information to your service 
engineer. Field Services can then do a preliminary evaluation of the problem before the field 
service engineer arrives at your site.

Troubleshooting
The following topics discuss possible TSQ Quantum XLS Series system problems and 
solutions.

Communication Issues

Communication issues likely involve links between the data system and the mass 
spectrometer, gas chromatograph, or autosampler. This section does not address 
communication issues with other devices. 

Communication issues can occur during the following:

• Data transfer between the mass spectrometer and the data system

• Mass spectrometer, gas chromatograph, and autosampler current status readbacks

• Instrument control, method downloading, and uploading

• Start, stop, pause, and initialize functions

• Error messages

How does the MS communication work?

The flow of digital information in the TSQ Quantum XLS Series systems is bidirectional; the 
data system downloads analytical methods to the instrument and activates functions to start, 
stop, shut down, start up, and initialize. The TSQ Quantum XLS Series systems report their 
readiness state, current tasks, various voltages, heated zones, and pressure readings. They also 
deliver a steady stream of mass spectral data during acquisition.
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Troubleshooting
Why does the MS have communication issues?

Some communication issues are due to mechanical faults—for instance, a cable might be 
unplugged, or a device might be turned off. In other cases, the instrument method could be 
incorrect for TSQ Quantum XLS Series system operations. Less common communication 
issues are due to defective electronic hardware components. 

How do I detect communication issues?

You might detect communication issues from an error message delivered by the data system, 
or you might notice the failure of the data system to perform some expected task.

Issue:  Data system is
unable to initiate

communication with the
mass spectrometer.

Possible causes/solutions

• The software is not configured correctly. Select and configure the mass spectrometer from 
the Instrument Configuration window.

• The Ethernet cable is unplugged. Verify that the Ethernet cable is connected to the 
Ethernet port on the mass spectrometer. See Figure 14 on page page 25.

• The Ethernet card in the PC is not configured or is faulty. Check the configuration or 
replace the Ethernet card if necessary.

• The electronics service switch of the mass spectrometer is in the Service Mode position. 
Return the electronics service switch to the Operating position. 

• An incorrect Ethernet cable is used for the mass spectrometer. Use the supplied 10 Base-T 
Category 5 crossover cable (P/N 76396-0052, in the TSQ Quantum XLS Accessory Kit).

Issue:  Computer
intermittently loses

communication with the
mass spectrometer.

Possible cause/solution

• The Ethernet cable is loose or damaged. Inspect the cable and replace it if necessary.

Issue:  Unable to
download methods to

the mass spectrometer.

Possible cause/solution

• The software is not properly configured. Verify the correct settings in Instrument 
Configuration.

Note  You can extend the length of the Ethernet cable by plugging a standard 
Category 5 cable in series with the supplied crossover cable.
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Troubleshooting
Issue:  Acquisition does
not begin as expected.

Possible causes/solutions

• The start mode is not properly configured. Verify that the instrument is configured 
properly. Refer to the Xcalibur Help for more information. 

• The mass spectrometer Instrument Setup file has incorrect settings. Check the start time 
in the Instrument Setup file.

• The forepressure is too high due to the solvent peak. Reduce injection volume or extend 
the filament/multiplier delay time until after solvent peak. 

• The remote start cable to the GC is disconnected. Connect the remote start cable. 

• The GC did not start. Verify GC instrument method and configuration. Verify the 
connection between the autosampler and GC.

• The autosampler did not start. Verify autosampler instrument method and configuration. 
Verify that the sample is present.

• The heated zone stipend is not attained. See “Heated Zone Issues” on page 120.

Issue:  Acquisition
terminates

unexpectedly.

Possible causes/solutions

• The end run time in the TSQ Quantum XLS Series instrument method is incorrect. 
Check the instrument method for the GC and the MS.

• The data system is out of disk space. Check disk space; back up and remove files.

Issue:  Unable to
initialize the gas
chromatograph.

Possible causes/solutions

• The GC is not turned on. Turn on the GC.

• The GC is not configured properly in the Xcalibur data system. Check Instrument 
Configuration.

• The cable between COM1 and GC is disconnected. Verify connection.

• COM1 is not configured properly. Verify COM port configuration. 

Issue:  Unable to
download methods to

the gas chromatograph.

Possible causes/solutions

• There is a discrepancy between the instrument method and configuration. Verify 
consistency between method and instrument configuration.

• COM1 is not configured properly. Verify COM port configuration.
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Issue:  Unable to
initialize the
autosampler.

Possible causes/solutions

• The autosampler is not turned on. Turn on autosampler. 

• The autosampler is not configured properly in the Xcalibur data system. Check 
Instrument Configuration.

• The cable between the GC and autosampler is disconnected. Verify connection.

• The autosampler instrument configuration is not set to the correct port. Verify 
connection and configuration.

Issue:  Unable to
download methods to

the autosampler.

Possible cause/solution

• There is a discrepancy between instrument method and configuration. Verify consistency 
between instrument method and instrument configuration.

Contamination Issues

Chemical noise is always present in any mass spectrometer. As a result, the high sensitivity of 
the mass spectrometer can cause new users to confuse background with a contamination 
problem. Additionally, the spectra shown in Xcalibur Tune and Real-Time Display are 
auto-normalized, which can make the background level appear high. 

Some chemical noise does occur, such as septum bleed after a series of injections, vial sample 
bleed (which occurs if more than one injection is made from a sample vial), and siloxane peaks 
that appear in the chromatogram at regular intervals from focusing at the head of the column 
or in the injector. 

Other possible contamination sources include hydrocarbon contamination of the carrier gas, 
pump oil, or instrument cleaning solvents. 

Always wear clean, lint- and powder- free gloves when handling ion source and mass analyzer 
components, and ensure that the carrier gas filter, carrier gas lines, and gas regulators are free 
of contamination and leaks.

Issue:  Excessive
chemical background

due to a column bleed
(m/z 429, 355, 281).

Possible causes/solutions

• The capillary column has not been properly conditioned. Condition the capillary 
column.

• The capillary column is damaged as a result of exposure to oxygen. Find the source of the 
oxygen in the carrier gas or air leak. Recondition or replace the capillary column.
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Issue:  Excessive
injection port septum

bleed (Typical m/z 207,
429, 355, 281).

Possible causes/solutions

• The septum is worn out or damaged. Replace the septum.

• Small pieces of septum are in the injection port liner. Replace the injection port liner; 
condition the capillary column.

Issue:  Phthalate
background (m/z 149,

167, 279).

Possible causes/solutions

• Phthalate contamination has occurred due to sample handling or solvent contamination.

• Packaging materials could be the source of phthalates. 

• Isolate source of phthalates such as vial lids or plastic solvent containers and remedy. 

Issue:  Excessive
hydrocarbon

contamination (Typical
ions are m/z 43, 57, 71,

85, 99).

Possible causes/solutions

• Carrier gas tubing is contaminated. 

• Isolate source of hydrocarbon contamination and remedy. 

• Replace carrier gas tubing. 

• Change carrier gas filters. 

Issue:  Chemical
background due to

rhenium oxide
(m/z 185/187, 201/203,

217/219, 233/235,
250/252).

Possible causes/solutions

• These series of rhenium oxide ions come from oxidation of the rhenium filament wire 
due to introducing air into the ion source while the filament is on. 

• Check for air leaks and remedy. For more information, see “High Vacuum Issues” on 
page 121.

Issue:  Spectra are
observed due to the
following solvents:

Solvent spectra

Acetone (m/z 43, 58, 59)

Hexane (m/z 41, 43, 56, 57, 58, 85, 86)

Methanol (m/z 31)

Methylene chloride (m/z 84, 83)

Toluene (m/z 91, 92)

Trichloroethane (m/z 151, 153)

Xylene (m/z 105, 106)
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Possible causes/solutions

• There is residual solvent from a cleaning procedure or laboratory background 
contamination. When you finish performing a cleaning procedure, allow cleaned 
components to dry thoroughly. Warm parts in the GC oven to drive off residual solvent.

• The observed compounds have been introduced through sample injection. The ultimate 
source is either a sample solvent or the autosampler rinsing solvent. Optimize GC 
method to separate solvent peak from the area of interest in the chromatogram.

Filament and Lens Control Issues

The lifetime of a filament depends on its exposure to oxygen and solvent vapors. The filament 
assembly protects the filament and increases its lifetime for many months. 

Xcalibur diagnostics test the filament for continuity and current regulation. Testing the 
filament for continuity before each acquisition ensures that an open filament condition will 
stop an autosampler sequence and generate an error message.

Diagnostics test the lenses of the TSQ Quantum XLS Series mass spectrometers. A flat line, 
which represents voltage readback versus the predicted voltage ramp, indicates a lens or other 
control fault. Contamination causes lens performance to deteriorate over time; the amount of 
time depends on what type of sample and ionization mode you use. 

Issue:  Diagnostics
indicate that the
filament is open.

Possible cause/solution

• The filament is open. Vent the system and remove the filament. Normal resistance is 
1.0 Ω. Replace if open.

Issue:  Unstable
emission current.

Possible cause/solution

• The filament is near the end of its life span. Replace the filament.

Issue:  Short filament
lifetime.

Possible causes/solutions

• There is an air leak contributing to short filament lifetime. Check for leaks; repair if any 
are found. For more information, see “High Vacuum Issues” on page 121.

• The filament is on during the solvent peak. Increase acquisition delay time until the 
solvent peak has passed.

• High emission current is being used. Use lower emission current to extend lifetime.

CAUTION  Handle the lenses with care, and do not use harsh cleaning techniques. 
Damaged lenses cause short circuits, which in turn can cause damage to the lens drivers. 
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Issue:  Diagnostics
indicate a flat lens

response.

Possible causes/solutions

• The power supply to the lens has a fault. Contact Thermo Fisher Scientific Technical 
Support.

• There is a fault with the lens drivers. Contact Thermo Fisher Scientific Technical 
Support.

Heated Zone Issues

The ion source and transfer line are heated zones. The mass spectrometer controls the ion 
source heater and the Aux1 heated zone of the TRACE GC Ultra controls the transfer line 
heater. 

A heated zone problem is often the result of downloading an instrument method to the 
instrument that has a different setpoint than the current setting, causing a delay while the 
heated zone heats or cools. 

Component failures are less common but can occur. These are usually related to open circuits 
in heater cartridges or faulty temperature sensors. 

This manual does not discuss heated zones in the gas chromatograph.

Issue:  Excessive
chromatographic peak

tailing.

Possible causes/solutions

• The ion source, transfer line, or both are not hot enough. Increase the transfer line 
temperature so that it is at least as hot as the highest GC oven temperature. Then, try 
increasing the ion source temperature.

• The sample analyte is adsorbing in the GC injector. Clean and deactivate the injection 
liner. You can also try liners made of different materials.

• The GC oven is not ramped to a high enough temperature. Extend upper oven 
temperature.

• The GC column must be replaced or does not have the appropriate stationary phase for 
your application. Change the GC column. See “Removing and Installing a GC Capillary 
Column” on page 107.

• The GC column does not extend far enough past the end of the transfer line tip. If the 
end of the column is inside the tip, an excessive amount of GC effluent will contact the 
inside wall of the tip. Follow the procedure described in “Installing a GC Capillary 
Column” on page 109.
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Issue:  Source heater
will not heat.

Possible causes/solutions

• No contact between the ion source temperature sensor and the heater block. For accurate 
temperature readings of the heater block, fully screw the threaded standoff into the ion 
source to ensure contact between the temperature sensor and the heater block. See 
“Reassembling the L1, L2, L3 Lens Assembly” on page 92.

• One or more heater cartridges on the EI/CI Source PCB is defective. Replace the EI/CI 
Source PCB. See “Completely Disassembling and Reassembling the Ion Source” on 
page 95.

• The ion source temperature sensor (RTD) is defective. Replace the EI/CI Source PCB. 
See “Completely Disassembling and Reassembling the Ion Source” on page 95.

Issue:  Source heater
overheats.

Possible cause/solution

• The ion source temperature sensor (RTD) is defective. Replace the EI/CI Source PCB if 
necessary. See “Completely Disassembling and Reassembling the Ion Source” on page 95.

Issue:  Transfer line will
not heat.

Possible causes/solutions

• Aux1 zone of the GC is not configured for MS Transfer Line. Configure Aux1 zone of the 
GC and set transfer line temperature in the GC Method Editor.

• Transfer line heater elements are defective. Replace the transfer line.

• The transfer line temperature sensor (RTD) is defective. Replace the transfer line.

Issue:  Transfer line
overheats.

Possible cause/solution

• The transfer line temperature sensor is defective. Replace the transfer line.

High Vacuum Issues

High vacuum problems can become obvious in two ways:

• An intermittent vacuum condition (the vacuum pressure in the vacuum manifold 
fluctuates intermittently) can cause chromatographic signals to drop out; or if the 
pressures exceed the maximum allowed pressures set in the Xcalibur data system (see 
Table 3 on page 55), then the TSQ Quantum XLS Series system turns off. 

• If the vacuum is consistent enough that it does not exceed the maximum allowed pressure 
and avoids automatic shutdown of the Xcalibur system, non-reproducible false 
chromatographic peaks can be generated in the chromatogram. 

Typical forepressure readbacks are 30 to 40 mTorr (in EI mode), and typical manifold 
pressure (ion gauge readback) is 2 × 10–5 Torr with argon collision gas on, and 2 × 10–6 Torr 
with Ar collision gas off. 
Thermo Scientific TSQ Quantum XLS  Series User Guide 121



7 Diagnostics and Troubleshooting
Troubleshooting
The most reliable way to find vacuum leaks is to spray a gas around the vacuum manifold and 
look for the characteristic ions in full-scan EI mode. Argon produces m/z 40. Or, you can use 
compressed electronic dusting spray containing an HFC. For example, Falcon™ Dust-Off™ 
and MicroCare™ Micro-Blast™ contain tetrafluoroethane, which produces ions at m/z 69 
and 83. 

Issue:  Forepump will
not turn on.

Possible causes/solutions

• The forepump is off. Check the forepump switch.

• The vacuum service switch is in the Off position. Place the vacuum service switch in the 
operating position.

• The forepump power cable from the mass spectrometer is not connected. Connect the 
power cable.

• The forepump is faulty. Replace the forepump.

Issue:  Forepump
powers on, but will not

pump down.

Possible causes/solutions

• The oil level in the forepump is insufficient. Check oil level; add oil if necessary.

• The foreline is leaking. Check the clamps and connectors. Replace the foreline hose if a 
hole is found.

• The vacuum manifold is leaking. 

• The forepump is faulty. Replace the forepump.

Issue:  Turbo pump
shuts off during

operation.

Possible cause/solution

• The foreline pressure is too high. Check for leaks in the foreline.

Issue:  Unexpected full
ventilation occurs.

Possible causes/solutions

• A gross leak is present. Check for leaks.

• The system was vented through the inlet valve. Close and plug the inlet valve.

• The GC column broke at the transfer line. Replace the GC column. See “Removing and 
Installing a GC Capillary Column” on page 107.

• The foreline was cut. Replace the foreline hose.

Note  The mass spectrometer performs a leak check during the automatic tuning and 
calibration procedure and during the maintenance tune procedure. The mass 
spectrometer returns a pass or fail report.
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Issue:  Vacuum is faulty. Possible Solutions

• A gross leak is present. Check for leaks.

• The pressure in the analyzer region of the vacuum manifold, as measured by the ion 
gauge, must be below the pressures listed in Table 3 on page 55. 

Linearity Issues

Linearity issues occur when a plot of intensity versus concentration of a known compound is 
not linear. Poor instrument operating conditions can cause linearity problems. In addition, 
certain compounds do not give a desired linear response due to chromatographic activity. 

A well-maintained instrument provides good linear response over a wide range of 
concentrations for most compounds. Like all instruments, however, the TSQ Quantum XLS 
Series mass spectrometers have a saturation point. 

Perform routine injector and column maintenance to minimize linearity problems. Usually, a 
hardware fault that affects linearity shows different issues than those that might be attributed 
to linearity.

Issue:  Calibration plots
not sufficiently linear.

Possible causes/solutions

• High-end standards are too concentrated for the MS. Use the split injection technique to 
decrease the amount of sample, or lower emission current to reduce MS sensitivity.

• The ion volume and lenses are dirty. Clean ion volume and lenses as described in 
“Cleaning Ion Source Components” on page 85.

• The electron multiplier setting is incorrect. Run the tune and calibration procedure as 
described in “Running Auto Tune and Calibration” on page 64.

• The injection port liner or capillary column is dirty. Change the injection port liner and 
trim the capillary column.

• The capillary column stationary phase is too thin for high concentration samples. Use a 
higher capacity capillary column with a thicker stationary phase, or use a split injection 
technique.

• The capillary column is bad. Replace the capillary column. See “Removing and Installing 
a GC Capillary Column” on page 107.
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Power Supply Issues

Xcalibur diagnostics detect most power supply issues. Power supply problems often involve a 
blown fuse, faulty electronic components, or something as simple as a disconnected cable. 
Have a Thermo Fisher Scientific field service engineer replace a blown fuse.

Issue:  Mass
spectrometer will not

power on.

Possible causes/solutions

• The power cord is disconnected. Verify that the power cord is plugged in.

• Voltage is not coming from the electrical outlet. Verify that the electrical outlet is 
operational.

• The Power Module is faulty. Contact Thermo Fisher Scientific Technical Support.

Issue:  Mass
spectrometer powers on

but trips the circuit
breaker.

Possible causes/solutions

• The Power Module is faulty. Contact Thermo Fisher Scientific Technical Support.

• The forepump causes the circuit breaker to trip. Check forepump; replace it if necessary.

Sensitivity Issues

If you observe a drop in instrument sensitivity, determine if the sensitivity drop was sudden or 
if it occurred gradually. A sudden loss of sensitivity can be the result of sudden component 
failure or an unnoticed change in the analytical method. Simple errors such as a plugged 
autosampler syringe or too low sample level in the sample vial can give the appearance of 
instrument failure. 

Gradual drops in sensitivity are usually the result of ion volume or lens contamination, and 
are easily remedied by cleaning the ion volume or lenses. 

The electron multiplier influences sensitivity and has a limited lifetime. Eventually you must 
replace the electron multiplier. 

Improper GC maintenance is another cause of diminished sensitivity. It is important to 
establish a routine maintenance program for the GC. For more information on establishing a 
maintenance program, refer to the TRACE GC Maintenance Manual. 
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Issue:  The
chromatogram has a low

total ion current signal.

Possible causes/solutions

• The GC temperature ramp does not continue to a high enough temperature to elute high 
boiling point compounds. Multiple injections cause these compounds to accumulate in a 
column, reducing sensitivity. Extend upper temperature or the time at upper temperature 
in the GC oven ramp.

• The instrument is out of tune, or the tune file is incorrect. Select the correct tune file for 
the method or run automatic tune as described in “Running Auto Tune and Calibration” 
on page 64.

• The ion volume is contaminated. Clean the ion volume.

• The ion volume is incorrectly positioned. Position the ion volume properly.

• The magnets above and below the ion source are installed incorrectly. Position both 
magnets so that the south pole is on top. Electrons will not focus into the ion volume if 
one magnet is upside down.

• Dust has collected in the electron multiplier or on the conversion dynode. Contact 
Thermo Fisher Scientific Technical Support.

• The emission current is set too low. Check the setting listed for the emission current. 

• The ground connection between the Electrometer PCB and anode feedthrough is faulty. 
Contact Thermo Fisher Scientific Technical Support.

• There is a problem with the filament or lens control. See “Filament and Lens Control 
Issues” on page 119 for more information.

• The EI/CI Source PCB is faulty, which allows emission current to leak to ground. 
Contact Thermo Fisher Scientific Technical Support.

• Reagent gas is leaking into the analyzer and suppressing EI signal. Check for presence of 
CI reagent ions in the spectrum. Replace CI Gas Flow Module if necessary. 
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Issue:  Poor compound
sensitivity.

Possible causes/solutions

• The syringe, injection port liner, and column depth in the injector are incorrectly 
matched. For the correct combination, refer to the TRACE GC Ultra Operators Manual.

• Sample delivery is insufficient due to a plugged syringe needle. Clean or replace the 
syringe.

• The injection port liner is contaminated. Clean or replace the injection port liner.

• Graphite or septa particles contaminate the injection port. Clean the injection port.

• The injector or septum is leaking. Replace septum and perform leak check on the GC. 

• The capillary column is at the end of its life span. Replace the capillary column.

• Method development problems are present. Contact Thermo Fisher Scientific Technical 
Support.

Issue:  Sensitivity is
unstable or shows

decrease with repeated
injections.

Possible causes/solutions

• The GC temperature ramp does not continue to a high enough temperature to elute high 
boiling point compounds. Multiple injections cause these compounds to accumulate in a 
column, reducing sensitivity. Extend the upper temperature or the time at upper 
temperature in the GC oven ramp.

• The ion volume or lenses are contaminated. Clean the ion volume and lenses as described 
in “Cleaning Ion Source Components” on page 85. 

• The ion source temperature is too low and causes the ion source to contaminate too 
quickly. Clean ion volume and lenses as described in “Cleaning Ion Source Components” 
on page 85 and then raise ion source temperature.

• There is a problem with the filament emission current control. See “Filament and Lens 
Control Issues” on page 119 for more information.

• The electron multiplier is faulty. Contact Thermo Fisher Scientific Technical Support.

• The injection port liner or capillary column is contaminated. Replace the injection port 
liner and trim the capillary column.
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Issue:  Poor sensitivity
in CI mode.

Possible causes/solutions

• An EI ion volume is installed. Install a CI ion volume as described in “Changing 
Ionization Modes” on page 73.

• The small hole in the CI ion volume is plugged. Use a dental pick or old syringe needle to 
clear it.

• The filament is not aligned. Remove the ion volume and check if the ion burn is centered 
around the small electron entrance hole. Be sure the filament is properly inserted into the 
connector. Carefully bend the filament wire to better align it with the ion volume.

• The ion volume is not inserted properly. While running the instrument, you can push on 
the ion volume with the I/R tool. Be sure to monitor the pressure to ensure that you get a 
good seal around the I/R tool. Otherwise, you might damage the filament. An increase in 
signal calibration gas as you push on the ion volume usually indicates that the filament is 
not aligned properly.

Stability Issues

Stability helps provide consistent instrument precision and the reproducibility of accurate 
results. Good operating conditions for the mass spectrometer, gas chromatograph, and 
autosampler contribute to instrument stability. 

Sample preparation, spiking errors, sample injection errors, and lack of routine maintenance 
on the instruments can cause false stability issues. 

When hardware faults affect instrument stability, investigate simple solutions first, such as 
cleaning the ion volume and lenses, or checking for air leaks. Usually, a hardware fault that 
affects stability shows different issues than those which might be attributed to stability.

Issue:  The signal
response is unstable or
drops out unexpectedly.

Possible causes/solutions

• There is a problem with the filament or lens control. See “Filament and Lens Control 
Issues” on page 119 for more information.

• There is an air leak. Run the maintenance tune or the Xcalibur auto tune and calibration 
procedure, which performs a leak check and returns a pass or fail message. If necessary, 
check for leaks. See “High Vacuum Issues” on page 121 for more information.

• There is a high vacuum problem. See “High Vacuum Issues” on page 121 for more 
information.

• There is a contamination problem. See “Contamination Issues” on page 117 for more 
information.

• Dust has collected in the electron multiplier or on the conversion dynode. Contact 
Thermo Fisher Scientific Technical Support.
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Tuning Issues

You can suspect a tuning problem when Xcalibur auto tune and calibration fails. The auto 
tune and calibration procedure performs several functions, and issues or error messages 
indicate different problems. Diagnostics can usually uncover a tuning problem. 

Issue:  “Cannot find
Calibration Gas” error

message received.

Possible causes/solutions

• There is a mechanical problem with the ion source or lenses. Verify that an EI ion volume 
is installed. Verify correct orientation and cleanliness of ion volume. Verify cleanliness and 
correct operation of lenses.

• Tune file settings are out of usable range. Restore default tune settings and calibration 
settings. Run Auto Tune and Calibration. See “Tuning and Calibrating” on page 61. 

• The calibration gas vial is empty. Add 100 μL (max) of calibration compound to 
calibration gas vial. See “Adding Calibration Compound” on page 102.

Issue:  The electron
multiplier gain

calibration fails.

Possible causes/solutions

• The electron multiplier has not been given sufficient time to outgas since venting. Allow 
more time to pump out.

• The GC column flow is too high. Lower it to 1 mL/min.

• The multiplier is near the end of its lifetime. Multipliers typically last about 2 to 3 years 
before they are too noisy for the gain to be set accurately. Contact Thermo Fisher 
Scientific Technical Support.

• The multiplier power supply is faulty. Contact Thermo Fisher Scientific Technical 
Support.

• The filament is the source of too much background noise. See “Filament and Lens 
Control Issues” on page 119 for more information.

• Chemical background in the manifold is elevated. Remedy leaks or sources of water 
contamination in carrier gas. See “High Vacuum Issues” on page 121 for more 
information.

• The difference between the electron energy and the setpoint is greater than 5 V. Contact 
Thermo Fisher Scientific Technical Support for assistance.
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Issue:  Poor high mass
response.

Possible causes/solutions

• Poor high m/z ion intensity because the ion source temperature is too high. Reduce the 
ion source temperature to reduce the amount of thermal decomposition and 
fragmentation of your analyte.

• Poor high m/z ion intensity because of bad ion source lens settings. Run the tune and 
calibration procedure. See “Tuning and Calibrating” on page 61. 

• Helium pressure in the ion source is too high or low. Set flow to 1.0 mL/min for most 
applications.

• There is a vacuum leak. Find and repair any leaks. Be sure to check the transfer line fitting 
in the GC oven. See “High Vacuum Issues” on page 121 for more information.

• An excess amount of low m/z ions, such as hydrocarbons or column bleed. Remedy the 
source of these low m/z ions. 

• The ion volume or lenses are contaminated. Clean the ion volume or lenses. See 
“Cleaning Ion Source Components” on page 85.

• m/z 131 is not base peak because the multiplier gain is too low. The multiplier gain 
calibration may set the multiplier voltage too low for a noisy multiplier. Electron 
multipliers older than 2 to 3 years are often noisy. Contact Thermo Fisher Scientific 
Technical Support.

• There is poor high m/z intensity and poor resolution of low m/z ions because the 
conversion dynode is faulty. Contact Thermo Fisher Scientific Technical Support.

• The injection rf is not calibrated. Run the tune and calibration procedure as described in 
“Tuning and Calibrating” on page 61.

• There is a problem with the filament or lens control. See “Filament and Lens Control 
Issues” on page 119 for more information.

• Reagent gas is leaking into the analyzer and suppressing the EI signal. Check for the 
presence of CI reagent ions in the spectrum. Replace the CI Reagent Gas Flow Module if 
necessary. 
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Issue:  Weak signal. Possible causes/solutions

• The ion volume or ion source lenses are dirty. Clean the contaminated components as 
described in “Cleaning Ion Source Components” on page 85.

• The multiplier is set too low. Run multiplier gain calibration in the tune and calibration 
procedure as described in “Tuning and Calibrating” on page 61. An electron multiplier 
older than 2–3 years may be too noisy for the multiplier gain calibration to accurately set 
the voltage. You might need to replace the electron multiplier. Contact Thermo Fisher 
Scientific Technical Support.

• The wrong type of ion volume is installed. EI and CI require different ion volumes. They 
may not be used interchangeably. Change the ion volume as described in “Changing 
Ionization Modes” on page 73.

• The ion volume is absent or incorrectly positioned. Verify that the ion volume is 
positioned correctly.

• There is a filament or lens control problem. See “Filament and Lens Control Issues” on 
page 119 for more information.

• The electron multiplier is faulty. Contact Thermo Fisher Scientific Technical Support.

Replacing Fuses

Replacing PCBs and Power Supplies

CAUTION  Fuses protect the various circuits by opening the circuits whenever overcurrent 
occurs. On the TSQ Quantum XLS Series mass spectrometers, a failed fuse indicates a 
failed board or electronic module that must be replaced by a Thermo Fisher Scientific 
field service engineer.

CAUTION  The TSQ Quantum XLS Series mass spectrometer electronic assemblies are 
close packed to minimize the size of the system. Due to the complexity of removing and 
reinstalling the mass spectrometer electronic assemblies, only a Thermo Fisher Scientific 
field service engineer can replace electronic assemblies.
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Using the Direct Sample Probe

With the direct sample probes (direct insertion probe and direct exposure probe) you can 
introduce compounds directly into the ion source without GC column separation. This 
chapter covers, step-by-step, a direct insertion probe (DIP) experiment using 
perfluorotetracosane (CF3(CF2)22CF3, molecular weight 1238.18, melting point 190 ºC). 
You can perform a similar experiment using your compound.

Creating an Instrument Method
An instrument method contains the settings that the TSQ Quantum XLS Series mass 
spectrometer uses during an experiment. Use the Instrument Setup view to create the 
instrument method.

To create an instrument method

1. On the Thermo Xcalibur Roadmap, click the Instrument Setup icon to open the 
Instrument Setup view. 

2. Click the TSQ icon in the viewbar.

3. Choose TSQ > Regular Method to open the regular method Scan Editor page.

4. On the Scan Editor page, create a one segment, one scan event instrument method. In 
this example, the segment is 8 minutes long (see Figure 62).

Contents

• Creating an Instrument Method

• Creating a Sequence

• Preparing the Probe and Inlet Valve

• Preparing the Mass Spectrometer

• Running the Sequence

• Examining the Raw Data in Qual Browser

• Removing the Probe
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5. Specify the mass spectrometer settings: for this example, Full-Scan (Scan Type list), 
Q1MS (Scan Modes|MS Mode option), and Positive (Polarity area).

Figure 62. Scan Editor page of Instrument Setup

6. Click the EI/CI tab to display the EI/CI page (see Figure 63).
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Figure 63. EI/CI page of Instrument Setup

7. Enter or select the following settings:

• Number of States: 1

• State at Start of Run: On

• Calibration Gas Setting: Off

• Use DIP/DEP Probe: 

This example is an EI experiment with a 200 μA emission current.

8. Save the instrument method.

a. Choose File > Save As to open the Save As dialog box.

b. Save the instrument method as a .meth file. In this example we name the instrument 
method Dip test.meth.
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Creating a Sequence
A sequence contains sample information—one sample per row. In this example the sequence 
has one sample.

To create a sequence

1. Click Start > Programs > Thermo Xcalibur > Xcalibur to open the Thermo Xcalibur 
Roadmap.

2. On the Thermo Xcalibur Roadmap, click the Sequence Setup icon to open the Sequence 
Setup view (see Figure 64).

3. Enter the name and path of the instrument method. In this example, it is 
C:\Xcalibur\methods\DIP test.

4. Enter a file name and path for the raw file that contains the acquired data. In this 
example, it is C:\Xcalibur\Data\data01. 

Figure 64. Sequence Setup view, showing one sample in the sequence

Note  If the sequence has more than one sample, the Xcalibur data system prompts you to 
reload the probe after each sample.
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Preparing the Probe and Inlet Valve
To prepare the probe and inlet valve 

1. Connect the direct sample probe controller to the mass spectrometer by contact closure 
with the probe start cable (P/N 70111-63627, in the Accessory Kit).

2. Create a probe method on the controller. Refer to the probe manual. This example uses 
the following DIP settings:

• Initial temperature: 50 ºC

• Initial time: 5 s

• Ramp rate: 100 ºC/min

• Final temperature: 200 ºC

• Ramp hold time: 200 s

3. Load sample on the probe.

4. Install the guide bar:

a. With the guide ball track facing left, insert the guide bar into the entry housing. See 
Figure 17 on page 28. 

b. Push the guide bar in as far as it goes. Rotate it 90° clockwise to lock the guide bar in 
the entry housing.

5. Prepare the inlet valve:

a. Make sure the inlet valve is closed with the inlet valve lever down, as shown in 
Figure 17 on page 28.

b. Loosen the inlet valve knob counterclockwise, and remove the inlet valve plug. 

Preparing the Mass Spectrometer 

To prepare the mass spectrometer for the experiment

1. If the EZ Tune window is not already open, choose Start > All Programs > 
Thermo Instruments > TSQ > TSQ Tune. 

2. Ensure that the TSQ Quantum XLS Series mass spectrometer is the only instrument in 
use and that there are no start instruments.

a. On the Thermo Xcalibur Roadmap, click the Sequence Setup icon to open Sequence 
Setup, if it is not already open.

IMPORTANT  You must have the TSQ EZ Tune window open for the mass 
spectrometer to initiate the probe insertion sequence.
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b. In Sequence Setup, choose Actions > Run Sequence. The Run Sequence dialog box 
opens (see Figure 65).

Figure 65. Run Sequence dialog box, showing instruments in use

c. Click Change Instruments to open the Change Instruments In Use dialog box (see 
Figure 66).

Figure 66. Change Instruments In Use dialog box, showing the TSQ Quantum mass 
spectrometer in use and no start instruments
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d. Click any Yes in the In Use column to clear all instruments other than the TSQ 
Quantum.

e. Ensure that the TSQ Quantum has a Yes in the In Use column. Click the area if 
necessary.

f. Click any Yes in the Start Instrument column to clear all start instruments.

g. Click OK to save your settings and close the Change Instruments In Use dialog box.

Running the Sequence 

You acquire data by running the sequence. The Xcalibur data system saves the acquired data 
in a raw file.

To run the sequence

1. In the Run Sequence dialog box (see Figure 65 on page 136), click OK to start the 
acquisition. The Xcalibur system displays a message to insert the probe (Figure 67).

Figure 67. Insert probe message

2. Inset the probe into the inlet valve:

a. Insert the guide ball on the DIP probe into the guide ball hole on the guide bar. 

b. Slide the probe forward into the inlet valve until the guide ball is at the guide bar’s 
first stop. See Figure 68.

c. Tighten the inlet valve knob clockwise to ensure a leak-tight seal.

Note  You must have the TSQ EZ Tune or QuickQuan application running so that the 
Xcalibur application can display instrument methods.
Thermo Scientific TSQ Quantum XLS Series User Guide 137



A Using the Direct Sample Probe
Running the Sequence
Figure 68. Probe at the first stop on guide bar

3. Click OK. The forepump evacuates the inlet valve. 

4. When the Safe to Open the Valve message appears (Figure 69), click OK.

Figure 69. Safe to open the valve message

5. Pull the inlet valve lever up to open the inlet valve.

6. Slide the probe into the vacuum manifold until the tip of the probe is fully inserted into 
the ion volume holder. See Figure 70.

Inlet valve 
knob

First stop on guide bar

Probe
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Running the Sequence
Figure 70. Probe inserted into the inlet valve 

7. When you receive the Acquisition Ready message (Figure 71), click OK. The mass 
spectrometer is now waiting for contact closure.

Figure 71. Acquisition Ready message
.

8. In Sequence Setup, choose View > Real Time Plot View to display the mass spectrum 
and chromatogram. 

9. Start the probe method from the probe controller to initiate data acquisition. See 
Figure 72, and Figure 73 on page 141.

Inlet valve

Probe
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Figure 72. Perfluorotetracosane mass spectrum at 0.56 minute retention time
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Figure 73. Perfluorotetracosane chromatogram

Examining the Raw Data in Qual Browser
You can use Qual Browser to display the mass spectrum at various times in the chromatogram.

To examine the raw data

1. On the Thermo Xcalibur Roadmap, click the Qual Browser icon to open the Qual 
Browser window. 

2. Click on the chromatogram to display the mass spectrum at that retention time. 
See Figure 74.
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Figure 74. Raw file displayed in Qual Browser

Removing the Probe
To remove the probe

1. Withdraw the probe until the guide ball on the probe reaches the first stop on the guide 
bar (see Figure 68 on page 138). 

2. Close the inlet valve by pushing the lever down.

3. Loosen the inlet valve knob by turning it counterclockwise.

CAUTION  Do not withdraw the probe beyond the point where the guide ball reaches 
the first stop in the guide bar. Close the inlet valve first. Otherwise, the system vents 
to the atmosphere. 
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4. Continue withdrawing the probe completely from the inlet valve by sliding it through the 
guide ball track in the guide bar.

5. Store the probe in its case.

6. Remove the guide bar by rotating it 90° counterclockwise and sliding it out of the entry 
housing. 

7. Replace the inlet valve plug and tighten the inlet valve knob clockwise to form a seal. The 
inlet valve plug prevents air from entering the vacuum manifold in case the inlet valve is 
accidentally opened. You can also remove the inlet valve lever by pulling it free.
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Replaceable Parts and Consumables

This appendix contains TSQ Quantum XLS Series part numbers for replaceable parts and 
consumables. To ensure proper results in servicing the TSQ Quantum XLS Series mass 
spectrometer, order only the parts listed or their equivalent. Contact Thermo Fisher Scientific 
Austin and have your TSQ Quantum XLS Series mass spectrometer serial number ready.

These kits with replaceable parts and consumables are available for the TSQ Quantum XLS 
Series systems:

EI/CI Ion Source Replaceable Parts
Figure 75 and Figure 76 show the replaceable parts of the EI/CI ion source of the TSQ 
Quantum XLS Series mass spectrometers. 

Contents

• EI/CI Ion Source Replaceable Parts

• Miscellaneous Replaceable Parts and Consumables

• Miscellaneous Replaceable Parts and Consumables

• Chemicals Kit
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B Replaceable Parts and Consumables
EI/CI Ion Source Replaceable Parts
Figure 75. Ion source (70111-60840)

L1, L2, L3 lens assembly 
(70111-60842)

Heater ring 
(70111-22052)

Centering ring
(70111-22061)

Ion source block
(70111-22019)

Heater ring and lens 
assemblies retainer clip 
(70111-22070)

Threaded standoff 
(70111-22060)Ion volume retaining 

thumbscrew 
(70111-22059)

EI/CI Source PCB 
(70111-60848)

Base studs 
(70111-22056)

Ion volume holder
(70001-20532-T)

Closed EI ion volume
(70111-22147)

Heated Q0 quadrupole
assembly (70111-60843)

Filament
(120320-0030)

Filament retainer clip
(70111-22071)
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 B Replaceable Parts and Consumables
Miscellaneous Replaceable Parts and Consumables
Figure 76. L1, L2, L3 lens assembly (70111-60842)

Miscellaneous Replaceable Parts and Consumables

Lens holder 
(70111-22197)

Lens L3 
(119650-3423)

Lens spacer 
(119650-0426)

Lens L2 
(119650-3416)

Lens spacer 
(119650-0426)

Lens L1 
(119650-3414)

Lens retainer clip 
(119650-0428)

Table 7. Miscellaneous replaceable parts  (Sheet 1 of 2)

Description Function Part number

Calibration compound vial Holds frit and FC-43 tuning and 
calibration compound.

120428-0002

Calibration compound frit Holds FC-43 tuning and calibration 
compound.

120432-0001

Ion volume, closed EI, P type Ni-Cr, for pesticides 70001-22202
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Accessory Kit
Accessory Kit

Ion volume holder, T type Special alloy 70001-20532-T

GC capillary column, 
15 m × 0.25 mm ID × 0.25 μm 
film thickness SQC install 
column

Replacement capillary column 76317-3015

Table 7. Miscellaneous replaceable parts  (Sheet 2 of 2)

Description Function Part number

Table 8. Accessory Kit (P/N 70111-62077) (Sheet 1 of 2)

Description Function Part number

Fitting, ferrule, SWG, 1/8 in., 
brass, set

00101-08-00009

Fitting, connection, 1/4 to 
1/8 in.

00101-01709

Fitting, connection, 1/4 to 
1/8 in.

00101-01712

Fitting, ferrule, SWG, front, 
3/8 in., brass

00101-11500

Ferrule, 0.4mm ID × 1/16 in. 00101-18100

Restek™ capillary-grade 
hydrocarbon trap

For removing hydrocarbons from 
the GC carrier gas

00106-99-00001

Restek high-capacity oxygen 
trap

For removing oxygen from the 
GC carrier gas

00106-99-00002

Cotton swabs For applying cleaning paste to 
stainless steel parts

00301-01-00015

Tubing, 1/8 in., copper, 
precleaned

Gas lines 00301-22701

Ball valve seal kit 
(replacement)

For replacing the ball valve seal in 
the inlet valve

119265-0003

Lens alignment tool For aligning ion source lenses 1, 2, 
and 3

120271-0001

Filament assembly For replacing a failed filament in the 
ion source

120320-0030 

Nitrile gloves medium For handling clean parts that are 
under vacuum

23827-0008
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 B Replaceable Parts and Consumables
Chemicals Kit
Chemicals Kit

Nitrile gloves large For handling clean parts that are 
under vacuum

23827-0009

Syringe, 10 μL, 80 mm For adding calibration compound 36502019

Tee union, 1/8 in. 00101-01-00012

Cable, start, probe Contact closure cable between the 
direct sample probe and the mass 
spectrometer

70111-63627

Cable, start, GC Contact closure cable between the 
GC and the mass spectrometer

70111-63626

Forceps, 10 in., stainless steel For handling ion volumes and clean 
components

76360-0400

Cable, 10 base-T, crossover, 
15 ft, shielded 

Communication 76396-0052

Oil, vacuum pump, 1 L Lubrication of forepump 00301-15101

Cable, RJ45, 7 ft. 00302-01838

Ethernet switch, 5 port Communication 00825-01-00024

Software, QuanLab Forms 
2.5.1 SP1

Chromatography analysis software 120395-0001

Software, GC Devices 2.1.0 for 
Xcalibur 2.1

GC devices control software 120399-0001

Table 8. Accessory Kit (P/N 70111-62077) (Sheet 2 of 2)

Description Function Part number

Table 9. Chemicals Kit (P/N 70111-62078)

Description Function Part number

Perfluorotributylamine (FC-43) Tuning and calibration compound 50010-02500

Aluminum oxide Cleaning stainless steel parts 32000-60340

Benzohexane Performance testing 120150-TEST

Octafluoronaphthalene Performance testing 120150-TEST
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Index
A
Accessory Kit  148
acetone solvent peaks solvent peaks  118
aluminum oxide  149
analyzer assembly, lenses, voltages applied to  37
analyzer chamber, location (figure)  42
Analyzer Control PCB, discussion  46
analyzer region, vacuum manifold

description  41
location  41

anode, electron multiplier, description  38
Auto Tune and Calibration  64
autosampler

configuration  18
photo  2
power outlet  24
startup  53, 56
TriPlus  18
troubleshooting communication problems  117

AutoSIM scan type  14

B
ball valve

extraction tool
figure  106
using  106

seal kit  148
seal, components  105
seal, replacing  106

benzohexane  149

C
cables  149
calibrating

and H-SRM (note)  61
discussed  61
frequency (note)  61
running procedure  64
tune and calibration report  67

calibration compound
flow control, description  44
mass spectrum, displaying  62
observed peaks  62
on, off  62
spectrum, positive EI mode  64

calibration compound vial
location  102–103
replaceable parts  147

calibration gas valve, description  44
capillary column

conditioning  110
installing  109
removing  107
removing ion source (Caution)  88

cathode, electron multiplier, description  38
Cautions

emergency shutdown  23, 49
forepump and line power  43
I/R tool removal, withdrawing  78, 81
removing ion source and capillary column  88
replacing fuses  130
replacing PCBs and power supplies  130

centroid data type  15
chemical ionization (CI)

discussed  4
gas valve, description  44
methane  4
removing ion volume  73

Chemicals Kit  149
circuit breaker  23–24
cleaning

aluminum parts  100
ceramic parts  100
frequency  83
ion source lenses  87
ion volumes  87
list of procedures (table)  83
stainless steel parts  98
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collision cell
figure  32
location (figure)  42

collision energy (Q2 offset voltage)  36
collision gas valve, description  44
collision gas, description  35
collision-induced dissociation (CID), discussed  35
column bleed contamination  117
Communication LED

description  23
figure  22, 55–56
mass spectrometer reset  57
mass spectrometer startup  55

compliance
regulatory  v
WEEE  vii

computer, features  47
consumables, replaceable parts  148
contacting us  xiii
contamination

column bleed  117
phthalates  118
septum bleed  118
troubleshooting  117

Convectron gauge, description  43
conversion dynode

description  38
figure  39

D
data dependent scan mode, discussed  11
data system

description  46
GC interface  47
instrument interface  47
LAN interface  47
personal computer  47
primary Ethernet adapter  47
shutdown  53

data types
centroid  15
discussed  14
profile  14

detector system  38
diagnostics  113
DIP (direct insertion probe), example procedure

1 creating an instrument method  131
2 creating a sequence  134
3 preparing the probe and inlet valve  135
4 preparing the mass spectrometer  135
5 running the sequence  137

6 examining the data  141
7 removing the probe  142
perfluorotetracosane  131

direct exposure probe (DEP)  19
direct insertion probe (DIP)  19
direct insertion probe (DIP), perfluorotetracosane example 
procedure  131

direct sample probe
and inlet valve  135
direct exposure probe (DEP)  19
direct insertion probe (DIP)  19
inserting into inlet valve (figure)  138
mass spectrometer, preparing  135
photo  20
using  131

documentation  xi
documentation survey  xiii
dynode  38

E
EI/CI Ion Source PCB

location  26
replacing  96

electron ionization (EI)
discussed  4
removing ion volume  73

electron multiplier
anode, description  38
description  38
figure  39

electronic assemblies
description  45
ion detection system  46
Power Entry Module, description  45
RF voltage generation, description  46

electronics service switch
description  24
location (figure)  25
mass spectrometer components On/Off status  59

embedded computer
description  45
resetting  57

emergency shutdown
Caution  23
front panel system power off button  23
procedure  49
system power off button  49

Ethernet  47
Ethernet Link OK LED  25
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Index: F
F
FC-43

mass spectrum, displaying  62
observed peaks  62
part number  149
spectrum, positive EI mode  64
turning flow on and off  62

ferrules  148
filament

description  27
location  94
location (figure)  26
part number  93
problems, troubleshooting  119
replaceable parts  148
replacing  93
turning on and off  62

filters  45
fittings  148
forepump

description  43
maintenance  101
power cord (Caution)  43
power outlet (figure)  25
Pump On LED  25

front panel LEDs
Communication  23
description  22
figure  22, 55–56
Power  23
Scan  23
System  23
Vacuum  23

front panel system power off button
emergency shutdown  49
figure  23

full scan type  12
functional description

autosampler  18
data system  46
direct sample probes  20
gas chromatograph (GC)  19
inlet valve  28
ion optics  29
mass analyzer  31
mass spectrometer  21
Q0 quadrupole  29
transfer line  20

fuses, mass spectrometer, replacing  130

G
gas chromatograph (GC)

capillary column
installing  109
removing  107

column installation  109
communication with data system  47
configuring  19
functional description  19
leak check  110
photo  2
power outlet  24
retention time correction (iSRM)  13
startup  53–54
troubleshooting communication problems  116

GC Devices 2.1.0  149
guide bar

figure  28, 74
installing  73

H
heated Q0 quadrupole

figure  29
location (figure)  26
reinstalling  92
removing  90

highly-selective reaction monitoring (H-SRM)  13
hydrocarbon trap  148

I
inlet gases hardware

calibration compound  44
CI gas valve  44
collision gas valve  44
description  40
functional block diagram  40

inlet valve
and direct sample probe  135
Caution  78, 81
components (figure)  75
description  28
figure  28
guide bar  28
Insert Probe message  75
insertion/removal (I/R) tool, inserting  75
ion volumes, installing  80
lever, removing  82
plug orientation  82
Safe to Insert Probe message  76
using, procedure  74

Insert Probe message (figure)  75
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Index: K
insertion/removal (I/R) tool
figure  28, 74
inserting  75
ion volumes, removing and installing  79
lock position  78
unlock position  74
withdrawal (Caution)  78, 81

Instrument Configuration window, opening  18–19
instrument method, creating  131
Instrument Setup window, opening  18
intelligent selected reaction monitoring (iSRM)  13
ion detection system

conversion dynode  38
description  38
electron multiplier  38
electron multiplier gain  39
electronic assemblies  46

ion gauge
description  43
location (figure)  42

ion optics, description  29
ion polarity modes, discussed  5
ion source

cleaning components  85
cross-sectional view (figure)  30
description  26
disassembling completely  96
electrical connections  xii, 53
exploded view  86
figure  26
filament, replacing  93
Ion Source PCB, location (figure)  96
lens assembly

disassembling  91
exploded view  91
reassembling  92
reinstalling  92
removing  90

location (figure)  xii, 53
reinstalling  92
removing  88

ion source block, location (figure)  26
ion source chamber, location (figure)  42
Ion Source PCB

location (figure)  xii, 53
reinstalling  97

ion transmission device
defined  6
rod assembly  6

ion volumes
attaching and removing from I/R tool  79
cleaning  87
figure  27

installing  80
location (figure)  81
removing  73
replaceable parts  147

ionization modes
changing  73
chemical ionization (CI)  3
discussed  3
electron ionization (EI)  3

iSRM scan type  13

K
kits

Accessory Kit  148
Chemical Kit  149

L
leak checking

during automatic tune  122
GC  110
QC tune report  71

LEDs
Communication LED

mass spectrometer reset  57
mass spectrometer startup  55
modes  23

Ethernet Link OK  24–25
Forepump On  24
Power LED  22

mass spectrometer reset  57
mass spectrometer startup  55

Pump On LED, location (figure)  25
Scan LED  23
System LED

mass spectrometer reset  57
mass spectrometer startup  55
modes  23

Vacuum LED  22
Vacuum LED, mass spectrometer startup  55
Vent Valve Closed LED

figure  25
modes  24

lens alignment tool  148
lens assembly, removing  90
lens L1, L2, L3, location (figure)  26
lenses

analyzer assembly, voltages applied to  37
ion source lenses

exploded view  91
reassembling  92
reinstalling  92

L1, L2, L3
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Index: M
exploded view  91
figure  26

L21, L22, L23 (figure)  32
L31, L32, L33 (figure)  32

linearity problems, troubleshooting  123

M
main power circuit breaker

description  23–24
location (figure)  24

maintenance
ball valve seal, replacing  105
forepump  101
frequency  83
GC column

installing  109
removing  107

procedures (table)  83
maintenance tune

report  70
running  70

mass analysis
collision-induced dissociation  35
discussion  32
RF and dc fields (figure)  33

mass analyzer
defined  6
description  31
quadrupole rod assembly, functional description  31

mass range  15
mass spectrometer

calibration compound, adding  102
CI gas valve  44
circuit breaker, location (figure)  25
collision gas valve  44
electronic assemblies  45
electronics service switch, location (figure)  25
emergency shutdown  49
front panel LEDs  22
functional description  21
inlet gasses hardware  40
inlet valve (figure)  28
ion detection system  38
ion detection system electronic assemblies  46
ion gauge  43
ion optics  29
ion source  26
LEDs and system startup  57
maintenance procedures (table)  83
mass analyzer  31
Off condition  59
On/Off status of components  59

Power Entry Module, description  45
power outlet  24
Q0 quadrupole  29
resetting  57
RF voltage generation electronic assemblies  46
right-side power panel  52
shutdown  51
Standby condition  51, 59
startup  53
tuning and calibrating (note)  56
tuning off components  58
turbomolecular pump  42
vacuum manifold  41
vacuum service switch, location (figure)  25
vacuum system  40
vent valve  44

mass spectrometer circuit breaker, location (figure)  25
mass spectrometer, and direct sample probe  135
mechanical pump  43
methanol solvent peaks  118
methylene chloride solvent peaks  118
MS main power circuit breaker, mass spectrometer 
components On/Off status  59

MS/MS scan modes
Neutral Loss  9
Parent  8
Product  7

N
Neutral Loss scan mode

discussed  9
example (figure)  11
illustration (figure)  10

O
octafluoronaphthalene  149
Off condition, mass spectrometer components On/Off 
status  59

offset voltage, quadrupole  36
oil, forepump, part number  149
oxygen trap  148

P
Parent scan mode

discussed  8
illustration (figure)  8

part numbers
Accessory Kit  148
Chemicals Kit  149
miscellaneous parts  147
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Index: Q
personal computer, features  47
phthalate contamination  118
power cord, forepump (Caution)  43
Power Entry Module, description  45
Power LED

figure  22, 55–56
mass spectrometer reset  57
mass spectrometer startup  55
modes  22

power supply problems, troubleshooting  124
pressure, maximum allowed (table)  55
probe button  75
procedures

capillary column
installing  109
removing  107

changing ionization modes  73
cleaning ion source components  85
cleaning ion volumes  87
cleaning stainless steel parts  98
complete system shutdown  51
conditioning capillary columns  110
creating QC tune report  71
disassembling ion source completely  96
disassembling ion source lens assembly  91
displaying FC-43 spectrum  62
emergency shutdown  49
GC leak checking  110
installing capillary columns  109
installing ion volumes  80
maintaining forepump  101
operating the inlet valve  73
placing system in standby  51
reassembling ion source lenses  92
reinstalling ion source  92
reinstalling ion source lenses  92
reinstalling Ion Source PCB  97
removing capillary column  107
removing ion source  88
removing ion source lens assembly  90
removing ion volumes  73
resetting mass spectrometer  57
saving tune and calibration reports  69
starting mass spectrometer  54
system startup  53
tuning and calibrating  64

Product scan mode
discussed  7
illustration (figure)  8

profile data type  14
pumps

forepump  43
oil, part number  149

turbomolecular pump  42

Q
Q0 quadrupole

cross-sectional view (figure)  30
description  29
location (figure)  42

Q1 quadrupole
figure  31
scan modes  6

Q1MS and Q3MS scan modes  7
Q2 rod assembly

figure  32
scan modes  6

Q3 quadrupole
figure  31
scan modes  6

QC tune report
creating  72
example (figure)  72
leak checking  71

QED MS scan type  14
quadrupole mass analyzer

functional description  31
quadrupole offset voltage  36

quadrupoles
mass analysis  31
Q0, description  29
Q1 and Q3  31
RF and dc fields  32
RF and dc fields (figure)  33–34

Qual Browser
direct sample probe data  141
opening  141
reviewing data  141

quality control (QC) tune report
creating  71
example (figure)  72
leak checking  71

QuanLab Forms  149
quantitation-enhanced data-dependent MS (QED MS) scan 
type  14

R
rear power panel, location (figure)  50
reference scans (iSRM)  13
reference SRM reactions  14
regulatory compliance  v
replaceable parts

accessory kit  148
calibration compound vial  147
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capillary column  147
chemicals kit  149

retention time correction (iSRM)  13
rf voltage generation, discussion  46
rf/dc voltages applied to mass analyzer, discussion  31
right-side power panel

discussion  24
figure  52

rod assemblies
description  32
ion transmission  6
mass analysis  6
mass analyzer(s), quadrupole  31
Q1, Q2, and Q3 (note)  7

roughing pump  43

S
Safe to Open Valve message, direct sample probe  138
safety and special notices  xii
safety standards  v
Scan LED

description  23
figure  22, 55–56

scan modes
data dependent  11
discussed  5
mass spectrometer  5
Neutral Loss

discussed  9
example (figure)  11
illustrated (figure)  10

Parent
discussed  8
illustrated (figure)  9

Product
discussed  7
illustrated (figure)  8

Q1MS and Q3MS  7
summary (table)  6

scan types
AutoSIM  14
discussed  12
full scan  12
highly-selective reaction monitoring (H-SRM)  13
intelligent selected reaction monitoring (iSRM)  13
quantitation-enhanced data-dependent MS (QED MS)  14
selected ion monitoring (SIM)  12
selected reaction monitoring (SRM)  13

selected ion monitoring (SIM) scan type  12
selected reaction monitoring (SRM) scan type  13
sensitivity problems, troubleshooting  124
septum bleed contamination  118

sequence
creating  134
direct sample probe, running  137
Sequence Setup view  134

Sequence Setup, opening  135
shutdown

complete shutdown  51
data system  53
emergency procedure  49
emergency, front panel system power off button  23
mass spectrometer  51
non-emergency  51

side cover plate (vacuum manifold), description  41
software

GC Devices 2.1.0  149
QuanLab Forms  149

solvent peaks
acetone  118
hexane  118
methanol  118
methylene chloride  118
toluene  118
trichloroethane  118
xylene  118

stability problems, troubleshooting  127
stainless steel, cleaning  98
Standby condition

mass spectrometer components On/Off status  59
placing system in  51

startup
autosampler  56
gas chromatograph (GC)  54
operating conditions, setting  56

survey link  xiii
System Control PCB, description  45
System LED

figure  22, 55–56
mass spectrometer reset  57
mass spectrometer startup  55
modes  23

system power off button
emergency shutdown  23
location (figure)  50

system reset button
description  24
location (figure)  24
mass spectrometer reset  57

system shutdown
complete shutdown  51
emergency procedure  49

System Tune and Calibration workspace (figure)  64
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T
tables

Accessory Kit  148
Chemicals Kit  147, 149
mass spectrometer components on/off status  59
mass spectrometer maintenance procedures  83
maximum allowed pressures  55
summary of scan modes  6

Thermo Xcalibur Roadmap, opening  134
toluene solvent peaks  118
TRACE GC Ultra gas chromatograph

configuration  19
photo  2

transfer line
capillary column

installing  109
removing  108

cross-sectional view (figure)  30
figure  21
functional description  20
location (figure)  xii, 53
union (figure)  108

trichloroethane solvent peaks  118
TriPlus autosampler

configuration  18
photo  2

troubleshooting
autosampler communication  117
communication issues  114
contamination issues  117
filament and lens control  119
gas chromatograph communication  116
heated zones  120
high vacuum  121
leak checking  122
linearity  123
power supplies  124
sensitivity  124
stability  127
tuning  128

TSQ Quantum mass spectrometer
calibrating  61
calibration compound, adding  102
data types  14
front panel LEDs  22
ion polarity modes  5
LEDs and system startup  57
mass analysis, overview  3
mass range  15
mass spectrometer  21
operating conditions, setting  56
overview  1
scan modes  5

scan types  12
Standby condition  51
startup  53
tuning  61
tuning and calibrating (note)  56
turning off components  58

TSQ Quantum XLS Series system
autosampler  18
data system  46
functional block diagram (figure)  18
gas chromatograph  19
TSQ Quantum XLS system (photo)  2
TSQ Quantum XLS Ultra system (photo)  2

tune and calibration report
figure  68
saving  67

tuning
discussed  61
frequency (note)  61
running procedure  64
tune and calibration report  67

tuning and calibrating (note)  56
tuning problems, troubleshooting  128
turbomolecular pump, description  42

V
Vacuum LED

and analyzer region pressure  22
description  22
figure  22, 55–56
mass spectrometer startup  55
modes  22

vacuum manifold
description  41
location (figure)  42
side cover plate, description  41

vacuum pumps
forepump  43
Pump On LED  25
turbomolecular pump  42

vacuum service switch
description  24
location (figure)  25
On/Off status of mass spectrometer components  59

vacuum system
collision gas valve  44
Convectron gauge  43
description  40
forepump  43
functional block diagram (figure)  40
ion gauge  43
leak checking  122
158 TSQ Quantum XLS Series User Guide  Thermo Scientific



Index: W
maximum allowed pressures  55
powering off  24
problems, troubleshooting  121
turbomolecular pump  42
Vacuum LED  22
vacuum manifold  41
vacuum service switch  24
vent valve  44

vent valve
description  44
LED  24

Vent Valve Closed LED  24
voltages

conversion dynode  38
Q0 offset  29
quadrupole rf and dc  32

W
Warnings

burn hazard
GC oven, injector, transferline  88
removing ion source  89

shock hazard, removing ion source  88
WEEE compliance  vii

X
xylene solvent peaks  118
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